
Lists the software available on the network for installation.



Click this to install the selected software program.



Click this to install a new program. 



Lists the programs that can be removed automatically by Windows. For installed programs that do not appear on
this list, see that vendor's documentation for instructions on removing the program.



Click this to remove the program selected in the installed software list.



Lists the Windows components you can add to or remove from your computer. 



Displays the hard-disk space required to install the component highlighted in the components list, and the space 
available on your hard disk.



Displays information about the component highlighted in the components list.



Click this to install the component from a disk or CD-ROM.



Click this to create a startup disk that can be used to start your computer if you have problems starting 
Windows. You will need one floppy disk with at least 1.2 MB capacity.



Click this to add or remove individual components contained in the selected component group.



To install a Windows component after Windows has been installed

1 Click here        to open the Add/Remove Programs dialog box.
2 To add all of the parts of a component, click the check box. 

To remove all of the parts of a component, clear the check box.
To add or remove some of the parts of a component, highlight the component name, and then click Details. 
Then, check or clear the parts as needed to add or remove them.

3 When you have finished selecting the components to add or remove, click OK.
4 Click OK again.

If you originally installed Windows 95 using a CD-ROM or floppy disk(s), you may be prompted to insert the 
Windows installation disk(s) in your computer. 

Note
Each component contains one or more parts. To see what is included in a component, highlight the 

component, and then click Details.



To install a program from a floppy disk or CD-ROM

1 Click here        to open the Add/Remove Programs dialog box.
2 Follow the instructions on your screen.



To remove a program from your computer

1 Click here        to open the Add/Remove Programs dialog box.
2 Follow the instructions on your screen.

Note
Only programs that were designed for Windows 95 can be removed by using Add/Remove Programs. For all

other programs, check the program's documentation to determine which files should be removed.



To create a startup disk

1 Click here        to open the Add/Remove Programs dialog box.
2 Follow the instructions on your screen.

Notes
To make a startup disk, you will need one floppy disk with at least 1.2 MB capacity.
You can use the startup disk to start your computer if you are having problems starting Windows. When 

you insert the startup disk in your computer before restarting, the computer starts from that disk, not from your 
hard drive.



To install a program from a network

1 Click here        to open the Add/Remove Programs dialog box.
2 If the Install/Uninstall tab is selected, and your computer is already connected to a network, click Install, and 

then click Next. Follow the instructions on your screen.
If the Network Install tab is selected, follow the instructions on your screen.

Notes
If you do not have a Network Install tab in the Add/Remove Programs dialog box, this feature has not been 

enabled on your computer, your network, or both. See your system administrator.
If you are not already connected to the shared folder you want to install from, you must connect to it by 

using My Computer or Windows Explorer, or type the path to it in the text box.



Windows Startup Troubleshooter

If you have trouble starting Windows, you can use several methods to start your computer with or without 
starting Windows or the network. After you identify and resolve the problem, you can restart your computer as 
you usually do. 

What do you want to do?
            Create a startup disk.  
            Start Windows in safe mode.  
            Start your computer without starting Windows.  
            Confirm startup files line by line.  
            Start Windows without logging on to the network.  

Note
Windows Help will not be available when you start these procedures. You can print this topic for reference 

by clicking Options and then clicking Print Topic.



To start your computer without starting Windows 

1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help is not available 
when you are starting up or running in MS-DOS.

2 Restart your computer by clicking the Start button, clicking Shut Down, and then clicking Restart The 
Computer.

3 When you see the message "Starting Windows 95," press F8.
4 If you want to load your Autoexec.bat and Config.sys files, choose Step-by-Step Confirmation.

If you want to skip your Autoexec.bat and Config.sys files and go to the command prompt, choose Command 
Prompt Only.
If you want to skip your Autoexec.bat and Config.sys files and go to the command prompt without network 
support, choose Safe Mode Command Prompt Only. 

Note
After you start your computer in MS-DOS, you need to restart your computer to start Windows again.



To go through the startup commands line by line

1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help is not available 
when you are starting up or running in MS-DOS.

2 Restart your computer by clicking the Start button, clicking Shut Down, and then clicking Restart The 
Computer.

3 When you see the message "Starting Windows 95," press F8.
4 Choose Step-by-Step Confirmation.
5 For each command you want to run, press Y. 

If the command runs successfully, you are prompted with the next command.
If the command does not run successfully, you receive an error message.
To skip a command, press N.

Note
After you finish this procedure, you may need to restart your computer before Windows will start properly.



To start Windows in safe mode

1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help is not available 
when you are starting up or running in MS-DOS.

2 Restart your computer by clicking the Start button, clicking Shut Down, and then clicking Restart The 
Computer.

3 When you see the message "Starting Windows 95," press F8. 
4 If you want to start Windows without network support, choose Safe Mode. 

If you want to start Windows with network support, choose Safe Mode With Network Support. 
In safe mode, Windows uses default settings (VGA monitor, no network, Microsoft mouse driver, and the 
minimum device drivers required to start Windows). You will not have access to CD-ROM drives, printers, or 
other devices.

5 On the Start menu, point to Settings, and then click Control Panel. 

Notes
You can double-click the Network or System icon and change settings as needed.
After you finish this procedure, you need to restart your computer before Windows will start properly.



To start Windows without logging on to a network 

1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help is not available 
when you are starting up or running in MS-DOS.

2 Restart your computer by clicking the Start button, clicking Shut Down, and then clicking Restart The 
Computer.

3 When the Enter Network Password dialog box appears, click Cancel.

Note
After you finish this procedure, you need to restart your computer before you can log on to the network.



The left column shows the status of the copy of the file inside Briefcase. The right column shows the status of the
copy outside Briefcase. The center column shows what will occur when you click Update. 
By default, Briefcase replaces older versions of files with newer versions. To change the way Briefcase updates a 
file, use your right mouse button to click the file.



Updates the selected file. To specify a different action, use your right mouse button to click the file, and then 
click an item on the menu.



Shows the name and icon of the file.



Breaks the connection between the copy of the file in Briefcase and the copy outside Briefcase.



Click this to find the original file that the copy in Briefcase is connected to.



Determines which types of files in the folder are copied to Briefcase. To include only certain files, click Selected 
Types, and then click the types of files you want to include.



Specifies whether any subfolders in the folder are copied to Briefcase.



To synchronize files on connected computers
1 On your portable computer, copy files from shared folders on your main computer to Briefcase. (You can drag 

the files to the My Briefcase icon on your desktop.)
2 Work on your files on your portable or laptop computer. It can be disconnected from the main computer.
3 When you have finished working on the files, connect the two computers, and then double-click the My 

Briefcase icon. 
4 On the Briefcase menu, click Update All. Or click the files you want to update, and then click Update Selection.

Notes
When you are copying files from your main computer into Briefcase, the two computers must be 

connected, either over a network or by a cable. 
The My Briefcase icon appears on the desktop if you chose the Portable setup option when you installed 

Windows 95. If you do not see a My Briefcase icon, click Related Topics below for information about installing 
Windows components.

{button ,AL("A_BFC_CREATE_NEW;A_ADDPROG_COMPONENT;A_COPY_FILES;A_SELECT_FILES;A_DIAL_LINK")} 
Related Topics



To keep files synchronized by using a floppy disk

1 Insert a floppy disk into a disk drive on your main computer.
2 Copy files to Briefcase. (You can drag the files or folders to the My Briefcase icon on your desktop.)
3 Move Briefcase to the floppy disk. 
4 Insert the floppy disk into a disk drive on your portable or laptop computer, and then edit the files in Briefcase.
5 When you are ready to synchronize the files, reinsert the floppy disk containing Briefcase into a disk drive on 

your main computer, and then double-click the My Briefcase icon.
6 On the Briefcase menu, click Update All. Or click the files you want to update, and then click Update Selection.

Note
The My Briefcase icon appears on the desktop if you chose the Portable setup option when you installed 

Windows 95. If you do not see a My Briefcase icon, click Related Topics below for information about installing 
Windows components.

{button ,AL("A_BFC_CREATE_NEW;A_COPY_FILES;A_MOVE_FILES;A_SELECT_FILES")} Related Topics



To separate Briefcase files from the originals

1 In Briefcase, click the file you want to split.
2 On the Briefcase menu, click Split From Original.

Note
After you split a file from its original, it is labeled an orphan and cannot be updated. 



An orphan file inside Briefcase is not linked to any file outside Briefcase. As a result, when you choose to update 
files, there is no file for the orphan to synchronize with.



To check the status of a file or folder in Briefcase

1 In Briefcase, click the file or folder whose status you want to check.
2 On the File menu, click Properties.
3 Click the Update Status tab.

Tips
To find the copy of the file that is outside Briefcase, click Find Original.
To check the status of all your Briefcase files and folders, click the View menu, and then click Details. A 

Status column appears in the main Briefcase window.



Splitting separates the copy of the file inside Briefcase from the copy outside Briefcase.



To create a Briefcase on the desktop

1 Click here        to open the Add/Remove Programs dialog box.
2 Click Accessories, and then click Details.
3 Click the check box for Briefcase to mark it for installation, and then click OK.

Note
If you already have Briefcase installed, or have installed it in the past and want to create a new one, you 

don't need to install it again. Just open Windows Explorer, then open the folder you want to create the new 
Briefcase in. On the File menu, point to New, and then click Briefcase.



To insert a special character into a document
1 Click here        to open Character Map.

2 Click the Font box, and then click a font.
3 Double-click each character you want. The character(s) will appear in the Characters To Copy box.
4 Click Copy.
5 In your document, click where you want the character(s) to appear, click the Edit menu, and then click 
Paste.
6 Select the character(s), and then change them to the same font you used in Character Map.

Tips
To magnify a character in Character Map, click it and hold down the mouse button.
Character Map works only with Windows-based programs.



Displays the characters you have selected.



Places the highlighted character in the Characters To Copy box.



Copies the characters that are in the Characters To Copy box. 
You must click this before you can paste the characters into a file. 



Specifies which font to use to display the characters. 



Shows the characters available in the selected font.



Displays a Help topic that explains how to use Character Map to add a character to a document.



Closes this dialog box and saves any changes you have made.



Closes this dialog box without saving any changes you have made. 



Click this to display an overview of this dialog box. 
For Help on an item, click  at the top of the dialog box, and then click the item.



Saves all the changes you have made without closing this dialog box.



Lists the available styles for the specified font.



Lists the available point sizes for the specified font.



Shows a sample of how text will appear with the specified font settings.



Specifies whether the font should appear with strikeout marks or underlines, and specifies the available colors 
for the font.



Lists the available language scripts for the specified font. Pick the one appropriate for the language your 
computer is set up for.



Lists the available fonts.



Lists the available colors for the specified font.



Lists the available folders and files. To see how the current folder fits in the hierarchy on your computer, click the
down arrow. To see what's inside a folder, click it.
The box below shows the folders and files in the selected location. You can also double-click a folder or file in that
box to open it.
To open the folder one level higher, click  on the toolbar.



Lists the available folders and files.



Lists the folders and files in the selected location. To see what's inside a folder, double-click it.
You can also use the Look In box to see the hierarchy of folders.
To open the folder one level higher, click  on the toolbar. 



Specifies that you will be able to read the file but cannot make changes to it.



Lists the types of files to display. 
This is useful for narrowing the list of files displayed to only those files you're interested in.



Specifies the type of file you are saving. The list includes all the available file types that this program can 
recognize.



Shows the drive and folder you have selected.



Shows the name of the drive you have selected.



Provides a space for you to type the name of the file.
You can use * as a wildcard. For example, you can type *.* to see a list of all files.
You can also type the full path of a file. For example, you can type c:\mydocs\letter.doc. Or, if you have used a 
long filename, you might type c:\mydocs\letter to mom.



Opens the file with the name, file type, and location you specified.



Saves the file with the name, file type, and location you specified.



Provides a space for you to enter the text you want to find. 



Searches for the next instance of the text you specified in the Find What box.



Finds only whole words instead of searching for your text inside longer words.



Finds only text that has the same pattern of upper and lower case as the text you specified in the Find What box.



Specifies which direction to search starting from the cursor in the document. Choose Up to search backward, 
toward the beginning of the document. Choose Down to search forward, toward the end of the document.



Searches for the next text that matches the text in the Find What box and replaces it with the text in the Replace
With box.



Searches for every instance of the text that matches the text in the Find What box and replaces it with the text in
the Replace With box.



Searches for the text in the Find What box and replaces it with this text. 



Click the plus sign next to an item to see more choices.



Shows which printer this document will print on.



Provides a space for you to type the name of the file to be printed.



Lists the printers that are set up on your computer.



Click this to choose a different printer or to specify print options.



Click this to connect to a network share.



Provides a space for you to type the number of copies you want to print.



If you have selected more than one copy, specifies whether you want the copies to be collated.



Prints the document to a file instead of routing it directly to a printer. You will be prompted to specify the 
filename and location.



Specifies whether to print the entire document, the current page, or specific pages.



Specifies whether to print the entire document, specific pages, or the selection you highlighted.



Click this to set up options for this printer. The options available depend on the features of the printer.



Lists the available printers. Click the printer you would like to use. To add a printer, open the Printers folder, and 
then double-click Add Printer.



Specifies additional setup options for individual printers.



Shows information about the selected printer.



Lists the available choices for paper size and source.



Specifies whether the document should be printed with its top along the short edge of the paper (portrait) or 
along the long edge of the paper (landscape).



Shows how the page layout will look. As you change the options, the page layout example changes.



Shows how the document is positioned on the page. 
To see an example on the sample page, click Portrait or Landscape.



Specifies the size of the paper or envelope you want to use.



Specifies where the paper you want to use is located in the printer. Different printer models support different 
paper sources, such as the upper tray, envelope feed, and manual feed.



Sets the printing area of the page. The margins you set here are never printed on.



Enables you to change printer options.



Displays any custom colors you have already defined.
To change the settings for a color, click a custom color box, and then click Define Custom Colors.
To define a new custom color, click the basic color it is closest to, and then click Define Custom Colors.



Displays any custom colors you have already defined.
To change the settings for a custom color, click a custom color box, and then specify a different color.
To define a new custom color, click an empty custom color box, specify a different color, and then click Add To 
Custom Colors.



Shows the basic colors available. 
To define a custom color, click the basic color closest to it, and then click Define Custom Colors.



Shows a color matrix. To define a custom color, click anywhere in this matrix, and then use the slider at the right 
of the dialog box to adjust the color's attributes.
If you define a color using the Hue/Sat/Lum or Red/Green/Blue scales, you can look at this matrix to make sure 
you defined the color as you intended.



Displays the possible amounts of white and black in the color.
The result of your choice is displayed in the Color/Solid box.



Specifies the hue for the selected custom color. A combination of hue, saturation, and luminosity can be used to 
define any color.
Hue is the value of a color wheel, where 0 is red, 60 is yellow, 120 is green, 180 is cyan, 200 is magenta, and 
240 is blue.
If you change the hue, the values for red, green, and blue will be changed to match.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the color 
matrix above.



Specifies the saturation level for the selected custom color. A combination of hue, saturation, and luminosity can 
be used to define any color.
Saturation is the amount of color in a specified hue, up to a maximum of 240.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the color 
matrix above.



Specifies the amount of red in the selected custom color. A combination of red, green, and blue levels can be 
used to define any color. You can see the effect of changing this value in the color matrix.
If you change this value, the values for hue, saturation, and luminosity will be changed to match.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the color 
matrix above.



Specifies the amount of green in the selected custom color. A combination of red, green, and blue levels can be 
used to define any color. You can see the effect of changing this value in the color matrix.
If you change this value, the values for hue, saturation, and luminosity will be changed to match.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the large 
rectangle above.



Specifies the amount of blue in the selected custom color. A combination of red, green, and blue levels can be 
used to define any color. You can see the effect of changing this value in the color matrix.
If you change this value, the values for hue, saturation, and luminosity will be changed to match.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the color 
matrix above.



Specifies the luminosity of the selected custom color. A combination of hue, saturation, and luminosity can be 
used to define any color.
Luminosity is the brightness of the color.
If you change the luminosity, the values for red, green, and blue will be changed to match.
The easiest way to experiment with different colors is to press and hold the mouse and move it around the color 
matrix above.



Adds the custom color you have defined to the Custom Colors palette.



On the left, shows the amount of white and black in the color you specified. On the right, shows how the color 
will look if you choose 100% of the color with no white and black.
To adjust the color, use the slider at the right of the dialog box. To specify that you want 100% of the color with 
no white or black, type ALT+O.



Click this to define a custom color. 
If this button is unavailable, you are already viewing custom colors. To define a custom color, click in the color 
matrix, or specify the color using the hue/saturation/luminosity or the red/green/blue definitions, and then click 
Add To Custom Colors.



Select the printing quality you want.



Click None if you want to print on only one side of a page. Click Long Side or Short Side if you want duplex 
printing.



Help is available for each item in this group. Click  at the top of the dialog box, and then click the specific item 
you want information about.



Provides a space for you to type the name of the drive where the file, folder, or program is located.



Click this to assign a new password or change an existing password.



Provides a space for you to type your old password. Asterisks will appear instead of what you type.



Provides a space for you to type a new password. For security, asterisks (*) will appear as you type. After you 
have typed your password, type it again in the Confirm New Password box.



Provides a space for you to type the password again. If what you type matches what you typed in the New 
Password box, Windows changes the password. For security, asterisks (*) will appear as you type.



No Help topic is associated with this item.



Click this to browse through folders to find the file you want.



Makes the selected text bold.



Makes the selected text italic.



Click the right mouse button on any item you want more information about. Click the left mouse button on any 
item to continue working.



No additional information is available.



Displays the buttons that you can add to the toolbar in the active window.



Moves the button selected in the Available Buttons list to the Toolbar Buttons list.



Moves the button selected in the Toolbar Buttons list to the Available Buttons list.



Displays the buttons in the order they appear (from left to right) on the toolbar in the active window.



Restores the default set of buttons on the toolbar in the active window.



Moves the selected button up one line. On the toolbar, the button shifts left one space.



Moves the selected button down one line. On the toolbar, the button shifts right one space.



Closes the dialog, accepting the changes you have made.



To change your computer's time

1 Click here        to display Date/Time properties.
2 In the box below the clock, select the hours, minutes, seconds, or AM/PM indicator.
3 Increase or decrease the selected value by clicking the up or down arrow.

Note
Windows uses the time setting to identify when files are created or modified.

{button ,AL("WINDOWS_DATE_CHANGE_DATE;WINDOWS_DATE_CHANGE_TIME_ZONE")} Related Topics



To change your computer's date

1 Click here        to display Date/Time properties.
2 In the Date area, select the correct month, year, and day.

Note
Windows uses the date setting to identify when files are created or modified.

{button ,AL("WINDOWS_DATE_CHANGE_TIME")} Related Topics



To change your computer's time zone

1 Click here        to display Date/Time properties.
2 In the list box above the map, select the time zone you are currently in.

Tips
You can also select a time zone by clicking your location on the map.
If you want your computer's clock to adjust automatically when daylight saving time changes, make sure a 

check mark appears in the Automatically Adjust Clock For Daylight Saving Changes box.

{button ,AL("WINDOWS_DATE_CHANGE_DATE;WINDOWS_DATE_CHANGE_TIME")} Related Topics



Displays the month setting your computer is currently using. 



Displays the year setting your computer is currently using. 



Displays the days that correspond to the selected month and year settings. The highlighted date is the one your 
computer is currently using. 



Displays the time setting that your computer is currently using. 



Shows which time zone is selected on the Time Zone tab. To change the time zone, click the Time Zone tab, and 
then click your location on the map.



Lists all available time zones.



Provides a way for you to choose a time zone by clicking an area on the map. To view all currently available time 
zones, use the list box above. 



Automatically adjusts your computer's clock when daylight saving time changes. If you use more than one 
operating system, make sure that only one of them automatically adjusts for daylight saving time.



Shows what percentage of your disk has been defragmented. You can use your computer while Disk 
Defragmenter is running. However, if a program saves information on the disk that is being defragmented, Disk 
Defragmenter will restart so it can process the newly saved information.



Stops Disk Defragmenter so you can select a different drive or quit the program.



If this button currently says Pause, clicking it pauses Disk Defragmenter. If the button says Resume, clicking it    
causes Disk Defragmenter to resume defragmenting your disk.



Shows how fragmented your disk is and enables you to watch as Disk Defragmenter defragments it.



Hides the window that displays how fragmented your disk is.



Describes what each colored block on your screen represents. 



Shows how fragmented your disk drive is. For information about what each colored block represents, click 
Legend.



Starts defragmenting the drive you selected. While Disk Defragmenter is working, you can use your computer to 
carry out other tasks. However, if a program saves information on the disk that is being defragmented, Disk 
Defragmenter will restart so it can process the newly saved information.



Click this to select a different disk drive to defragment.



Click this to specify the method you want Disk Defragmenter to use when it defragments your disk drive.



Closes Disk Defragmenter.



Lists the drives that you can defragment. Windows cannot defragment CD-ROM or network drives, or drives that 
were compressed by a disk-compression program that Windows does not support.



Resumes Disk Defragmenter after you have stopped it.



Rearranges the files and free space on your disk so each file is stored in one contiguous unit and free space is 
consolidated in one place.



Rearranges all your fragmented files so each file is stored in one contiguous unit. This method may be faster 
than fully defragmenting your disk because it does not consolidate free space. However, files you save in the 
future are more likely to be fragmented.



Consolidates the free space on your disk, which helps ensure that files you save in the future won't be 
fragmented. However, as a result of consolidating free space, the files that are already on your disk may become
more fragmented.



If this box is checked, Disk Defragmenter checks the files and folders on your drive for errors before it 
defragments the drive. 



Uses the settings you specify, but does not save them. If you want to save your settings, click Save These 
Options And Use Them Every Time.



Saves your settings. Unless you change these settings, Windows will use them every time you defragment a 
disk.



To speed up your hard disk by using Disk Defragmenter

1 Click here     to start Disk Defragmenter.
2 Click the drive you want to defragment, and then click OK.
3 If you want to change the settings that Disk Defragmenter uses, click Advanced.
4 Click Start.

Tip
While Windows defragments your disk, you can safely use your computer to carry out other tasks. 

However, your computer will operate more slowly. To temporarily stop Disk Defragmenter so you can run other 
programs at full speed, click Pause.



A file is fragmented when it becomes too large for your computer to store in a single location on a disk. When this 
happens, your computer splits the file up and stores it in pieces. You can use fragmented files, but it takes your 
computer longer to access them.
Disk Defragmenter speeds up disk access by rearranging the files and free space on your computer, so files are 
stored in contiguous units and free space is consolidated in one contiguous block.



To change the background of your desktop

1 Click here        to view Display properties.
2 In the Pattern or Wallpaper list, click the pattern or wallpaper you want to use.

Tips
To cover your entire screen with a small wallpaper image, click Tile. To center a wallpaper image, click 

Center.
You can use patterns and wallpaper simultaneously. However, if Tile is selected, you will not see the 

pattern.
By default, only a limited set of wallpapers is installed during Windows Setup. For information about 

installing a few others, click Related Topics below, and then double-click "Installing a Windows component after 
Windows has been installed."

{button ,AL("WIN_PAINT_TO_WALLPAPER;WIN_DESKPR_COLORS;WIN_DESKPR_EDIT_PATTERNS;A_ADDPROG_COM
PONENT")} Related Topics



To create or modify desktop patterns 

1 Click here        to view Display properties.
2 In the Pattern list, click the pattern you want to modify or base your new pattern on, and then click Edit 

Pattern.
3 If you want to create a new pattern, type a new name for it. If you want to modify an existing pattern, skip to 

the next step.
4 To change squares from one color to another, click them in the Pattern area. Repeat this until the pattern in the

Sample area looks the way you want it to.
5 When you are finished, click Done, and then click Yes when Windows prompts you to save the pattern.

Tips
The color of colored squares is determined by the Desktop setting on the Appearance tab.
To remove a pattern, click it in the Pattern list, click Edit Pattern, and then click Remove.



To protect your screen by setting up a screen saver

1 Click here        to view Display properties.
2 In the list in the Screen Saver area, click the screen saver you want to use.
3 To customize the screen saver, click Settings.

Tips
The screen saver starts if your computer is idle for the number of minutes specified in the Wait box. To 

clear the screen saver after it has started, move your mouse or press any key.
By default, only a limited set of screen savers is installed during Windows Setup. For information about 

installing a few others, click Related Topics below.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



To protect your files by assigning a screen-saver password

1 Click here        to view Display properties.
2 In the list in the Screen Saver area, click the screen saver you want to use.
3 Make sure Password Protected is checked, and then click Change.
4 Type your password, and then confirm the password by typing it again.

Note
If you assign a password to a screen saver, people who do not know the password cannot clear the screen 

saver, and therefore cannot easily gain access to your computer.



To change the way the items on your desktop look

1 Click here        to view Display properties.
2 If you want to change the appearance of only one screen element, click that element in the Item list. Then 

change the settings in the Item Size and Color and Font Size and Color areas.
If you want to change the appearance of all screen elements simultaneously, click an appearance scheme in 
the Scheme list.

Tip
If you change individual settings, you can save them by clicking Save As and then typing a name for the 

scheme. That name will appear in the Scheme list, so you can easily restore the settings later.



To change the number of colors your monitor displays

1 Click here        to view Display properties.
2 In the Color Palette list, click the number of colors that you want your monitor to display.

Note
Your monitor and display adapter determine the maximum number of colors that can appear on your 

screen. 



To change your screen resolution

1 Click here        to view Display properties.
2 Under Desktop Area, drag the slider.

Note
Your monitor and display adapter determine whether you can change your screen resolution.



To use larger or smaller display fonts

1 Click here        to view Display properties.
2 In the Font Size box, click the size you want your displayed fonts to be. 
3 To customize the size of displayed fonts, click Custom.

Note
If the Font Size area is unavailable, make sure your Desktop Area setting is higher than 640 by 480 pixels. 

If 640 by 480 pixels is the only setting available to you, you cannot change your display font.

{button ,AL("WIN_DESKPR_SCALE_FONTS")} Related Topics



To calibrate your display to actual dimensions

1 Click here        to view Display properties.
2 In the Desktop Area box, make sure the setting is higher than 640 by 480 pixels.

If 640 by 480 pixels is the only setting available to you, you cannot calibrate your display to actual dimensions.
3 In the Font Size area, click Custom.
4 Hold a ruler up to the ruler on your screen, and then drag the ruler on your screen to match the ruler you are 

holding.



To have your monitor automatically turn off 

1 Click here        to view Display properties.
2 To switch your monitor to standby after a specified period of time, make sure the Low-Power Standby box is 

checked. 
To turn off your monitor after a specified period of time, make sure the Shut Off Monitor box is checked. 

3 In the corresponding Minutes box, specify how many minutes you want your computer to be idle before 
Windows activates energy-saving features.

Notes
If no energy-saving settings are visible, check to make sure your monitor and your video card or system 

BIOS support Advanced Power Management (APM 1.1) or VESA BIOS Extensions for Power Management (VBE/PM). If 
your computer supports power management features, but no energy-saving settings appear, click the Settings tab, 
and then click Change Display Type. Make sure the Monitor Is Energy Star Compliant box is checked.

You can combine screen-saver and energy-saving features. For example, you could specify that after 5 
minutes your screen saver turns on, after 10 minutes your monitor goes into standby mode, and after 15 minutes 
your monitor shuts off.

{button ,AL("suspend")} Related Topics



A pattern is a design you can use to decorate your desktop. You can choose a pattern from the list, or modify an 
existing pattern by clicking it and then clicking Edit Pattern.



Wallpaper is a picture or image that you can display on your desktop. You can choose wallpaper from the list or 
use your own bitmap file, such as a drawing or scanned photograph. To use your own file, click the Browse 
button, and then specify the file's location.



Shows how a pattern or wallpaper will look on your screen. To preview a pattern or wallpaper, click its name in 
the Pattern or Wallpaper list.



Lists the available patterns you can use to decorate the desktop. To preview a pattern, click its name. 
Note    If the pattern you click does not appear on the sample monitor, make sure None is specified in the 
Wallpaper list.



Lists the available wallpaper you can use to decorate the desktop. To preview a wallpaper, click its name.



Click this to edit an existing pattern or to create a new one. 



Shows the name of the pattern you selected. To create a new pattern based on this pattern, type a new name 
here, and then modify the pattern.



Shows how the pattern will appear when it is repeated, actual size, across the desktop.



Provides a means for you to modify patterns. To reverse the color of a block, click it. The color of colored blocks is
determined by the Desktop setting that is currently specified on the Appearance tab.



Closes the Pattern Editor.



Adds a newly named pattern to the Pattern list.



Saves any changes you made to the pattern.



Removes the pattern in the Name box from the Pattern list.



Click this to search for wallpaper on other drives or in other folders. You can use most bitmap (.bmp) files as 
wallpaper.



Specifies whether a wallpaper image will cover your entire screen or appear only in the center of the screen.



Repeats small wallpaper images until your entire screen is covered.



Centers a wallpaper image on your screen.



Shows how a screen saver will look on your screen. To preview a screen saver, click its name in the Screen Saver 
list.



Lists the available screen savers. A screen saver displays moving images, which prevent damage to your screen.
The screen saver starts automatically if your computer is idle for a specified amount of time. 



Specifies how much time will elapse before Windows displays the selected screen saver. 



Starts the screen saver temporarily so you can see what it looks like. To return to Windows, move your mouse or 
press any key.



Click this to change settings for the selected screen saver.



Conserves power by switching your monitor to standby mode if your computer is idle for the number of minutes 
specified in the Minutes box. To reactivate your monitor, press a key or move your mouse.



Conserves power by shutting off your monitor. This saves more power than the Low-Power Standby mode. For 
information about how to turn your monitor back on, consult your hardware documentation.



Energy Starä is a program administered by the U.S. Environmental Protection Agency (EPA) to reduce the 
amount of power used by personal computers and peripherals. The Energy Star emblem does not represent EPA 
endorsement of any product or service.



Adjusts the speed at which shapes move on your screen.



Specifies how many lines shapes contain. 



Specifies how many curves shapes contain. Higher values result in more complex shapes.



Adjusts the amount of space that appears between the lines of each shape.



Displays curves in the color you specify. To change the color, click Choose Color.



Click this to specify the color of curves.



Changes the color of curves at random.



Displays curves and colors against a black background.



Adjusts the speed at which flying Windows logos appear on your screen.



Specifies how many flying Windows logos appear on your screen.



Enables you to assign a password to your screen saver. A password protects your computer from unauthorized 
use. Windows will not clear a screen saver until this password is typed correctly. To assign a password, click 
Change.



Displays the message in the center of your screen.



Displays the message in different places on your screen.



Adjusts the speed at which the message moves across your screen.



Lists the background colors on which you can display your message. 



Provides a place for you to type the message you want the screen saver to display. To change the font, 
formatting, or color of your message text, click Format Text.



Click this to change the font, size, and color of your message text.



Specifies which polygon you are changing settings for. You can specify different colors and a different number of 
lines for each polygon.



Displays the selected polygon using the colors and number of lines you specify. If you do not want the selected 
polygon to appear, clear this check box. 



Specifies how many lines you want the polygon in the Shape box to contain.



Specifies which colors you want the screen saver to display. To specify a color, make sure the Active box is 
checked. Then choose the colors you want from the color lists.



Displays the selected polygon in several randomly alternating colors.



Displays the polygon you selected against a black background. 



Adjusts the speed at which stars appear on your screen.



Specifies how many stars will appear on your screen.



Lists schemes that you can use to change the appearance of many screen elements simultaneously. The screen 
elements in each scheme are different colors, sizes, and formats. You can use existing schemes or create and 
save your own schemes.



Click this to save your current screen settings. The name you specify will appear in the Scheme list, so you can 
easily restore these settings later.



Provides a place for you to type a name for your current screen settings. The name you type will appear in the 
Scheme list, so you can easily restore these settings later.



Deletes the scheme that is selected in the Scheme box.



Shows how the current settings will look on the desktop.



Lists the screen elements for which you can change settings.



Lists the background colors you can use for the selected item. If this option is unavailable, you cannot change 
the item's background color.



Lists the colors you can use for the text in the selected item. If this option is unavailable, you cannot change the 
item's text color.



Specifies the size (in pixels) of the selected item. If this option is unavailable, you cannot change the item's size.



Lists the fonts you can use for the text in the selected item. If this option is unavailable, you cannot change the 
item's font.



Lists the point sizes you can specify for the text in the selected item. If this option is unavailable, you cannot 
change the point size.



Makes the text in the selected item bold. If this option is unavailable, you cannot change the formatting.



Makes the text in the selected item italic. If this option is unavailable, you cannot change the formatting.



Shows how the current settings will look on your screen. 



Lists the color palettes that your display adapter and monitor support.



Increases or decreases the amount of information that appears on your screen. Your monitor and display adapter
determine whether you can change this setting. This is sometimes referred to as "resolution."



Changes the size of the text that Windows displays. If this setting is unavailable, you cannot change the font 
size.



Click this to customize the size of the fonts that Windows displays. If this button is unavailable, you cannot 
change the font size.



Click this to install the software for a new display adapter or monitor.



Shows how large the current screen font is in relation to the standard Windows font. You can type a different 
percentage in this box.



Provides a way for you to calibrate the fonts your computer displays. If you want to calibrate your display to 
actual dimensions, hold a ruler up to your display, and then drag the ruler that appears on the screen to match 
it.



Shows how the percentage that appears above affects the size of the text that will appear on your screen.



Shows what type of display adapter you are currently using. To install the software for a new display adapter, 
click Change.



Click this to install the software for a new display adapter.



Shows what type of monitor you are currently using. To install the software for a new monitor, click Change.



Displays information about your display adapter.



Click this to install the software for a new monitor. 



Indicates that your monitor can reduce its power usage. For Windows to take advantage of this feature, the 
monitor must adhere to the VESA Display Power Management Signaling (DPMS) specification or to another 
method of lowering power consumption (such as the LCD screens on portable computers). If your monitor has an
Energy Starä emblem, it probably supports DPMS. Energy Star is a program administered by the U.S. 
Environmental Protection Agency (EPA) to reduce the amount of power used by personal computers and 
peripherals. The Energy Star emblem does not represent EPA endorsement of any product or service.
Note    If the information on your screen appears garbled or otherwise irregular when your power management 
screen saver turns on, clear this check box.          



Hardware Conflict Troubleshooter

This troubleshooter helps you identify and resolve hardware conflicts. Just click to answer the questions, and 
then follow the step-by-step instructions to fix the problem. To move back a step, click Back at the top of each 
Help window.

What do you want to do?
            Start the Hardware Conflict Troubleshooter.  
            Display an overview of the process.  



Overview of resolving conflicts

When more than one device on your system tries to use the same resource (for example, a specific location in 
memory), a hardware conflict results. This troubleshooter helps you resolve such conflicts. To use this 
troubleshooter, follow the step-by-step instructions.
If you prefer to resolve the conflict on your own, you can work in Device Manager and try the following 
strategies:

Identify a free resource, and assign it to the device that is causing the conflict.
Disable a conflicting device to free up its resources.
Rearrange resources used by one or more other devices to free up resources needed by the device that is 

causing the conflict.
Change jumpers on your hardware to match the new settings.

What do you want to do?
            Start the Hardware Conflict Troubleshooter.  
            Start Device Manager and try to resolve this conflict myself.  
            Close this troubleshooter.  



Start Device Manager

1 Click here  to view Device Manager.
2 Make sure View Devices By Type is selected.
            Click here to continue.  



Determine if the device was installed twice
If the hardware that has the conflict isn't visible in the list, click the plus sign next to the type of hardware.

Is the device you were installing (or that had the conflict) listed twice?
            No, the device is listed only once.  
            Yes, it is listed twice. I have only one of this kind of device.  
            Yes, it is listed twice, but I have two of this kind of device.  



Remove the duplicate devices and install again

1 Remove each duplicate item from the hardware list. To do this, click its name, and then click Remove. When 
you are finished, no instances of the hardware should be listed.

2 Click OK.
3 Click here  to start the Add New Hardware wizard.

If you see a message that you already have a wizard open, click Finish in that wizard, and then click the 
button in this step to start a new wizard.
4 Click Next.
5 Click the option to automatically detect your hardware, and then click Next.

Continue until you finish the wizard.

Did this fix the problem?
            Yes. Close this troubleshooter.  
            No, I want to continue troubleshooting.  



View resource settings for the device

1 Click here  to view Device Manager.
2 Double-click the hardware that has a conflict.
3 In the Device Usage area, make sure that there is a check in the box next to the configuration marked 

"Current." If the box isn't checked, click it.
4 Click the Resources tab.

Do you see a box with resource settings?
            Yes.  
            No, I see a Set Configuration Manually button.  
            This device does not have a Resources tab.  



View resource settings for the device

1 Double-click the hardware that has a conflict.
2 In the Device Usage area, make sure that there is a check in the box next to the configuration marked 

"Current." If the box isn't checked, click it.
3 Click the Resources tab.

Do you see a box with resource settings?
            Yes.  
            No, I see a Set Configuration Manually button.  
            This device does not have a Resources tab.  



Identify which resources are causing the conflict
In the Conflicting Device List box, identify the hardware that is using conflicting resources.

Is more than one resource conflict listed?
            Yes.  
            No, only one conflict is listed.  
            One or more of the conflicts show System Reserved as the conflict.  
            There are no conflicts listed.  



No conflicts listed

If there are no conflicts listed in the Conflicting Device List box, either you are not viewing resources for the 
correct device or the conflict has already been resolved, but you need to restart your computer to allow Windows
to configure the hardware.
Look at the top of the dialog box to see if you are viewing resources for the correct device.

Are you viewing resources for the correct device?
            No.  
            Yes.  



View resources for the correct device

1 Click Cancel to return to the hardware list.
2 Find the correct device in the hardware list, and then double-click it.
3 Click the Resources tab.
4 In the Conflicting Device List box, identify the hardware that is using conflicting resources.

Is more than one resource conflict listed?
            Yes.  
            No, only one conflict is listed.  
            One or more of the conflicts show System Reserved as the conflict.  
            There still are no conflicts listed.  



Try restarting your computer

Restarting your computer may help resolve the conflict. If you restart your computer and Windows still displays a
message that you have a hardware conflict, begin this troubleshooter again.

Click the Start button, click Shut Down, and then click Restart The Computer.



Your resource setting is reserved

It is likely that this resource setting will not cause a problem if it conflicts with a resource reserved by your 
system. You can either free the resource now, or wait to see if it causes problems.
If it does cause problems later, you can either free the resource setting or change the setting for the device so it 
doesn't conflict with a reserved resource setting.

Do you want to free the resource now?
            Yes.  
            No.  



Are any other conflicts listed?
            Yes, more than one setting still conflicts.  
            Yes, only one more conflict is listed.  
            No more conflicts are listed. Close the troubleshooter.  



Free the reserved resource setting

1 Click OK to return to the hardware list.
2 Click Computer at the top of the list, and then click Properties.
3 Click the Reserve Resources tab.
4 Click the type of resource setting that is conflicting, and then click the resource setting.
5 Click Remove, and then click OK.
6 Double-click the device that was conflicting, and then click the Resources tab.
            Click here to continue.  



Determine why resources aren't displayed

When the Resources tab shows a Set Configuration Manually button, it is either because the device has a conflict
or other problem and is disabled, or because the resource settings used by this device are working properly but 
they don't match any of the known configurations.
You can tell which situation applies by reading the text above the button.

Which message do you see?
            My device is conflicting, or the device is not currently enabled or has a problem.  
            The resource settings don't match any known configurations.  



Identify which hardware is conflicting

1 Click Set Configuration Manually.
2 In the Conflicting Device List box, identify the other hardware that is using the conflicting resources.

Is more than one resource conflict listed?
            Yes.  
            No, only one conflict is listed.  
            There are no conflicts listed.  



No conflicts listed

If there are no conflicts listed in the Conflicting Device List box, either you are not viewing resources for the 
correct device, or the conflict has already been resolved but you need to restart your computer to allow Windows
to configure the hardware.
Look at the top of the Resources tab to see if you are viewing resources for the correct device.

Are you viewing resources for the correct device?
            No.  
            Yes.  



Select the correct device

1 Click Cancel to return to the hardware list.
2 Double-click the correct device.
3 Click the Resources tab.
4 In the Conflicting Device List box, identify the hardware that is using conflicting resources.

Is more than one resource conflict listed?
            Yes.  
            No, only one conflict is listed.  
            There still are no conflicts listed.  



How many devices are listed as conflicting?
            Only one device is causing all the conflicts.  
            More than one device is causing the conflicts.  



Look for resource settings that don't conflict

1 In the Resource Settings box, double-click the icon next to a resource setting that is conflicting.
If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

2 Scroll through the available resource settings.
3 For each setting, look in the Conflicting Device List box to see if it conflicts with any other hardware.
4 When you find a free setting, click OK.
5 Repeat steps 1 through 4 for each conflicting resource.

Did you find a free setting for each conflicting resource?
            Yes, all the resources are now set without any conflicts.  
            No, some or all of the resources are still conflicting.  
            No, I saw a message that said the resource setting cannot be modified.  



View the resources for the other device

1 In the Conflicting Device List box, make a note of which device is using the resource that cannot be modified.
2 Click Cancel.
3 In the hardware list, find and double-click the device that is using the resource.

Does this device have a Resources tab?
            Yes.  
            No.  



Check to see if the device can use a different resource

1 Click the Resources tab.
2 In the Resource Settings box, double-click the resource setting that you need to free for the other device.

If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

3 Scroll through the available resource settings.
4 For each setting, look in the Conflicting Device List box to see if it conflicts with any other hardware.
5 If you find a free setting, click OK. If you see a message prompting you to restart your computer, click No.

Did you find a free setting?
            Yes, I found a free setting.  
            No, I did not find a free setting, or the settings can't be modified.  



Determine whether there are any remaining conflicts
1 Click OK to return to the hardware list.
2 Double-click the device that had the original conflict.
3 Click the Resources tab.
4 See if there are any remaining conflicts listed in the Conflicting Device List box.

If the conflict you just resolved is listed, you can ignore it. It will no longer conflict after you restart your 
computer later in this process.

Are there still conflicts listed?
            No, all the resources are now set without any conflicts.  
            Yes, some or all of the resources are still conflicting.  



Decide which device to disable

Because both devices need to use the same resource setting, you must decide which device you want to use. 
You must disable and remove the other device.
It probably is easier to remove the device that had the original conflict. If you choose to remove the other device,
then after you finish this set of procedures and restart your computer, you may see a message telling you that 
you still have a conflict. Just restart this troubleshooter, and continue resolving the conflict.

Which device would you like to disable?
            The device with the original conflict.  
            The other device that it is conflicting with.  



Determine whether you have to remove the card to disable the hardware

1 On the hardware list, double-click the hardware that you want to disable.
If you do not see the hardware list, click Cancel until you return to it.

2 In the Device Usage area, make sure that there is a check in the box next to the configuration marked 
"Current." If the box isn't checked, click it.

3 Click the Resources tab.
If there is a Set Configuration Manually button, Windows can free up resources for this hardware without your 
removing its card from your computer.

Do you see a Set Configuration Manually button?
            Yes, I see that button, and there are no resource settings listed in the box.  
            No, I don't see that button.  



Determine whether you have to remove the card to disable the hardware

1 On the hardware list, double-click the hardware that you want to disable.
If you do not see the hardware list, click Cancel until you return to it.

2 In the Device Usage area, click the box next to the configuration marked "Current" to remove the check mark.
3 Click the Resources tab.

If there is a Set Configuration Manually button, Windows can free up resources for this hardware without your 
removing its card from your computer.

Do you see a Set Configuration Manually button?
            Yes.  
            No, I don't see that button.  



Restart your computer

1 Click OK, and then click OK again.
2 You may be prompted to restart your computer. Click Yes.



Disable your hardware

1 On the hardware list, click the plus sign next to the type of hardware that you want to disable.
If you do not see the hardware list, click Cancel until you return to it.

2 Click the hardware you want to disable.
3 Click Remove, and then click OK.
4 You may be prompted to restart your computer. You will have to remove the card for this hardware from your 

computer, so you need to shut down instead of restarting. Click No.
5 Click the Start button, click Shut Down, and then click Yes.

When the message says it is safe to do so, turn off your computer and remove the card from your computer. 
For instructions, see your hardware documentation.



Print a report for each device you changed

1 In the hardware list, click a device whose resource settings you changed while resolving the conflict.
If you do not see the hardware list, click OK until you return to it.

2 Click Print.
3 Click the second option to print the selected class or device.
4 Click OK.
5 Repeat steps 1 through 4 for each device that you changed during this troubleshooting process.

Did the report print properly?
            Yes.  
            No.  



Write down the hardware settings

1 In the hardware list, double-click a device that you changed while resolving the conflict.
2 Click the Resources tab.
3 Write down all the settings you see in the Resource Settings box.
4 Click Cancel.
5 Repeat steps 1 through 4 for each device that you changed during this troubleshooting process.
            Click here to continue.  



Important information about what to do with these reports

Note    To print this Help topic, click the Options button at the top of the Help window, and then click Print Topic.
The report you print tells you the way your hardware cards should be configured to ensure that they work 
properly. If the cards aren't set properly, your hardware will not work, even if you resolved the conflict correctly. 
Depending on the type of hardware you have, your card may be able to be configured automatically (if it is a 
Plug and Play device), or you can configure it by using a utility provided by your hardware manufacturer or by 
changing jumpers on the hardware. If you changed more than one piece of hardware, each device may need to 
be configured in a different way.
The configuration information you need is in the "Resources" section of the reports. See your hardware 
documentation for instructions on setting the jumpers on your hardware cards to match this configuration.
You may also have to remove the card(s) for the disabled device(s) from your computer to free up resources for 
other devices. If you have disabled the device, it does not show any resource settings in use, and if you see a Set
Configuration Manually button in the Resources window, then you do not have to remove the card for the device.
In the next procedure, you will shut down your computer. You should then check to see whether you need to 
change jumpers on your hardware to match the settings on your printouts, or run a configuration utility. If you 
do, refer to your hardware documentation for further instructions.
            Click here to continue.  



Restart your computer

1 Click OK.
2 You may see a message prompting you to restart your computer. Click No.
3 Click the Start button, click Shut Down, and then click Yes.

When Windows says it is safe to do so, turn off your computer so you can configure the devices that changed. 
For more information about how to do this, see your hardware documentation.



Set resources to conflict with only one device

1 Double-click a resource that is still conflicting.
If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

2 Scroll through the available resource settings. For each value, write down the setting and the name of the 
hardware it conflicts with. Then click Cancel.

3 Repeat steps 1 and 2 for each conflicting resource.
4 Looking at the list, see if you can change the resource settings so they conflict with only one device, preferably

one you could disable. 

Are all conflicts with one device?
            Yes, all the conflicts are with only one device.  
            No, the resources still conflict with more than one device or cannot be changed.  



Do you want to disable the device that is causing all the conflicts?
            Yes.  
            No, I want to use the hardware that is causing the conflicts.  



Look for a resource setting that doesn't conflict

1 In the Resource Settings box, double-click the icon next to the resource setting that is conflicting.
If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

2 Scroll through the available resource settings.
3 For each setting, look in the Conflicting Device List box to see if it conflicts with any other hardware.
4 If you find a free setting, click OK.

Did you find a setting that doesn't conflict with any other hardware?
            Yes. I found a free setting.  
            No, all of the settings conflicted with other hardware.  
            No, I saw a message that said the resource setting cannot be modified.  



Set the new value

1 Make a note of the old and new settings to refer to later.
2 Click OK. If you see a message prompting you to restart your computer, click No.
            Click here to continue.  



Important information about changing hardware jumpers

Depending on the type of hardware you have, you may have to change the jumpers on your hardware card to 
match the new setting, or you may have to run a configuration utility provided by your hardware manufacturer. If
the jumper settings on your card aren't set properly, your hardware will not work, even if you resolved the 
conflict correctly.
In the next procedure, you will shut down your computer. Refer to your hardware documentation for instructions 
on changing jumpers.
            Click here to continue.  



Identify hardware you no longer need

1 Scroll through the available resource settings. 
2 When a conflict appears in the Conflicting Device List box, determine whether you still need to use the device 

that is causing the conflict.

Did you identify a hardware device that you no longer need to use?
            Yes, I want to disable the hardware I no longer need.  
            No, I use all of the hardware that is conflicting.  



Write down a list of all devices using resources

1 Scroll through the settings. On a piece of paper, write down the name of each piece of conflicting hardware 
and its setting.

2 Click Cancel until you return to the hardware list.
            Click here to continue.  



Rearrange resource settings for conflicting hardware

1 On the hardware list, click the plus sign next to the hardware type for the first item on your written list.
2 Double-click the hardware.
3 Click the Resources tab.
4 Double-click the resource setting that you wrote down.

If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

5 Scroll through the available resource settings. For each setting, look in the Conflicting Device List box to see if 
it conflicts with any other hardware.

6 If you find a free setting other than the one you wrote down, write down the new values, and continue to the 
next procedure.
If you do not find a free setting, repeat steps 1 through 5 until you run out of hardware to try or you find a free 
setting.

Did you find a free resource setting?
            Yes.  
            No, there are no free resource settings for any of the hardware on my list.  



Change the resource settings

1 Save the new setting by clicking OK and then clicking OK again.
2 If you see a message about restarting your computer, click No.
3 Double-click the hardware that first had the conflict.
4 Click the Resources tab.
5 Double-click the resource that is conflicting.

If you see a message that says you must clear the Use Automatic Settings box before you can change a 
resource setting, click OK to close the message, and then clear the Use Automatic Settings box.

6 Change the resource setting to the value you just freed. The Conflicting Device List box may show a conflict 
with the other hardware that you just changed.

7 Click OK. If you see a message, click Yes to continue.
            Click here to continue.  



Do you want to disable the hardware that caused the original conflict?
            Yes, I want to disable this hardware.  
            No, I still want to use this hardware.  



Determine how to disable the hardware

1 On the hardware list, double-click the hardware that you want to disable.
If you do not see the hardware list, click Cancel until you return to it.

2 In the Device Usage area, click the box next to the configuration marked "Current" to remove the check mark.
3 Click the Resources tab.

If there is a Set Configuration Manually button, Windows can disable and free up resources used by this 
hardware without your removing its card from your computer.

Do you see a Set Configuration Manually button?
            Yes.  
            No, I don't see that button.  



Determine whether the hardware you want to disable is Plug and Play

1 Select each resource setting that conflicts with the hardware you will disable, and then click OK.
2 When the message appears saying the setting conflicts with another device, click Yes to continue.
3 Click OK until you return to the hardware list.
4 Click the plus sign next to the type of hardware that you want to disable.
5 Double-click the hardware that you want to disable.
6 In the Device Usage area, click the box next to the configuration marked "Current" to remove the check mark.
7 Click the Resources tab.

If there is a Set Configuration Manually button, Windows can disable and free up resources used by this 
hardware without your removing its card from your computer.

Do you see a Set Configuration Manually button?
            Yes.  
            No, I don't see that button.  



Hardware is disabled
Click OK.

            Click here to continue.  



Disable hardware by removing it

1 On the hardware list, click the plus sign next to the type of hardware that you want to disable.
If you do not see the hardware list, click Cancel until you return to it.

2 Click the hardware you want to disable.
3 Click Remove.
            Click here to continue.  



The device is not using any resources

If the device doesn't have a Resources tab, the device is not using any resource settings, and therefore should 
not be listed as conflicting.
Make sure you are viewing properties for the correct device.
Look at the top of the dialog box to see if you are viewing resources for the correct device.

Are you viewing resources for the correct device?
            No.  
            Yes.  



Select the correct device

1 Click Cancel to return to the hardware list.
2 Double-click the hardware that has a conflict.
3 In the Device Usage area, make sure that there is a check in the box next to the configuration marked 

"Current." If the box isn't checked, click it.
4 Click the Resources tab.

Do you see a box with resource settings?
            Yes.  
            No, I see a Set Configuration Manually button.  
            This device does not have a Resources tab.  



Next steps

You've encountered a hardware conflict problem that this troubleshooter can't help you solve.
For more information, try looking in the documentation for your hardware, or call your hardware support line.
            Close the troubleshooter.  



Specifies the phone number in a format that can be dialed from any location or with a calling card.
The international format is: 

+CC (AC) NUMBER

where CC is the country code, AC is the area or city code, and NUMBER is the local phone number. Type the plus 
sign, parentheses, and spaces exactly as shown. 
For example, the international format for a number might be:
 +1 (901) 5551234.



Contains exactly the digits you want to dial. This format is often used when you want to call internal extensions 
or special numbers, such as for an operator, emergency services, or directory assistance.
Calls in this format are dialed exactly as they are shown, regardless of what location you specify. Calling cards 
cannot be used.
For example, the dialable format for an internal extension might be 2414.



Specifies where you will be when you make the call. The location information is used to determine if a phone 
number is local, long distance, or international. 
Location information is used only for phone numbers entered in international format.



Defines a card number for each calling card and a procedure for using that card for local, long-distance, and 
international calls. Calling cards are used only with phone numbers entered in international format.
Calling-card numbers can also be used if you need to specify dialing rules that require unconventional 
procedures. For example, you could set up a calling card if you need to dial an account code after the phone 
number.



Telephony devices provide a way for your computer to dial a phone line. The most common type is a modem 
connected to a phone line. Other devices enable people to share a pool of modems. Check your modem 
documentation to make sure it is compatible with telephony.



Use pause characters in a phone number to pause dialing:
, Pause for a fixed time, typically two seconds.
! Hookflash (1/2 second on-hook, 1/2 second off-hook).
W Wait for one second of dial tone.
@ Wait for quiet answer (ringback followed by five seconds of silence).
$ Wait for calling-card prompt ("bong") tone.
? Ask for input before dialing continues. 



Typically specifies an access number that you dial at the beginning of a phone call.



You can use the following characters to specify the rules for dialing calls:
Ente

r
To specify

0-9 Dialable digits
ABCD Dialable digits (tone dialing only; 

used for special control on some
systems)

E Country code
F Area code (city code)
G Local number
H Card number
*,# Dialable digits (tone dialing only)
T Following digits are to be tone 

dialed
P Following digits are to be pulse 

dialed
, Pause for a fixed time
! Hookflash (1/2 second on-hook, 1/2 

second off-hook)
W Wait for second dial tone
@ Wait for quiet answer (ringback 

followed by five seconds of 
silence)

$ Wait for calling-card prompt 
("bong")

? Ask for input before dialing 
continues

In North America, specifies the first three digits of a local telephone number. For example, if the local number is 
555-1234, the prefix is 555.



Modem Troubleshooter

This troubleshooter will help you identify and solve modem problems. Just click to answer the questions, and 
then try the suggested steps to fix the problem.

What's wrong?
            I don't know how to install my modem.  
            Dialing doesn't work correctly.  
            I can't connect to another computer, or the connection doesn't work properly.  
            I can't transfer a file to or from another computer.  
            Dial-Up Networking doesn't work correctly.  



Install your modem

1 Click here        to start the Install New Modem wizard.
2 Follow the instructions on your screen.



What kind of dialing problem is occurring? 
            The number is not being dialed at all.  
            The wrong number is being dialed.  
            My calling-card call doesn't go through.  
            I get an error message from the operator.  
            I can't dial international calls.  
            I can't make a local call to a different area code.  
            I can't make a long-distance call to the same area code.  
            I have a different dialing problem.  



What kind of dialing problem is occurring?
            The call is canceled before it finishes going through.  
            The modem does not detect the dial tone.  
            I have a different dialing problem.  



Disable dial-tone detection

1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Properties. 
3 On the Connection tab, make sure the box labeled Wait For Dial Tone Before Dialing is not checked.
4 Try the call again. 

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work. What else could be wrong?  



Increase the time length before canceling calls

1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Properties. 
3 On the Connection tab, make sure the box labeled Cancel The Call If Not Connected Within is not checked. 

If you do not want to disable this option, increase the number of seconds.
4 Try the call again. 

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work. What else could be wrong?  



Check your location setup

1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Dialing Properties.
3 On the My Locations tab, make sure that you have specified your current location.

Because dialing procedures vary by location, you need to specify the location you are calling from each time 
you move your computer.

4 If the specified location is not correct, click the location you are calling from.
5 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.   



Dial a local call in a different area code

If you need to dial a local call in a different area code, Phone Dialer may try to dial the call as long distance. To 
dial the call successfully, enter the phone number as shown below.

Enter the area code for the number as your own area code, and include the actual area code in the 
telephone number. 

For example, if your phone number is in the 212 area code, to dial a local phone number 555-1212 in the 718 
area, change the phone number entry to +1(212)718 5551212. 

Tip
If you are using HyperTerminal, make sure the box labeled Use Country Code And Area Code is not 

checked. Then type the phone number as shown in the example.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



Dial a long-distance call in the same area code

If you need to dial a long-distance call in the same area code you are calling from, Phone Dialer may try to dial 
the call as a local call. To dial the call successfully, enter the phone number as shown below.

Enter the area code for the number, and include the actual area code in the telephone number. 
For example, if the number you are calling from is in the 214 area code, to dial a long-distance phone number 
555-1212 in the same area, change the phone number entry to +1(214)214 5551212. 

Tip
If you are using HyperTerminal, make sure the box labeled Use Country Code And Area Code is not 

checked. Then type the phone number as shown in the example.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



What kind of connection problem is occurring?
            I can't connect to the remote computer.  
            The remote computer hangs up unexpectedly.  
            I can connect to the remote computer, but random characters appear on the screen.  
            I can connect to the remote computer, but the connection is very slow.  



What happens when you try to transfer files?
            The transfer is very slow.  
            I can't send files at all.  
            I can't receive files at all.  
            I have a different problem.  



Check your transfer protocol

1 On the Transfer menu, click Send File.
2 Make sure the transfer protocol you are using is the same one the remote computer is using.
3 Try to send the file again.

Did this fix the problem?
            Yes. The file transfer worked. Close the troubleshooter.  
            No. It still doesn't work.  



Check your transfer protocol

1 On the Transfer menu, click Receive File.
2 Make sure the transfer protocol you are using is the same one the remote computer is using.
3 Try to transfer the file again.

Did this fix the problem?
            Yes. The file transfer worked. Close the troubleshooter.  
            No. It still doesn't work.  



Which transfer protocol are you using?
            I am using Ymodem-G.  
            I am using a different protocol.  



Make sure error control is available

The Ymodem-G transfer protocol is for modems that provide error control. If your modem does not provide error 
control, use a different transfer protocol, such as Ymodem or Xmodem. 
1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Properties.
3 Click the Connection tab, and then click Advanced.
4 If Use Error Control is available, make sure the check box is checked.
5 Try your transfer again.

Did this fix the problem?
            Yes. The file transfer worked. Close the troubleshooter.  
            No. It still doesn't work.  



Try a different protocol
Try your file transfer again, using a different transfer protocol. 

Tip
Make sure you are using a common transfer protocol, such as Xmodem. 

Did this fix the problem?
            Yes. The file transfer worked. Close the troubleshooter.  
            No. It still doesn't work.  



What message do you get?
            You must first dial 1 and then the area code.  
            I get a different message.  



Specify the call as long distance

In North America, or if you have specified the number in international format, some prefixes within your area 
code are long distance and some are local. 
1 If you are using Phone Dialer, click Dial, click Change Options, and then click Dialing Properties.

If you are using HyperTerminal, click the Call menu, click Connect, and then click Dialing Properties.
2 On the My Locations tab, make sure Dial As A Long Distance Call is checked. 

If you have no calling card, make sure Dial Using Calling Card is not checked.
3 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



Identify the number dialed

1 Click here        to start Phone Dialer.
2 Use Phone Dialer to dial a number.
3 Look in the Dialing dialog box to see what number was actually dialed.

Which of the following happened?
            Phone Dialer dialed a country code or area code when it shouldn't have.  
            Phone Dialer didn't dial 9 when it should have.  
            I have a different dialing problem.  



Check your modem and cable setup

1 Make sure your communications port and modem are connected by a cable, and that your modem is plugged 
into the phone jack.

2 Try the call again.

Did this fix the problem?
            Yes. It worked. Close the troubleshooter.  
            No. The cables are fine. What else could cause this problem?  



Check the port settings for your modem

1 Click here        to display Modem properties. 
2 Click the General tab, and then click the modem you are using.
3 Click Properties. Make sure the port listed is the one your modem is connected to.
4 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



I can't dial using my calling card
            Phone Dialer dials the number too soon.  
            Phone Dialer never dials the number.  
            I have a calling card that isn't on the list.  



Check your calling-card setup

1 If you're using Phone Dialer, click the Tools menu, and then click Dialing Properties. 
If you're using HyperTerminal, click the Call menu, click Connect, and then click Dialing Properties.

2 Click Change.
3 Click the calling card you're using, and then click Advanced.
4 Add a comma after the H representing the calling-card access number. This adds a short pause before the 

number is dialed.
If this doesn't solve the problem, look at the available pause characters, and try a different one.

5 Try the call again.

Did this fix the problem?
            Yes.    My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



Make sure you are using your calling card

1 If you're using Phone Dialer, click the Tools menu, and then click Dialing Properties. 
If you're using HyperTerminal, click the Call menu, click Connect, and then click Dialing Properties.

2 Make sure the box labeled Dial Using Calling Card is checked. 
3 Try your call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It was already checked. What else could be wrong?  



Check the dialing rules for your calling card

1 If you're using Phone Dialer, click the Tools menu, and then click Dialing Properties. 
If you're using HyperTerminal, click the Call menu, click Connect, and then click Dialing Properties.

2 Click Change.
3 Click the calling card you're using, and then click Advanced.
4 Try using a different pause character. In each phone number box, there is a pause character between the 

calling-card access number and the codes for area code or country code. 
5 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



Add a new calling card

1 If you're using Phone Dialer, click the Tools menu, and then click Dialing Properties. 
If you're using HyperTerminal, click the Call menu, click Connect, and then click Dialing Properties.

2 Click Change.
3 Click New, and then type a name for this calling card.
4 Click Advanced, and then fill in the appropriate information. Information about how to dial a call usually 

appears on the back of your card, or you may need to contact your calling-card vendor. You must translate this
information into dialing rules for local, long distance, and international calls. 

Tip
You can copy the dialing rules from any other calling card by clicking Copy From. Make sure to change the 

access number.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.  



Check the location you're calling from

1 On the Tools menu, click Dialing Properties.
2 On the My Locations tab, make sure you have specified your current location.

Because dialing procedures vary by location, you need to specify the location you are calling from each time 
you move your computer.

Which location are you calling from?
            I am not at the place specified in the I Am Dialing From box.  
            I am at the place specified in the I     Am Dialing From box.  



Check the settings for current location

1 Make sure your area code and country code are correct.
2 Make sure the options for dialing from this location are correct.
3 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.   



Define your current location

1 On the Tools menu, click Dialing Properties.
2 On the My Locations tab, click the location you're calling from. If your location isn't on the list, click New.
3 Type a name for the location.
4 Make sure your area code and country code are correct.
5 Make sure the settings for how you dial from this location are correct.
6 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.   



Phone Dialer isn't dialing 9 when it should
            It dials 9 even when it shouldn't.  
            It never dials 9 even when it should.  



Check your location setup

1 On the Tools menu, click Dialing Properties.
2 On the My Locations tab, make sure that you have specified your current location.

Because dialing procedures vary by location, you need to specify the location you are calling from each time 
you move your computer.

3 If the specified location is not correct, click the location you are calling from.
4 Make sure you have not entered 9 in the To Access Outside Line boxes.
5 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.   



Check your location setup

1 On the Tools menu, click Dialing Properties.
2 On the My Locations tab, make sure you have specified your current location.

Because dialing procedures vary by location, you need to specify the location you are calling from each time 
you move your computer.

3 If it is not correct, click the location you are calling from.
4 Make sure you have entered 9 in the To Access Outside Line boxes.
5 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.   
            No. It still doesn't work.   



Check the format of the telephone number

1 Make sure the number you're dialing is in international format, which is necessary if you use location 
information. International format looks like the following:
+country-code (area-code) phone-number
Type the plus sign, parentheses, and spaces exactly as shown. 
Only the digits 0 through 9 should appear in the country code and area code. The phone number can contain 
hyphens, periods, spaces, and other formatting characters.

2 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. It still doesn't work.   



Next steps

You've run into a dialing problem that the Modem Troubleshooter can't help you solve. 
For more information, try looking in the documentation for your modem or other telephony device. 
            Go back to the beginning of the troubleshooter.  
            Close the troubleshooter.  



Does your telephone line have Call Waiting?
            Yes, it does.  
            No. it doesn't.  



Turn off Call Waiting

If the phone line you use has Call Waiting, and someone calls while you are using your modem, extra characters 
might appear on the screen or even disconnect you from the remote computer. 
1 End your session with the remote computer. 
2 Click here        to display Modem properties. 

3 Click the General tab, and then click Dialing Properties.
4 Click This Location Has Call Waiting. 
5 In the box to the right of To Disable it, Dial, type the numbers that cancel Call Waiting (you can usually find 
these instructions in the telephone book), or click a number in the list.
6 Try the call again.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. I turned off Call Waiting and I'm still having trouble. What else could be wrong?   



Turn on Error Control

1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Properties. 
3 Click the Connection tab, and then click Advanced. 
4 Click the box labeled Use Error Control, if it is not unavailable. 
5 Try the call again. 

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. I'm still having trouble.   



Check your terminal type

1 On the File menu, click Properties.
2 Click the Settings tab.
3 Look at the Emulation box to see what terminal type HyperTerminal is emulating. Make sure the emulation is 

set either to Auto Detect or to the same terminal type the remote computer is emulating. 
To set the terminal type, click the Emulation box. Then click the terminal type you want.

Did this fix the problem?
            Yes. My call went through. Close the troubleshooter.  
            No. I'm still having trouble.   



Check your modem speed

1 Click here        to display Modem properties. 
2 Click the General tab, click the modem you are using, and then click Properties.
3 Make sure the Maximum Speed value is the highest that can be used by both your modem and the remote 

computer's modem. (If you are not sure of the maximum speed to use, contact that computer's administrator.)
4 Make sure Only Connect At This Speed is not checked. 
5  Try the call again. 

Did this fix the problem?
            Yes. I was able to connect. Close the troubleshooter.  
            No. I'm still having trouble.   



Check your modem's port settings

1 Click the Connection tab.
2 Make sure the Data Bits, Parity, and Stop Bits settings are set correctly for the remote computer. (If you are not

sure of the settings to use, contact that computer's administrator.)
3 Try the call again.

Did this fix the problem?
            Yes. I was able to connect. Close the troubleshooter.  
            No. I'm still having trouble.  



Try your call again 
You may be experiencing line noise or cable problems. Try your call again.

Did this fix the problem?
            Yes. I was able to connect. Close the troubleshooter.  
            No. I'm still having trouble.  



Check your modem speed

1 On the Call menu, click Disconnect.
2 Click here        to display Modem properties. 

3 Click the General tab, and then click the modem you are using.
4 Click Properties. Make sure the Maximum Speed is the highest that can be used by both your modem and 
the remote computer's modem. (If you are not sure of the maximum speed to use, contact that computer's 
administrator.)
5 Try the call again. 

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. The connection is still slow.  



Try your call again
If other people are using the remote computer, it may run more slowly. Try again later when fewer people 

may be connected to the remote computer.
            Click here to close the troubleshooter.  
            Click here to return to the beginning of the troubleshooter.  



Contact the computer's administrator
You may have gone too long without typing anything, or your account may have a limit to how long you 

can be connected to the computer. Try the call again, and ask the remote computer's administrator about having 
your time limit increased. 

Did this fix the problem?
            Yes. I was able to reconnect. Close the troubleshooter.  
            No. I'm still having trouble.  



Contact the computer's administrator
Find out if the computer is working correctly. It may have been shut down for maintenance. 

            Click here to close the troubleshooter.  
            Click here to return to the beginning of the troubleshooter.  



Lists the locations that are currently set up. To set up an additional location, click New.



Click this to add a new location.



Removes the selected location from the list.



In the first space, type the number(s) required to access an outside line for local calls. In the second space, type 
the number(s) required to access an outside line for long distance calls. In many cases, these two numbers will 
be the same.
If you do not have to dial any numbers to access an outside line, leave both spaces blank.



Provides a space for you to type the area code for this location.
If you are in a country other than the United States, type your city code here, but do not include the leading 0. 
For example, if your city code is 071, just type 71.



If checked, displays the calling card that should be used when you call from this location.
This calling card will be used whenever you are at this location and you dial from any program on this computer.



Click this to change the calling card to be used for this location.



Specifies whether this location uses call waiting.
Call waiting should be turned off while you're dialing from your computer. Contact your local phone company for 
information about how to turn off this feature.



Specifies which type of dialing to use.
Specify pulse dialing only if this is the only type your phone line supports.



Specifies whether the number should be dialed as a long-distance call.
Check this box for all numbers outside the local area code.



Displays the phone number to be dialed.



Displays your current country code.



Lists common calling cards in addition to any that you have previously defined.



Click this to add a new calling card.



Removes the selected calling card from the list.



Click this to set up dialing rules for the specified calling card.
This is useful if your call is not getting through when you use the default rules for this card.



Provides a space for you to type your calling-card account number.



Provides a space for you to type the rules for dialing calls.
You can use the following characters to specify the rules for dialing calls:
Enter To specify
0-9 Dialable digits
ABCD Dialable digits (tone dialing only; used for special control on some systems)
E Country code
F Area code (city code)
G Local number
H Card number
*,# Dialable digits (tone dialing only)
T Following digits are to be tone dialed
P Following digits are to be pulse dialed
, Pause for a fixed time
! Hookflash (1/2 second on-hook, 1/2 second off-hook)
W Wait for second dial tone
@ Wait for quiet answer (ringback followed by five seconds of silence)
$ Wait for calling-card prompt ("bong")
? Ask for input before dialing continues



Click this to copy the dialing rules from another calling card.



Lists the calling cards that already have dialing rules defined.



Provides a space for you to type the name of the calling card you are setting up.



Provides a space for you to type the name of the location you are setting up.



Disk Space Troubleshooter

This troubleshooter helps you solve problems you may encounter if you run out of disk space. To free up disk 
space, just click a method you want to try, and then carry out the suggested steps.

{button ,JI(`',`WIN_DSKTRB_EMPTY_REC_BIN')} Empty the Recycle Bin

{button ,JI(`',`WIN_DSKTRB_SCANDISK')} Use ScanDisk to check for errors that may be using up disk space

{button ,JI(`',`WIN_DSKTRB_BACKUP')} Back up unneeded files and remove them from your hard disk

{button ,JI(`',`WIN_DSKTRB_ADDREMOVE_PROGRAMS')} Remove Windows components that you don't use

{button ,JI(`',`WIN_DSKTRB_DRIVESPACE')}Create more disk space by using DriveSpace disk compression

{button ,AL("PLUSPACK_DISK_TRB",1,`PLUS_PACK_MSG')} See more ways to free up disk space



Empty the Recycle Bin

1 On the desktop, double-click the Recycle Bin.
2 If you do not need the files in the Recycle Bin, click the File menu, and then click Empty Recycle Bin.

Were there files in the Recycle Bin?
            Yes, I want to see how much free disk space I have now.  
            No. I want to free up disk space in other ways.  



Check for errors that may be using up disk space

1 Click here        to start ScanDisk.
2 Click the drive that contains the files and folders you want to check.
3 Click Start.

Did ScanDisk find errors?
            Yes, I want to see how much free disk space I have now.  
            No. I want to free up disk space in other ways.  



Remove Windows components that you don't use

1 Click here        to open the Add/Remove Programs dialog box.
2 In the list, double-click a category, clear the check box for each program or component you want to remove, 

and then click OK. 

Do you want to free up more disk space?
            Yes.  
            No. I want to see how much free disk space I have now.  



Create more disk space by using DriveSpace

1 Click here        to start DriveSpace.
2 In the Drives On This Computer list, click the drive you want to compress.
3 On the Drive menu, click Compress.
4 Click Start.
5 If you have not backed up your files, click Back Up Files, and then follow the instructions on your screen. When 

you are done, proceed to step 6.
6 Click Compress Now.
7  If Windows prompts you to restart your computer, click Yes.

If you want to free up more disk space after your computer restarts, start the Disk Space Troubleshooter again.

Do you want to free up more disk space?
            Yes.  
            No. I want to see how much free disk space I have now.  



Back up and delete unneeded files

1 Click here        to start Backup.
For information about using Backup, click the Help menu in Backup, and then click Help topics.

2 When you are finished backing up unneeded files, double-click the My Computer icon.
3 Locate the file or folder you backed up, and then click it.
4 On the File menu, click Delete. 
5 Repeat steps 3 and 4 until you have deleted all the files or folders you backed up.
6 Double-click the Recycle Bin icon.
7 If there are files in the Recycle Bin, click the File menu, and then click Empty Recycle Bin.

Do you want to free up more disk space?
            Yes.  
            No. I want to see how much free disk space I have now.  



Determine how much free space is on your disk

1 Double-click the My Computer icon.
2 Click the icon for the disk you want to check.
3 On the File menu, click Properties.

Is enough free space available?
            No. I want to free up more disk space.  
            Yes. Close the troubleshooter.  



Windows stores deleted files in the Recycle Bin, which is located on the desktop. You can use the Recycle Bin to 
retrieve files you deleted in error, or empty the Recycle Bin to create more disk space.
If you cannot see the Recycle Bin, use your right mouse button to click a blank area of the taskbar, and then click
Minimize All Windows.



You can use My Computer to easily view and manage the contents of your computer's disk drives. It also enables
you to work with and configure some of the hardware devices that are installed in or attached to your computer.
If you cannot see the My Computer icon, use your right mouse button to click a blank area on the taskbar, and 
then click Minimize All Windows.



Additional ways to free up disk space are available only if Microsoft Plus! for Windows 95 is installed on your 
computer. To obtain Microsoft Plus! for Windows 95, contact your software vendor.



MS-DOS Program Troubleshooter

This troubleshooter helps you identify and solve problems related to using an MS-DOS–based program with 
Windows. Just click to answer the questions, and then try the suggested steps to fix the problem.

What's wrong?
            I get a message that the program does not run under Windows.  
            I can't install the program.  
            The program doesn't run correctly.  
            The program runs poorly or not at all, and I am using DoubleSpace or DriveSpace.  
            The program runs in MS-DOS mode, but I want to run it in an MS-DOS window.  
            I get a message that I don't have enough memory to run the program.  
            I can't print from the program.  
            I want to start MS-DOS first rather than Windows.  



Try running your program in MS-DOS without disk compression

DriveSpace may be using memory needed for your MS-DOS–based program. To increase available memory, try 
not loading DriveSpace and loading only the devices and files needed to run your program.

To start your computer in MS-DOS mode without starting disk compression 
1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help is not available 

when you are starting up or running in MS-DOS mode.
2 Restart your computer. Click the Start button, click Shut Down, and then click Restart The Computer.
3 When you see the message "Starting Windows 95," press F8.
4 Choose Step-by-Step Confirmation.
5 When prompted to load DoubleSpace, press N. This prompt applies either to DoubleSpace or DriveSpace.
6 Write down the lines and settings you accept in this step and step 7, so that you can adjust them later if 

needed.
When prompted to process your startup drivers (Config.sys), press Y, and then press Y to accept the lines 
specifying the drivers and devices that you think you need to run your program; press N to all unnecessary 
drivers.

7 Repeat step 6 for the startup command file (Autoxec.bat).
8 Press N when prompted to load the Windows graphical interface and to start Windows (WIN).
9 Run your MS-DOS–based program.

Notes
The program and any files needed to run it must be on a host (uncompressed) drive. When you choose not 

to load DriveSpace, you cannot load any files from a compressed drive—you will get a message that the file is 
corrupted or cannot be found.

Move the files you need to run your program to an uncompressed drive. For information about increasing the 
amount of free space on an uncompressed drive, look up "adjusting free space on a compressed drive" in the 
DriveSpace Help Index.
See your program's documentation to find out what files are required.

Running the program correctly may require some trial and error in choosing which lines to load from 
Config.sys and Autoexec.bat. When you have found the settings that work, write them down for later use.



Change the Advanced settings so that the program does not detect Windows

1 Using the right mouse button, click the program, and then click Properties.
2 On the Program tab, click Advanced.
3 Click Prevent This Program From Detecting Windows, click OK, and then click OK again.
4 Try running the program again.

If it doesn't work, follow the same procedure to disable the setting, and then proceed through the next stage 
of the troubleshooter below.

Warning
Make sure you save all your work before attempting to run the program with this setting.

Did this fix the problem?
            Yes. My program runs correctly now. Close the troubleshooter.  
            No. What else could be wrong?  



Check the following, and then try installing again
Make sure you have enough disk space to install the program.
Make sure the setup program is on the disk you are trying to install from. 
If the setup program is named something other than Setup or Install, click here    

    to open an MS-DOS window, and then try installing it from there.
Check the program's documentation for special setup requirements.

Did this fix the problem?
            Yes. The program installed successfully. Close the troubleshooter.  
            No. What else could be wrong?  



What's wrong?
            My screen output is garbled.  
            I get an "Insufficient file handles" message.  
            I get a different message, or no message at all.  



Check the settings for the program

1 Click the icon for the program, click the File menu, and then click Properties.
2 Make sure you have chosen the correct settings as specified in the program's documentation or by the 

program's vendor.
3 Click the Screen tab, and then click Full-Screen. (Some MS-DOS–based programs do not run in a window.)
4 Try running the program again.

Did this fix the problem?
            Yes. My program runs correctly now. Close the troubleshooter.  
            No. What else could be wrong?  



Modify the FILES command in your Config.sys file

1 Click the Start menu, point to Programs, point to Accessories, and then click WordPad.
2 Open your Config.sys file, usually located in the root of your startup drive (usually C).
3 Find the line FILES=xxxx. Change the number to a larger number. If you are running MS-DOS–based programs 

in Windows, make sure the number is at least 30.
4 Restart your computer.
5 Try running the program again.

Did this fix the problem?
            Yes. My program runs correctly now. Close the troubleshooter.  
            No. What else could be wrong?  



Try running the program in MS-DOS mode

1 Print this topic for reference by clicking Options and then clicking Print Topic. Windows Help will not be 
available when you are running in MS-DOS mode.

2 Click the Program tab, and then click Advanced. 
3 Click MS-DOS Mode, and then click OK.
4 Find the program's icon, and then double-click it.

If this doesn't work, contact the vendor of the MS-DOS–based program.
If this works, but you don't want to run the program in MS-DOS mode, return to the MS-DOS Programs 
Troubleshooter to follow steps to make the program run correctly in an MS-DOS window.



Try running the program from an MS-DOS window

1 Click here     to start an MS-DOS window.
2 Type the name of the program, including the path, and then press ENTER.

Did this fix the problem?
            Yes. The program runs correctly in an MS-DOS window.  
            No. What else could be wrong?  



Change the program's settings to match the settings of an MS-DOS window

1 In an MS-DOS window, click the MS-DOS icon, and then click Properties.
2 Write down the current settings on a piece of paper.
3 Find your program, and then click its icon.
4 On the File menu, click Properties.
5 Change the settings to match the ones you wrote down, and then start the program again.

Did this fix the problem?
            Yes. My program runs correctly now. Close the troubleshooter.  
            No. What else could be wrong?  



Contact the vendor

You have a problem that cannot be resolved by using the MS-DOS Program Troubleshooter. Contact the vendor of
the MS-DOS–based program.



Run this program in MS-DOS mode only

This program runs poorly, or not at all, in an MS-DOS window. Run this program in MS-DOS mode.



Record what the message says
Write down what the error message says, including how much memory is needed, in K (kilobytes) or MB 

(megabytes), and what kind is needed (conventional, expanded, extended, or DPMI). Some error messages may not
specify any of these.

Note that all of the memory settings for the MS-DOS properties, except Initial Environment, are in kilobytes. To 
convert megabytes to kilobytes, multiply by 1024. For example, 4 megabytes equals 4096 kilobytes.

How did the message appear?
            It appeared in an MS-DOS    window.  
            It appeared in a Windows dialog box with an OK button.  



MS-DOS Program Memory Troubleshooter

You may need to adjust more than one type of memory in order for your program to run. 
First try adjusting the settings for the type of memory specified in the error message. If you still have trouble, try
adjusting one of the other memory settings below.

What kind of memory does your program need?
            More conventional memory.  
            More expanded memory.  
            More extended memory.  
            The message only specified how much memory is needed, but not what kind.  
            The message did not specify what kind of memory, or how much, is needed.  
            I have tried all of these, and the program still does not have enough memory. What else can I do?  



Check the program's conventional-memory settings

1 Using the right mouse button, click the program's icon, and then click Properties.
2 Click the Memory tab, and check the settings for conventional memory.

What is the conventional memory set to?
            It is set to Auto.  
            It is set to a number value.  



Try setting the conventional memory to Auto

1 Change the conventional-memory setting to Auto.
2 Try running the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing other memory settings.  
            No. I have changed other memory settings, and the program still doesn't work. What else could be wrong?  



Check the program's expanded-memory settings

1 Using the right mouse button, click the program's icon, and then click Properties.
2 Click the Memory tab, and check the settings for expanded memory.

What is the expanded memory set to?
            Auto or a number value, and the original error message told me how much memory the program needs.  
            Auto, but the message did not tell me how much memory the program needs.  
            A number value, but the message did not tell me how much memory the program needs.  
            There is no field for total expanded memory. The computer is not configured for expanded memory in MS-  

DOS sessions.



Try to configure your computer for expanded memory

1 Click Details, and follow the instructions on the screen.
2 Try running the program again.

If you still do not have enough memory to run the program, run the MS-DOS Program Troubleshooter again.

Note
You may need to restart your computer after reconfiguring it for expanded memory.



Set the expanded memory to the amount in the error message 

1 Change the expanded-memory setting to the value specified in the message. Click OK, and then click OK 
again.

2 Try running the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing other memory settings.  
            No. I have changed other memory settings, and the program still doesn't work. What else could be wrong?  



Change the expanded-memory setting

1 Change the expanded-memory setting to 8192. Click OK, and then click OK again.
2 Try running the program again.

If you still do not have enough memory, increase the value, and run the program again. Repeat this a few 
times and see if it works.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. It still doesn't work. What else could be wrong?  



Change the expanded-memory setting to Auto
Change the expanded-memory setting to Auto. Click OK, and then click OK again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing other memory settings.  
            No. I have changed other memory settings, and it still doesn't work. What else could be wrong?  



Check the program's extended-memory settings

1 Using the right mouse button, click the program's icon, and then click Properties.
2 Click the Memory tab, and then check the settings for extended memory.

What is the extended memory set to?
            Auto or a number value, and the original error message told me how much memory the program needs.  
            Auto, but the message did not tell me how much memory the program needs.  
            A number value, but the message did not tell me how much memory the program needs.  



Set the extended memory to the amount in the error message

1 Change the extended-memory setting to the value specified in the error message, and then click OK.
2 Try running the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing other memory settings.  
            No. I have changed other memory settings, and the program still doesn't work. What else could be wrong?  



Change the extended-memory setting

1 Change the extended-memory setting to 8192, and then click OK.
2 Try running the program again.

If you still do not have enough memory, increase the value, and run the program again. Repeat this a few 
times and see if it works.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. The program still doesn't work. I want to try changing other memory settings.  
            No. I have changed other memory settings, and it still doesn't work. What else could be wrong?  



Change the setting to Auto

1 Change the extended-memory setting to Auto, and then click OK.
2 Try running the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing other memory settings.  
            No. I have changed other memory settings, and it still doesn't work. What else could be wrong?  



Change the DPMI memory setting to the amount in the error message

1 Using the right mouse button, click the program's icon, and then click Properties.
2 Click the Memory tab.
3 Set the total value for MS-DOS protected-mode (DPMI) memory to the value specified in the error message, 

and then click OK.
4 Try running the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. I want to try changing the extended-memory setting.  



Try setting the memory to Auto

1 Using the right mouse button, click the program's icon, and then click Properties.
2 Click the Memory tab.
3 Change the conventional-memory setting to Auto, and then click OK.
4 Try running the program again.

If you still do not have enough memory, try changing the value to Auto for each of the other memory settings, 
and then run the program again.

Did this fix the problem?
            Yes. Close the troubleshooter.  
            No. There is no field for total expanded memory. The computer is not configured for expanded memory in   

MS-DOS sessions.
            No. I have changed other memory settings, and it still doesn't work. What else could be wrong?  



Shows the icon for the file or files you are looking at.



Displays the name of the file or folder.



Shows how many files and folders were selected when you chose to look at the properties.



Displays the type of file or folder you are looking at.
If the type is Shortcut, you are looking at the properties for the shortcut to an item, not for the original item.



Displays the size of the file or folder.



Displays how many files and folders are contained in this folder.



Shows where the file or folder is located on your computer.



Displays the filename in MS-DOS format.
MS-DOS filenames can have up to eight characters with a three-character extension. An MS-DOS filename can 
contain only the letters A through Z, the numbers 0 through 9, and the following special characters: underscore 
(_), caret (^), dollar sign ($), tilde (~), hyphen (-), braces ({ }), at sign (@), quotation mark ("), apostrophe ('), 
and parentheses ( ). No other special characters are acceptable. Some programs use the MS-DOS format for 
opening and closing your documents.



Displays the date that the file or folder was created.



Indicates the date that the information in this file or folder was last changed.



Indicates the date that this file or folder was last opened.



Shows whether this file or folder is read-only, which means it cannot be changed or accidentally deleted. Click 
this box to turn the attribute on or off.
If multiple files are selected, a check mark means that all the files are read-only. A filled box means that some 
files are read-only and some aren't.



Shows whether this file should be archived. Some programs use this option to control which files are backed up. 
Click this box to turn the Archive attribute on or off.
If multiple files are selected, a check mark means that all the files have the Archive attribute set. A filled box 
means that some files have the attribute set and some don't.



Shows whether the file or folder is hidden, which means that you cannot see or use it unless you know its name. 
Click this box to turn the Hidden attribute on or off.
If multiple files are selected, a check mark means that all the files are hidden. A filled box means that some files 
are hidden and some aren't.



Shows whether the file is a system file. System files are required by Windows in order to run properly, and by 
default are not shown in folder listings. Do not delete system files.
If multiple files are selected, a check mark means that all the files are system files. A filled box means that some 
files are system files and some aren't. A folder cannot have the System attribute set.



Specifies the MS-DOS path, which is the route to the location of this file or folder. The MS-DOS path includes the 
drive name, the names of the folders containing this file or folder, and the MS-DOS name for this file or folder.



Displays version and copyright information about the program. Click a category on the left to display the 
information on the right.



Displays version and copyright information about the file. For more specific information, click the categories 
listed below.



Displays the icon for the shortcut you are looking at. To change it, click Change Icon.



Displays the name of the shortcut. The name of the shortcut does not have to match the name of the original 
item that it points to.



Displays the location of the original item that the shortcut points to.



Displays the name of the item that the shortcut points to. There are many types of items that a shortcut can 
point to, such as a file, folder, part of document, printer, or a computer on the network.



Displays the type of item that the shortcut points to.



Displays the size of the item that the shortcut points to.



Specifies the folder that contains the original item or some related files. Sometimes, programs need to use files 
from other locations. You may need to specify the folder where these files are located so that the program can 
find them.



Provides a space for you to define a keyboard shortcut to start or switch to this program from Windows. Shortcut 
keys must include CTRL and/or ALT and another key; for example, CTRL+Y. You cannot use ESC, ENTER, TAB, SPACEBAR, 
PRINT SCREEN, or BACKSPACE. 
No other program can use this key combination. If the shortcut key conflicts with an access key in a Windows 
program, the access key will not work.



Specifies how you want the window to display the item when you open the shortcut: in a standard window, in a 
full screen (maximized), or as a button on the taskbar (minimized).



Click this to change the icon for the shortcut.
This does not change the icon for the original item.



Opens the folder that contains the original item that the shortcut points to.



Specifies the name of the file that contains the icon for the shortcut. Some files contain more than one icon, and 
you can select a different icon from the Current Icon list.
To use an icon in a different file, type the filename here, or click Browse to find and select the file.



Shows which icon you are currently using. If other icons are available, they appear in the list. To change to 
another icon, click a different one in the list or specify a new file in the File Name box.



Opens a new window every time you open a folder in My Computer. The previous folder will still be displayed in a
window, so you can switch between them.
The example shows how the windows will open.



Displays the contents of each folder you open in the same window. To switch back to the previous folder, click
    on the toolbar, or press the BACKSPACE key. 

The example shows how one window stays open and displays the contents of each folder you open.



Specifies that all files, including hidden and system files, should be displayed in a folder. For example, click this 
option if you want to work with files such as dynamic link libraries (DLLs).



Specifies that certain files should not be displayed in a folder. The types of files that will not be displayed, 
including system files and dynamic link libraries (DLLs), are listed in the box.
Click this option to display only the files you need to work on, or to protect your system files from accidentally 
being changed or deleted.



Displays the path of the folder in the title bar of the window. Click this option if you understand MS-DOS paths, 
and you want a quick way to tell which folder you are in.



Hides the filename extensions for certain files. Click this option to reduce clutter in your folder windows.



Displays descriptions or labels above the two sides of the Windows Explorer window. Turn this option off if you 
want more room to display your files and folders.



Displays the icon for the type of disk you are looking at.



Displays the name of the disk. To change the name, type a new one in the box.



Describes the type of disk you are looking at. A local drive is a hard disk installed in your computer, a network 
connection is a disk on someone else's computer, and a floppy disk drive is a drive in which you can insert a 
floppy disk.
A CD-ROM drive is a drive that can play a compact disc. A RAM drive is a drive that has been set up to use your 
computer's memory as storage for files and folders. A removable drive is a portable drive that you can 
disconnect from your computer and attach to another computer.



Shows exactly how much space on your disk is used and how much is free, in both bytes and megabytes.



Displays the total capacity of the disk in both bytes and megabytes.



Shows how much space on the disk is used (in blue) and how much is free (in pink).



Displays the drive letter associated with this disk. The drive letter is used by some programs when you open files
on a particular disk.



Provides a place for you to type a description for the filename extension. This description appears when you look
at folders in Details view.



Lists the programs that Windows has registered. Click the one you want to use to open the file. If the program 
you want is not on this list, click Other.
If you want to use this program each time you open this file, make sure the check box is checked.



Click this to choose another program. You'll be able to browse through the folders on your computer.



Specifies that the next time you open this file, or any other file having the same filename extension, you want 
Windows to use the program you specified here.



Specifies when this drive was last checked for damage. It's a good idea to periodically check your disk for 
damage. To check your disk for damage, click Check Now.



Specifies when files on this disk were last backed up. To back up files now, click Backup Now.



Specifies when this disk was last defragmented. It's a good idea to defragment your disk occasionally. 
Defragmenting a disk organizes the space on the disk more efficiently, and improves its performance.
To defragment this disk, click Defragment Now.



Shows the folder in which the file used to be located.



Shows the date when the file was deleted.



Shows whether the file was marked as Read-Only. You cannot change the attributes of a deleted file.



Shows whether the file was marked as Hidden. You cannot change the attributes of a deleted file.



Shows whether the file was modified since it was last backed up.



Shows whether the file was marked as a System file. You cannot change the attributes of a deleted file.



Displays the file types that are currently registered with Windows. When a file type is registered, information 
such as what program should be used to open files of that type is stored in Windows.
When you click one of the types in the list, the Details area shows a summary of what filename extension the 
type has and what program is used to open it.
To modify or delete one of the currently registered types, click the type, and then click Edit or Remove.



Click this to register a new file type with Windows.



Click this to remove the selected file type from the list.



Click this to modify the settings of the selected file type. To see the current settings, click a file type, and then 
look at the Details area at the bottom of the dialog box.



Shows the extension and program of the selected file type. To change these settings, click Edit.



Shows the icon that is associated with the file type.



Click this to change which icon is associated with this file type.



Specifies the description of the file type. This description appears in folder windows when you display files in 
Details view.



Specifies the three-letter filename extension for this file type. All files having this extension will get the icon and 
commands that are defined for this file type.



Lists the commands that have been defined for this file type. These commands will appear on the shortcut menu
for the item. To add a new command, click New. To change an existing command, click the command, and then 
click Edit.
You can define as many commands as you want, and you can give them any name you want. For example, you 
could create a file type that has two commands, one called "Open with Notepad" for opening the file with 
Notepad, and one called "Open with WordPad" for opening the file with WordPad. Both of these commands would
appear on the File menu and on the shortcut menu for the item.



Returns all commands for this file type to the default commands. The default commands were set up by the 
program or by Windows.



Click this to add a new command for the file type.



Click this to change the selected command.



Click this to remove the selected command.



Specifies whether the file type supports Quick View.



Specifies that the extension for this file type should be visible in a folder window.



Specifies the name of the command that will appear on the shortcut menu for the item. Common commands are 
Open and Print. You can specify any name you want for the command.
To specify which character is used as the accelerator key, precede the character with an ampersand (&). For 
example, the following command would appear with the letter N underlined: "Open with &Notepad".
The Application Used To Perform Action box specifies what should happen when this command is chosen.



Specifies what should happen or which program should be used when the command specified in the Action box is
chosen. Be sure to include the path to the command and any required parameters.
For example, if you created a command called "Open with Notepad" in the Action box, you would specify 
"Notepad.exe".
If the program supports DDE (dynamic data exchange), specify the program filename here, and click Use DDE, 
and then specify the DDE commands required to perform the action you want.



Click this to browse for a program.



Click this if the program or file type uses DDE (dynamic data exchange).



Specifies the DDE command for the specified action. Use the %1 replaceable parameter to represent a filename. 
The %1 is replaced with the selected file when the command is carried out.
For example, if the specified action is Open, the DDE command for opening a file is [open("%1")].
This option will work only with programs that support DDE.



Specifies the DDE application string to use to initiate a DDE conversation with the program.
If you leave this area blank, the command specified in the Application Used To Perform Action box will be used.



Specifies the DDE command to use if the program is not already running. Use the %1 replaceable parameter to 
represent a filename. The %1 is replaced with the selected file when the command is carried out.
For example, if you want to specify the action for printing when the program is not running, you would type: 
[open("%1")][print()][quit()].
If this area is blank, the value in the DDE Message area is used.



Specifies the DDE topic string to use to initiate a DDE conversation with the program. If you do not complete this
area, "System" is used.



Displays any available copyright information for this file.



Shows how long the file takes to play.



Describes the specific audio format used in the file.



Displays the MIDI sequence name.



Describes the specific video format used in the file.



Displays information about this file.



Plays the media file. Click the Play button to play this file.



Displays information about this file. This information was specified in the program used to create this file. If no 
information was specified when the file was saved, you'll see a message saying that no information is available.
You cannot modify the information here.



Displays information about this file. This information is tracked by Windows and your program. You cannot modify
the information here.



Lists the available disk drives. Click the one you want to copy files from.



Lists the available disk drives. Click the one you want to copy files to. 
The disks must be the same type. 
You can specify the same drive as for the disk you copy from.
Any existing information on the disk will be deleted and replaced with the information you are copying.



Click this to start copying.



To see what's on your computer

1 Double-click the My Computer icon.
2 Double-click the icon for the drive you want to look at.

Windows displays the files and folders on the drive. Folders can contain files, programs, and even other 
folders.

3 To open a file or folder, or start a program, double-click it.

Tips
To switch back to the previous folder, click 

 on the toolbar or press the BACKSPACE key. If the toolbar is not visible, click the View menu, and then click Toolbar.
To see the hierarchy of all folders on your computer, you can use Windows Explorer. Click the Start menu, 

point to Programs, and then click Windows Explorer.

{button ,AL("a-hierarchy")} Related Topics



To see the hierarchy of folders on a disk drive

1 Click the Start button.
2 Point to Programs, and then click Windows Explorer.
3 Click a folder on the left side of the window to display its contents on the right.

Click the plus signs (+) to display more folders.

Tips
To change the size of either side of the window, drag the bar that separates the two sides.
To quickly open a folder and display its subfolders, double-click the folder on the left side of the window.



To open a file or folder

1 Double-click the My Computer icon.
2 Double-click the drive that contains the file.
3 To open a file or folder, double-click it.

Tips
To change the way files are displayed, try the commands on the View menu.
If the file is on someone else's computer, double-click the Network Neighborhood icon instead of My 

Computer.
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To move a file or folder

1 In My Computer or Windows Explorer, click the file or folder you want to move.
2 On the Edit menu, click Cut.
3 Open the folder where you want to put the file or folder.
4 On the Edit menu, click Paste.

Tip
To select more than one file or folder to move, hold down the CTRL key, and then click the items you want.

{button ,AL("a-openfolder;a-link;A_COPY_FILES;a-dragdrop")} Related Topics



To delete a file or folder

1 In My Computer or Windows Explorer, locate the file or folder you want to delete.
2 Click the file or folder.
3 On the File menu, click Delete.

Tips
If you want to retrieve a file you have deleted, look in the Recycle Bin. Your deleted file remains in the 

Recycle Bin until you empty it.
You can also drag file or folder icons onto the Recycle Bin icon. If you press SHIFT while dragging, the item 

will be deleted from your computer without being stored in the Recycle Bin.

{button ,AL("a-openfolder;a-dragdrop;WIN_WASTE_FREEING_SPACE;WINDOWS_WASTE_RETRIEVE_FILES")} 
Related Topics



To create a new folder

1 In My Computer or Windows Explorer, open the folder in which you want to create a new folder.
2 On the File menu, point to New, and then click Folder. The new folder appears with a temporary name.
3 Type a name for the new folder, and then press ENTER.

{button ,AL("a-openfolder")} Related Topics



To change the name of a file or folder

1 In My Computer or Windows Explorer, click the file or folder you want to rename. You do not need to open it.
2 On the File menu, click Rename.
3 Type the new name, and then press ENTER.

Tip
A filename can contain up to 255 characters, including spaces. But, it cannot contain any of the following 

characters: \ / : * ? " < > |

{button ,AL("a-openfolder")} Related Topics



To copy a file or folder

1 In My Computer or Windows Explorer, click the file or folder you want to copy.
2 On the Edit menu, click Copy.
3 Open the folder or disk where you want to put the copy.
4 On the Edit menu, click Paste.

Tip
To select more than one file or folder to copy, hold down the CTRL key, and then click the items you want.

{button ,AL("a-openfolder;a-link;a-dragdrop;WIN_COPY_FILE_TO_FLOPPY")} Related Topics



To copy a file to a floppy disk

1 Insert the disk in the floppy disk drive.
2 In My Computer or Windows Explorer, click the file you want to copy.
3 On the File menu, point to Send To, and then click the drive you want to copy the file to.

{button ,AL("a-openfolder;a-link;a-dragdrop")} Related Topics



To select multiple files and folders
In the folder window, hold down the CTRL key, and then click each item you want to select.

To select all the files and folders in the window, click the Edit menu, and then click Select All.
To select a group of files that are next to each other, hold down the mouse button and drag a rectangle around
the files you want to select.



To put a shortcut on the desktop

1 Click the item, such as a file, program, folder, printer, or computer, that you want to create a shortcut to.
2 On the File menu, click Create Shortcut.
3 Drag the shortcut icon onto the desktop.

Tips
You can use the shortcut as a fast way to open the item.
To change any settings for the shortcut, such as what kind of window it starts in or what key combination is

used to access it, use your right mouse button to click the shortcut, and then click Properties.
To delete a shortcut, drag it to the Recycle Bin. The original item will still exist on the disk where it is 

stored.

{button ,AL("a-openfolder;a-dragdrop")} Related Topics



To create a shortcut in a folder

1 In My Computer or Windows Explorer, open the folder you want to create the shortcut in.
2 On the File menu, point to New, and then click Shortcut.
3 Follow the instructions on the screen.

{button ,AL("a-link;a-dragdrop")} Related Topics



To change file or folder properties

1 In My Computer or Windows Explorer, click the file or folder whose properties you want to change.
2 On the File menu, click Properties.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.

{button ,AL("a-openfolder")} Related Topics



To change the appearance of items in a folder
In My Computer or Windows Explorer, click the View menu, and then click one of the following commands: 

Large Icons, Small Icons, List, or Details. Experiment to find the view you prefer.
You can also sort the items by name, size, date, and type, depending on the view. Experiment with the Arrange
Icons command on the View menu.

Tip
To see a description of what each menu command does, rest your pointer over it; information about the 

command appears in the status bar at the bottom of the window. If the status bar is not displayed, click the View 
menu, and then click the Status Bar command.



To see all files and filename extensions

1 In My Computer or Windows Explorer, open the folder you want to look at.
2 On the View menu, click Options.
3 Click the View tab, and then click Show All Files.

If you want to see all filename extensions, make sure the Hide MS-DOS File Extensions box is not checked.



To name a disk

1 Double-click the My Computer icon.
2 Click the disk you want to name, click the File menu, and then click Properties.
3 In the Label box, type a name for the disk. To change an existing label, select it, and then type a new name.

The label can contain up to 11 characters.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To determine how much space is available on a disk

1 Double-click the My Computer icon, and then click the disk you want to check.
2 On the File menu, click Properties.

A pie chart shows how much free and used space is on the disk.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To format a disk
1 If the disk you want to format is a floppy disk, insert it into its drive. Otherwise, go to step 2.
2 Double-click the My Computer icon, and then click the icon for the disk you want to format.

Be sure not to double-click the disk icon, because you can't format a disk if it is open in My Computer or 
Windows Explorer.

3 On the File menu, click Format.

Notes
Formatting a disk removes all information from the disk.
You cannot format a disk if there are files open on that disk.
If the disk has been compressed, use DriveSpace, or other compression software, to format the disk.
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To make a copy of a floppy disk

1 In My Computer, click the icon for the disk you want to copy.
2 On the File menu, click Copy Disk.
3 Click the drive you want to copy from and the drive you want to copy to, and then click Start.

Notes
You can use the same drive for both disks.
The disks must be the same type.
Any existing information on the disk you copy to will be deleted.



To create or modify a file type

1 Double-click the My Computer icon.
2 On the View menu, click Options, and then click the File Types tab.
3 To create a new file type, click New Type.

To modify the settings for an existing file type, click the type, and then click Edit.
4 Specify a description for the file type and the filename extension associated with this type of file.
5 Click New to define an action for this file type.

If you are modifying an existing type, you can click the command in the Action box that you want to modify, 
and then click Edit.

6 Specify the action that you want to define, such as Open or Print, and the command that should run to 
complete this action.

7 Repeat steps 5 and 6 for as many actions as you want to define for this file type.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
Creating a file type is similar to associating a file in Windows version 3.1, but you can specify actions for 

more than just opening the file; for example, you can specify which program should be used for printing the 
document.



To change which program starts when you open a file

1 In My Computer or Windows Explorer, click the View menu, and then click Options.
2 Click the File Types tab.
3 In the list of file types, click the one you want to change.

The settings for that file type are shown in the File Type Details box.
4 Click Edit.
5 In the Actions box, click Open.
6 Click Edit, and then specify the program you want to use to open files that have this extension.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To display the full MS-DOS path in the title bar

1 In My Computer or Windows Explorer, click the View menu, and then click Options.
2 Click the View tab.
3 Make sure the option for displaying the full MS-DOS path is checked.



To use shortcut menus
Instead of using the standard menus to find the command you need, use the right mouse button to click a 

file or folder.
The menu that appears shows the most frequently used commands for that file or folder.

Tip
You can also use the right mouse button to click an empty space on the taskbar or desktop.



To use drag and drop instead of menus

1 In My Computer or Windows Explorer, find the file or folder you want to work with.
2 Make sure the place you want to drag the file or folder to is visible.
3 Drag the file or folder to the destination.

The result depends on the type of file you selected and the destination. For example, to print a file, drag it to 
the printer icon.

Tips
If you use your right mouse button to drag, a menu will appear with the available options.
If you drag a file to a folder on the same disk, it will be moved. If you drag it to a folder on another disk, it 

will be copied. 
You can hold down a key while dragging for the following:
To move a file, use SHIFT.
To copy a file, use CTRL.
To create a shortcut, use CTRL+SHIFT.

{button ,AL("A_WIN_FCAB_SENDTO;a-link")} Related Topics



To quickly send files to another place

1 Use your right mouse button to click the file you want to send.
2 Point to Send To, and then click the destination.

Tip
You can add other destinations to the Send To command. In the Send To folder, located in your Windows 

folder, create shortcuts to the destinations you send files to often; for example, a printer, fax, or particular folder.

{button ,AL("A_WIN_FCAB_CREATE_NEW_SHORTCUT")} Related Topics



To put part of a document on the desktop

1 In your document, select the text or graphic that you want to copy.
2 Drag it to the desktop.

A scrap is created. You can now drag this scrap to other documents or programs.

Note
You can use this feature only if your program supports drag-and-drop functions for OLE.



A scrap is a file that is created when you drag part of a document to the desktop.



Click Help Topics to return to the list of topics.



Specifies how much data the disk can hold. To select a different capacity, click the down arrow, and then click an 
option in the list.



Removes all files from the disk but doesn't scan the disk for bad sectors. The quick format option will only work on
disks that have previously been formatted. You should choose a quick format only if you are sure that your disk is 
not damaged.



Prepares a disk so that you can store information on it. If the disk has any files on it, formatting will remove the 
files.
If you are formatting a floppy disk, it will be scanned for bad sectors after it is formatted. If you are formatting a 
hard disk, it will not be checked for errors; and if it previously had errors, that information won't be saved. If you 
use this option on a hard disk, run ScanDisk on the disk after you have formatted it.



Copies system files to a disk that is already formatted, without erasing the files already on the disk. 
If you copy system files to a disk that you can use in your startup drive (drive A or C on most computers), you can 
start your computer by using that disk.



Provides a space for you to type a name for the formatted disk so you can easily identify it later.



Specifies that you do not want to name the formatted disk.



Displays information about the disk after formatting is finished. The report shows how much space is available on 
the disk and how much is taken up by system files or bad sectors.



Copies system files to the disk after it is formatted.
If you copy system files to a disk that you can use in your startup drive (drive A or C on most computers), you can 
start your computer by using that disk.



Starts formatting the disk using the options you've specified.



Displays a preview of the file you selected. 
To edit the file, click the File menu, and then click Open File For Editing.



To preview a document

1 In a folder window, click the document you want to preview.
2 On the File menu, click Quick View.

If the Quick View command is not on the File menu, there is no file viewer available for the type of file, or 
Quick View is not installed. To find out how to install it, click Related Topics below.

Tips
To change the way the document appears, click a command on the View menu in Quick View.
To preview a document on the desktop, use your right mouse button to click the document, and then click 

Quick View.
To preview another document, drag its icon into the Quick View window.
To edit the document, click the File menu, and then click Open File For Editing.

{button ,AL("A_ADDPROG_COMPONENT;A_FIND_FILE;a-hierarchy")} Related Topics



To change number, currency, time, and date settings

1 Click here        to display properties for regional settings.
2 In the list, click the region whose date, time, number, and currency format you want to use. 

{button ,AL("WIN_KBD_NEW_LANG_AND_LAYOUT")} Related Topics



To change the way your computer displays numbers

1 Click here        to display properties for regional settings.
2 Make any necessary changes. 

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To change the way currency values appear

1 Click here        to display properties for regional settings.
2 Make any necessary changes. 

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To change the way your computer displays the time

1 Click here        to display properties for regional settings.
2 Make any necessary changes. 

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To change the way your computer displays the date

1 Click here        to display properties for regional settings.
2 Make any necessary changes. 

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



Provides a way for you to choose a regional setting by clicking an area on the map. For a list of currently 
available settings, use the list box. 



Lists the regional settings from which you can choose. Choosing a regional setting automatically changes 
settings on the Number, Currency, Time, and Date tabs to match those of the region. These settings affect the 
way some programs display and sort dates, times, currency, and numbers.



After you click Apply, this area shows how Windows displays the settings in the Time Style, Time Separator , AM 
Symbol, and PM Symbol boxes. 



Specifies that the time is before noon when you use a 12-hour time format. 



Specifies that the time is after noon when you use a 12-hour time format.



Changes the symbol that separates hours, minutes, and seconds.



Changes the way Windows displays the time. Use the letters in the 
following table to change the time style, and then click Apply. The new 
time style appears in the Time Sample box. 
To display Use
Time in 24-hour format Uppercase H or HH for the hour
Time in 12-hour format Lowercase h or hh for the hour
Leading zeros in single-digit 
hours, minutes, or seconds

Uppercase HH, or lowercase hh, mm, 
or ss

No zeros in single-digit 
hours, minutes, or seconds

Uppercase H, or lowercase h, m, or s

A single letter to indicate AM or 
PM

Lowercase t

Two letters to indicate AM or PM Lowercase tt
Text Use single quotation marks (') around 

text

After you click Apply, this area shows how positive numbers appear based on the tab settings.



After you click Apply, this area shows how negative numbers appear based on the tab settings.



Specifies which symbol indicates decimal values.



Specifies how many digits appear to the right of the decimal symbol.



Specifies the symbol that groups the digits in large numbers. 



Specifies how many digits appear between digit-grouping symbols. 



Specifies which symbol shows that a number is negative.



Specifies whether a zero appears before the decimal symbol in decimal values.



Specifies how Windows displays negative numbers.



Specifies which system of measurement your computer uses.



Specifies which character separates the items in a list. 



After you click Apply, this area shows how Windows displays positive currency values based on the tab settings.



After you click Apply, this area shows how Windows displays negative currency values based on the tab settings.



Displays a placeholder that appears in the Position Of Currency Symbol and Negative Number Format boxes. The 
placeholder represents the setting that is specified in the Currency Symbol box.



Specifies which symbol identifies the currency of a particular region.



Specifies where the currency symbol appears in relation to a currency value. A placeholder symbol represents 
the setting that is specified in the Currency Symbol box.



Specifies how Windows displays negative currency values. A placeholder symbol represents the setting that is 
specified in the Currency Symbol box.



Specifies which symbol separates units of currency. 



Specifies how many digits appear after the decimal symbol in a currency value.



Specifies the symbol that groups the digits in large currency values. 



Specifies how many digits appear between digit-grouping symbols. 



After you click Apply, this area shows how Windows will display the date based on the settings in the Short Date 
Style and Date Separator list boxes.



Changes the way Windows displays the short version of the date. Use the 
letters in the following table to change the short date style, and then click 
Apply. The new short date style appears in the Short Date Sample box. 
To display Use
Numbers with no leading zeros for 
single-digit days, years, or months

Lowercase d or y, or uppercase 
M

Numbers with leading zeros for 
single-digit days, years, or months

Lowercase dd or yy, or 
uppercase MM

Three-letter abbreviations for 
the day, year, or month

Lowercase ddd or yyy, or 
uppercase MMM

Text Use single quotation marks (') 
around text

Specifies which character separates the day, month, and year. 



After you click Apply, this area shows how Windows displays the setting in the Long Date Style list box. 



Changes the way Windows displays the long version of the date. Use the 
letters in the following table to change the long date style, and then click 
Apply. The new long date style appears in the Long Date Sample box.
To display Use
Numbers with no leading zeros for 
single-digit days, years, or months

Lowercase d or y, or uppercase 
M

Numbers with leading zeros for 
single-digit days, years, or months

Lowercase dd or yy, or 
uppercase MM

Three-letter abbreviations for 
the day, year, or month

Lowercase ddd or yyy, or 
uppercase MMM

The full name of the day, year, or 
month

Lowercase dddd or yyyy, or 
uppercase MMMM

Text Use single quotation marks (') 
around text

Shows which calendar Windows is using. The options listed in this box are determined by your regional setting. 
Switching calendars changes the names of months and days. It also affects the number of days in weeks and 
months, the number of months in a year, and when months and years begin. 



Click this to quit the selected program without having to restart your computer.
This is useful if one of the programs on your computer has stopped responding. The message "Not responding" 
will appear next to the program on the list. 
Note that any information you have entered using this program since the last time you saved will be lost.



Click this to quit all the programs listed so you can turn off or restart your computer. Any programs listed as "Not 
responding" will be shut down, and any information you've entered in those programs since the last time you 
saved will be lost. You will be prompted to save changes before other programs are shut down.
You can use this option to shut down your computer at any time, but it is especially useful if you need to shut 
down because one or more of your programs is not responding.



The items listed are programs that are running on your computer.
If the message "Not responding" appears next to a program on the list, you need to quit the program. To quit the 
program, click its name on this list, and then click End Task. 
Note that any information you have entered using this program since the last time you saved will be lost. 



Adjusts the amount of time that elapses before a character begins repeating when you hold down a key.



Adjusts the speed at which a character repeats when you hold down a key.



Provides a place for you to test Repeat Delay and Repeat Rate settings.



Shows what type of keyboard you are using. To set up a new keyboard, click Change.



Click this to install the software for a new keyboard. 



Adjusts the speed at which the cursor (or insertion point) blinks. Changing the blink rate can make the cursor 
easier to locate.



Shows the speed at which the cursor (or insertion point) will blink. A cursor that blinks quickly is generally easier 
to locate. To change the cursor blink rate, drag the slider.



Lists the language(s) and keyboard layout(s) that Windows loads into memory every time you start your computer.
If you want to quickly switch between languages and keyboard layouts while using Windows, make sure the 
Enable Indicator On Taskbar box below is checked. This causes a language indicator to appear on the taskbar. You 
can click the indicator to display a menu that lists all installed languages.



Shows which language setting Windows will use by default whenever you start your computer.



Click this to add a language or keyboard layout to the list. When you start your computer, Windows will load the 
listed language(s) and keyboard layout(s) into memory.



Click this to change settings for the selected language and keyboard layout.



Deletes the selected language and keyboard layout from the list. Windows will no longer load that language and 
keyboard layout into memory when you start your computer.



Sets the selected language and keyboard layout as the default. Windows will use this setting every time you start 
your computer.



Specifies which keys (if any) you can use to switch between installed languages and keyboard layouts. Use this 
key combination if you are working in one language and want to switch to another one quickly.



Displays an indicator on the taskbar. You can easily switch between languages by clicking this indicator.



Enables you to switch between installed keyboard languages and layouts. To switch to another language and 
layout, click this indicator, and then click the language and layout you want to switch to.



Enables you to display a graphic keyboard layout when you use your right mouse button to click the language 
indicator on the taskbar. This is especially useful if the keyboard layout you are using differs from your computer's 
physical keyboard layout.



Lists the languages that Windows can load into memory every time you start your computer.



Shows which language you are modifying the keyboard layout for.



Lists the keyboard layouts that you can use with the selected language. Windows will load the language and the 
keyboard layout you choose into memory every time you start your computer.



To change the way your keyboard responds

1 Click here        to display Keyboard properties.
2 If you want to adjust how much time elapses before a held-down key begins repeating, drag the Repeat Delay 

slider.
If you want to adjust how quickly characters repeat when you hold down a key, drag the Repeat Rate slider.

Tip
You can test the repeat delay and repeat rate by clicking the box below the sliders, and then holding down 

a key.



To adjust the rate at which your cursor blinks 

1 Click here        to display Keyboard properties.
2 In the Cursor Blink Rate area, drag the slider.



To add a language or keyboard layout

1 Click here        to display Keyboard properties.
2 Click Add.
3 Select the language you want to add, and then click OK.
4 Make sure Enable Indicator On Taskbar is checked.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
When Enable Indicator On Taskbar is checked, and you have two or more languages installed, an indicator 

representing the default language appears on the taskbar. To quickly switch between languages, click the indicator, 
and then click the language you want to use.

{button ,AL("KEYB_CREATE_MULTILING_DOC;KEYB_INST_MULTI_LANG_SUPPORT")} Related Topics



To change the keyboard layout for an installed language

1 Click here        to display Keyboard properties.
2 In the list, click the language whose keyboard layout you want to change, and then click Properties.
3 Select a different keyboard layout.



To delete a language or keyboard layout

1 Click here        to display Keyboard properties.
2 In the list, click the language and keyboard layout you want to delete, and then click Remove.



To create a multilingual document

1 If you want to create documents in Central European, Cyrillic, Baltic, Greek, or Turkish-based languages, make 
sure multilanguage support is installed.
For information about installing multilanguage support, click Related Topics below.

2 Make sure the languages you want to use are installed.
For information, click Related Topics.

3 Open the program you want to use to create the document.
4 Click the language indicator on the taskbar, and then choose the language you want to use.
5 If you are creating a document in a Central European, Cyrillic, Baltic, Greek, or Turkish-based language, choose

the TrueType font that is compatible with the language you chose in step 4.
6 If you want to type text in another language, repeat steps 4 and 5.

Note
This feature works only for those products that support TrueType fonts.

{button ,AL("WIN_KBD_NEW_LANG_AND_LAYOUT;KEYB_INST_MULTI_LANG_SUPPORT")} Related Topics



To install multilanguage support

1 Click here        to open the Add/Remove Programs dialog box.
2 Click Multilanguage Support, and then click Details.
3 Make sure a check mark appears beside the language or languages you want to use.
4 Click OK, and then click OK again.
5 The changes will take effect after your computer restarts.

Note
You can use Windows to create documents in many different languages. However, to create documents in 

a Central European, Cyrillic, Baltic, Greek, or Turkish-based language, you must install multilanguage support.



By choosing a language, you specify what language you want to type in. Some programs that are designed for 
Windows 95 recognize this setting. When you add a new language, a keyboard layout for that language is also 
added.



Keyboard layouts vary to accommodate the special characters and symbols used in different languages. This 
affects which characters appear when you press the keys on your keyboard. After you change your keyboard 
layout, the characters that appear on your screen may no longer correspond to the characters that are printed 
on your keyboard's keys.



Memory Troubleshooter

This troubleshooter helps you identify and solve problems If you get an error message saying your computer 
doesn't have enough memory to run a program. Just click to answer the questions, and then try the suggested 
steps to fix the problem.

Have you tried restarting your computer?
            No, I have not.  
            No. I want to try other steps first.  
            Yes. I've restarted the computer and I'm still having trouble.  



Quit any programs you don't need
Close any documents you aren't working on, and then quit any programs you are not using. Then try to 

start the program again.

Did this help?
            Yes. I can run the program now. Close the troubleshooter.  
            No. I am still having trouble.  



Delete some files you no longer need

If you have files on your hard disk that you no longer need, they could be taking up space that Windows could 
use for memory management. 
The Disk Space Troubleshooter helps you free up disk space.
            Start the Disk Space Troubleshooter.  
            I want to try restarting my computer first.  



Restart your computer
Click the Start button, and then click Shut Down. Then click Restart The Computer. 

You may need to close some programs before you shut down.
If this problem does not go away after you have restarted the computer, start the Memory Troubleshooter 
again.

            Close the troubleshooter.  



Check the StartUp group for programs you don't need

1 For reference, you might want to print this procedure by clicking Options and then clicking Print Topic.
2 Click the Start button, point to Programs, and then point to StartUp.
3 Check the StartUp group for unnecessary programs that start automatically when Windows 95 starts.
4 Remove any unnecessary programs, and then restart your computer.

You may need to close some programs before you shut down.
If this problem does not go away after you have restarted the computer, start the Memory Troubleshooter 
again.

Did this solve the problem?
            Yes. I can run the program now. Close the troubleshooter.   
            No. I am still having trouble.   
            How do I remove a program from the StartUp group?  



Reserve hard-disk space as extra memory

1 For reference, you might want to print this procedure by clicking Options and then clicking Print Topic.
2 Click here        to display System properties.

3 Make sure Let Windows Manage My Virtual Memory Settings is checked, and then click OK.
4 Try to start the program again.

Tip
The size of the space reserved for memory changes depending on available disk space.

Did this help?
            Yes! I can run the program now. Close the troubleshooter.  
            No. The box is checked and I am still having trouble.  



Next step

You've run into a problem that the Memory Troubleshooter can't help you solve. 
If you have files on your hard disk that you no longer need, they could be taking up space that Windows could 
use for memory management. Try running the Disk Space Troubleshooter, if you haven't already done so.
For more information, try looking in the documentation for your computer. 
            Go back to the beginning of the troubleshooter.  
            Start the Disk Space Troubleshooter.  
            Close the troubleshooter.  



Lists schemes that you can use to simultaneously change the sounds assigned to many system events. Each 
scheme consists of a set of events and the sounds associated with them.



Click this to save your current event settings. The name you specify will appear in the Schemes list, so you can 
easily restore these settings later.



Deletes the selected scheme.



Lists the events to which you can assign sounds. To assign a sound, click an event, and then click a sound in the 
Name list.



Lists the available sounds that you can associate with program events. To play a sound, click its name, and then 
click the  button. If a sound you want to use does not appear in the list, click Browse. 



Click this to search for sounds on other drives or in other folders. 



Enables you to play sound files. To play a file, click it, and then click the  button. To stop playing a file, click 
the 

 button.



Displays information about the selected sound. If this button is unavailable, there is no additional information.



Plays the selected sound.



Stops playing the selected sound.



Provides a place for you to type a name for the event scheme. This name will appear in the Schemes list, so you 
can easily restore these settings later.



Adjusts the volume of all sounds played through your computer's audio hardware. This setting is unavailable if 
you must physically change the volume on your audio hardware and cannot change it using software.



Displays an indicator on the taskbar that you can use to quickly change your audio hardware's playback volume. 
This setting is unavailable if you must physically change the volume on your audio hardware and cannot change 
it using software.



Lists the audio hardware available on your computer. 



Adjusts the volume of the sounds you record using your computer's audio hardware. The recording volume 
affects how loud sounds are when you play them back. This setting is unavailable if you must physically change 
the volume on your audio hardware and cannot change it using software.



Lists the audio hardware available on your computer. 



Lists the sound qualities that you can choose from. Note that higher quality sound files are larger than lower 
quality sound files. To change settings for the selected sound quality or create custom recording formats, click 
Customize.



Click this to change settings for the selected sound quality or to create custom recording formats.



Limits your programs to using only the selected sound cards. If you use programs that require a specific type of 
sound card, and that sound card is selected in the Preferred Device lists above, check this box. If your programs 
can use any sound card on your computer, clear this box. 



Lists audio formats that you can use. Each name refers to a format and a set of attributes. You can add your own 
names to the list by changing the values in the Format and Attributes areas, and then clicking Save As.



Click this to save your current format and attribute settings under a new name. The name you specify will appear
in the Name list, so you can easily restore these settings later.



Provides a place for you to type a name for the specified settings. The name you type will appear in the Name 
list, so you can easily restore these settings later.



Removes the selected name from the Name list.



Lists the audio formats that your computer supports.



Lists the available attributes for the selected format. These attributes typically include the sampling frequency, 
number of channels, and other settings.



Shows the instrument on which Windows plays MIDI output. This instrument is generally used by games.



Lists the instruments that are installed on your computer. To select a different instrument, click it. 



Enables you to select a MIDI scheme, modify an existing scheme, or create a new one. If you have several MIDI 
instruments, you can assign those instruments to different channels by clicking Configure.



Lists schemes that you can use to simultaneously change some or all of your channel assignments. To create a 
new scheme or modify an existing one, click it, and then click Configure.



Click this to assign channels to MIDI instruments. If you have more than one MIDI instrument, you can specify 
which channel each instrument uses.



Click this to set up a new MIDI instrument. 



Lists the MIDI scheme(s) for which you can change settings. To modify a scheme, click it, and then click a 
channel. Click Change, and then select a new instrument. To save changed settings under a different name, click 
Save As.



Click this to save your current settings under a different name. The name you specify will appear in the Scheme 
list, so you can easily restore these settings later.



Click this to delete the currently selected scheme.



Lists the instruments associated with a channel. To add or configure instruments, click a channel, and then click 
Change.



Click this to assign a different instrument to the selected channel.



Provides a place for you to type a name for your current configuration settings. The name you type will appear in
the Scheme list box, so you can easily restore these settings later. 



Shows which channel you are assigning a new instrument to.



Lists the instruments installed on your computer. Select the instrument you want to assign to the selected 
channel.



Shows how large a video clip will be on your screen. The size of the window in this illustration corresponds to the 
setting that is currently selected in the Show Video In area.



Enlarges a video clip and gives it exclusive access to your screen. Note that video clips run optimally at their 
original size. Video clips that you run full screen may not run optimally, but they will run better than in a 
maximized window or in a window that is a fraction of the screen size.



Lists the window sizes from which you can choose. Note that video clips are designed to run optimally at their 
original size. If you change the size, your video clips may not play smoothly and may appear to be grainy.



Lists the CD-ROM drives on your computer. If you have more than one CD-ROM drive, you can set the volume for 
each of them individually. Media Player, CD Player, and other programs will use the selected drive as the default.



Changes the volume for the headphones that are attached to your CD player. 



Lists joysticks. If you have more than one joystick, click the one you want to configure, and then change its 
settings in the Joystick Configuration area.



Lists the types of joysticks you can choose. Make sure the type of joystick you have is selected. If your joystick is 
not listed, click Custom. To calibrate your joystick, click Calibrate. 



Click this to test your joystick's calibration. If you have not yet calibrated your joystick, click Calibrate.



Click this to calibrate your joystick. This sets the range of motion for your joystick. If your joystick has a throttle, 
point-of-view (POV)    hat, or rudder controls, you can also calibrate these features.



Enables you to use rudder controls. If this check box is unavailable, you either do not have a rudder control or 
you specified a four-axes joystick in the Custom Joystick dialog box.



Resets your joystick to the default value range. Some games reset your joystick's value range, causing it to 
function incorrectly with other games.



Enables you to test your joystick's point-of-view (POV) hat, if it has one. To test the POV hat, move it up, left, 
right, and down. If it doesn't respond correctly, recalibrate it.



Enables you to test your joystick's rudder controls if it has them. To test the rudder controls, move them from 
side to side. If they don't respond correctly, recalibrate them.



Enables you to test your joystick's throttle control, if it has one. To test the throttle control, move it back and 
forth. If it doesn't respond correctly, recalibrate it.



Enables you to test your joystick's range of motion. To test your joystick, move its handle around in circles. If it 
doesn't respond correctly, recalibrate it.



Enables you to test your joystick's buttons by pressing them. Button number assignments are determined by 
your joystick's manufacturer.



Specifies how many axes your joystick has. Although there are exceptions, two-axes joysticks typically provide 
up-and-down and side-to-side motion. Three-axes joysticks generally provide a throttle control. Four-axes 
joysticks usually provide a rudder.



Specifies how many buttons your joystick has. If you are unsure about the number of buttons, choose 4. Then 
test to see if the third and fourth buttons work. 



Enables you to choose one of the special features below.



Specifies that your joystick has a point-of-view (POV) hat. A POV hat enables you to specify the position or 
direction from which to view an object on your screen.



Specifies that you have a controller for flight-simulator programs.



Specifies that you have a touch-directional controller that moves in eight directions and usually has two to four 
buttons.



Specifies that your controller has a steering wheel and gas and brake pedals.



Lists categories of multimedia devices. To view all the device drivers in a category, click the plus (+) sign next to 
the category name. To change the settings for a specific device driver, click it, and then click Properties. 



Click this to change settings for the selected device driver. If this button is unavailable, click the plus (+) sign 
beside a category name, and then click a device driver. 



Enables your programs to use this device driver.



Prevents your programs from using this device driver. The driver remains on your disk, but Windows no longer 
loads it into memory when you start your computer.



Prevents your programs from using this device driver. Unless one of your programs specifically requests it, this 
device will not be used.



Removes this device driver from your hard disk. If you choose this option, you will have to use the Add New 
Hardware wizard in Control Panel to reinstall it.



Click this to change settings for this device driver. If this button is unavailable, the driver does not have any 
settings you can change.



Changes the priority of this audio codec. When audio codecs are equally capable of compression, Windows uses 
them in the order of the priority assigned to them.



Displays information about this audio codec. The codec's manufacturer provides this information.



Lists the instruments that are currently installed on your computer. To add a new instrument, click Add New 
Instrument.



Shows the name of the selected instrument.



Shows which MIDI port on your sound card this instrument is plugged into.



Click this if the definition file you want to use doesn't appear in the Instrument Definition list, and you have the 
definition file you want to use on a disk.



Displays the name of the selected instrument's definition file and, if applicable, any individual definition names 
within that file. The definition file contains information about how Windows communicates with the selected 
instrument. If the definition file you want to use doesn't appear in the Instrument Definition list, click Browse.



To assign sounds to program events

1 Click here        to display Sounds properties.
2 In the Events list, click the event you want to assign a sound to.
3 In the Name list, select the sound you want Windows to play whenever the selected event occurs.

If the sound you want to use isn't in the list, click Browse.

Tips
By default, not all sound schemes are installed during Windows Setup. For information about installing 

others, click Related Topics below.
To test a sound, click its name, and then click the 

 button.
You can save your sound settings by clicking Save As and then naming the sound scheme you created. 

That name will appear in the Schemes list, so you can easily restore these settings.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



To adjust the volume for multimedia devices

1 Click here        to display Multimedia properties.
2 In the Playback or Recording area, drag the Volume slider.

Tip
If the Show Volume Control On The Taskbar box is checked and your sound card's volume can be changed 

using software, a speaker icon appears on the taskbar. To change the volume, click the icon, and then drag the 
slider. 

{button ,AL("WIN_MMCPL_SOUND_QUALITY;WIN_MMCPL_CD_VOL")} Related Topics



To change the sound quality for recordings

1 Click here        to display Multimedia properties.
2 In the Preferred Quality area, select the sound quality you want to use. 

Tips
Higher quality sound files take up more disk space than lower quality sound files.
If you want to change settings for the selected sound quality, or you want to create custom recording 

formats and add them to the Preferred Quality list, click Customize.



To set up a MIDI instrument
1 Plug the instrument into one of your sound card's MIDI ports.
2 Click here        to display Multimedia properties.

3 Click Add New Instrument, and then follow the instructions on your screen.
4 When the wizard is finished, click Single Instrument on the MIDI tab, and then click the device you just 
installed.

{button ,AL("WIN_MMCPL_MOVING_MIDI_INST")} Related Topics



To move a MIDI instrument to another sound card

1 Click here        to display Multimedia properties.
2 Click the plus (+) sign beside MIDI Devices And Instruments.
3 Click the plus (+) sign beside the sound card your MIDI instrument is connected to.
4 Click the instrument that you want to move, and then click Properties.
5 Click the Details tab.
6 In the MIDI Port list, choose the name of the sound card that you want to move the instrument to.
7 If you have not already plugged the instrument in to the new sound card, do so now.

Note
If you change this setting while your MIDI instrument is playing, the change may not take effect until it 

stops playing.



To change the size of video clip windows

1 Click here        to display Multimedia properties.
2 In the Show Video In area, click the window size in which you want video clips to appear. 

Tip
To achieve the smoothest playback available, click Window, and then select Original Size.



To adjust the volume for your CD player's headphones

1 Click here        to display Multimedia properties.
2 Drag the slider.

Tip
For information about adjusting the volume for your speakers, consult the documentation that came with 

your CD player.



To switch between CD players

1 Click here        to display Multimedia properties.
2 In the CD-ROM Drive list, choose the CD drive you want to use.

Tip
You can set the volume for each of your CD drives independently.



To calibrate your joystick

1 Click here        to display Joystick properties.
2 If you have more than one joystick, select the one you want to configure in the Current Joystick list.
3 In the Joystick Selection list, select the type of joystick you are using. If your joystick is not listed, click Custom.
4 If your joystick has a rudder, make sure Rudder is checked.
5 Click Calibrate, and then follow the instructions on your screen.

Tip
Click here    

    to start the Add New Hardware wizard if you have not yet installed your joystick.



To reset your joystick if it doesn't work correctly

1 Click here        to display Joystick properties.
2 In the Joystick Troubleshooter area, click Reset.

Note
Your games may reset your joystick's value range, but the value range that one game uses may be 

incompatible with that of another game. Clicking Reset restores the default value range.



To configure multimedia devices

1 Click here        to display Multimedia properties.
2 Click the plus (+) sign beside a device category, and then click the device you want to configure.
3 Click Properties, and then change any settings as needed.

{button ,AL("WINDOWS_MMCPL_SETDEVPRI")} Related Topics



To change the priority of audio compression drivers

1 Click here        to display Multimedia properties.
2 Click the plus (+) sign beside Audio Compression Codecs, and then click the codec whose priority you want to 

change.
3 Click Properties, and then change the priority.

Note
If no plus (+) sign appears beside Audio Compression Codecs, click Related Topics for information about 

how to install them.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



An event is an action performed by you or a program that your computer can notify you about. For example, 
sometimes your computer beeps when you press an incorrect key. If you have a sound card, you can choose to 
play a sound other than a beep when this event occurs. Your computer can also play sounds when other events 
occur, such as when you start or quit Windows.



Enables you to select a modem to install. You will be prompted to provide the manufacturer and model of your 
modem, and the port to which it is connected.



Detects an installed modem.



Enables you to select the port you want to use for your modem.



Shows the name of your new modem. You can type a different name, if you prefer.



Lists the modems you have installed.



Click this to display or change information about the modem you selected.



Click this to install a new modem.



Deletes the selected installed modem.



To set up a modem

1 Click here        to install a new modem.
2 Follow the instructions on your screen.



To start an MS-DOS window

1 Click the Start button, and then point to Programs.
2 Click MS-DOS Prompt.

Tips
To view the toolbar, click the MS-DOS icon in the title bar, and then click Toolbar.
To switch between a full screen and a window, press ALT+ENTER.
To quit MS-DOS, click 

 or type exit at the command prompt.

{button ,AL("A_DOS_WINDOWS_CHANGE;WINDOWS_DOS_COPY;WINDOWS_DOS_PASTE;A_WINDOWS_DOS_GET_H
ELP")} Related Topics



To optimize an MS-DOS program
1 In My Computer, click the icon for the program.
2 On the File menu, click Properties. 

The settings you specify will be used each time you start the program by double-clicking its icon. If you start 
the program from an MS-DOS window, these settings won't be used.

Tips
To specify whether MS-DOS starts in a full screen or in a window, change the Run properties on the 

Program tab. Note that some MS-DOS–based programs cannot run in a window.
The properties dialog box replaces the PIF Editor used in earlier versions of Windows.
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To allocate all system resources to an MS-DOS program
1 In My Computer, click the icon for the program.
2 On the File menu, click Properties.
3 On the Program tab, click Advanced, and then click MS-DOS Mode.

Tips
You can specify the environment you want your program to run in by providing alternative Config.sys and 

Autoexec.bat files. Either type the commands you want in the spaces provided, or create a basic configuration by 
clicking Configuration and selecting the options you want.

For Help on an item, click 
 at the top of the dialog box, and then click the item.



 The MS-DOS icon is at the left end of the title bar. Clicking this icon displays the System menu for the MS-DOS 
window.



To copy text from an MS-DOS window

1 In an MS-DOS window, click the MS-DOS icon, point to Edit, and then click Mark.
2 Click at the beginning of the text you want to copy.
3 Press and hold down the SHIFT key, and then click at the end of the text you want to copy.
4 Click the MS-DOS icon, click Edit, and then click Copy.
5 Position the cursor where you want the text to be inserted, either in an MS-DOS–based or a Windows -based 

program.
6 In an MS-DOS–based program, click the MS-DOS icon, click Edit, and then click Paste. In a Windows-based 

program, click the Edit menu, and then click Paste.

Tips
To select text by dragging the cursor over the selection, open the properties dialog box for the MS-DOS 

window, click the Misc tab, and then click QuickEdit.
You cannot paste text into an MS-DOS window or MS-DOS–based program when it is running in a full 

screen.



To display Help for an MS-DOS command
At the command prompt, type the name of the command you want Help on, followed by /?.

For example, type chdir /? to get Help on the CHDIR command.

Tip
To display Help text one screen at a time, type the command followed by | more. For example, type dir /? 

| more for Help on the DIR command.

{button ,AL("A_WINDOWS_DOS_START_DOS")} Related Topics



Provides a space for you to type the name of this MS-DOS–based program. 



Provides a space for you to type the path and command to start this MS-DOS–based program. If necessary, 
include the drive, folder, filename extension, and any parameters for the command. You can use environment 
variables in this box (%variable%). 
If you type a space followed by a question mark (?) on the command line, you will be prompted for parameters 
each time the program is started.



Provides a space for you to type the name of the folder that this program will load files from, and where it will 
save files. If necessary, include the drive letter. 



Provides a space for you to type the name of a batch file that is run each time you start this program. 



Provides a space for you to define a keyboard shortcut to start or switch to this program from Windows. Shortcut 
keys must include CTRL and/or ALT and another key (for example, CTRL+Y). You cannot use ESC, ENTER, TAB, 
SPACEBAR, PRINT SCREEN, or BACKSPACE. 
No other program can use this key combination. If the shortcut key conflicts with an access key in a Windows-
based program, the access key will not work.



Specifies how the window is displayed when you start this program. You can display it as a normal window, 
reduced to a button on the taskbar, or enlarged to take up the whole screen.
Note that many MS-DOS–based programs cannot be enlarged to take up the whole screen.



Click this to change the icon that represents this program.



Provides a space for you to type the filename for the icon to use for this program.



Displays the icon that will represent this program.



Click this to either set up this program to have exclusive use of your computer (MS-DOS mode) or enable 
Windows-based programs to be run in addition to this program.



Specifies whether this MS-DOS–based program will be able to detect the presence of Windows. Some MS-DOS–
based programs will not run or will lose functionality if they detect Windows. 
If you want to hide Windows from this MS-DOS–based program, make sure this box is checked. If you are not 
sure, or you want to run Windows-based programs from this MS-DOS–based program, clear this check box.



Displays the name of the file that stores the properties for this program.
You can change all the settings in this file by using the properties dialog box. You do not need to edit the .pif file 
directly.



Provides a space for you to enter and view the contents of the Config.sys file that is used when you run this 
program in MS-DOS mode. 
If you leave the Config.sys box blank, the program will use your current Config.sys file, and it will start faster.
You can use environment variables in this box (%variable%). 



Provides a space for you to enter and view the contents of the Autoexec.bat file that is used when you run this 
program in MS-DOS mode. 
If you leave the Autoexec.bat box blank, the program will use your current Autoexec.bat file, and it will start 
faster.
You can use environment variables in this box (%variable%). 



Click this to choose the options that you want enabled each time you start this program in MS-DOS mode.



These three options specify the types of fonts available for this program.



Lists the available type sizes for this program.



Shows how the program window will appear on your screen.



Shows how the fonts in this program will appear.



Specifies that the mouse can be used to select text for cutting and copying. If QuickEdit is not selected, you 
must click Mark on the Edit menu to mark text for cutting and copying.



Click this to enable the mouse to work exclusively with this program. You will not be able to use the mouse as a 
standard Windows pointer. 



Specifies to close or leave open the MS-DOS window after the program is completed or closed. If this box is not 
checked, the MS-DOS window will be left open.



Click this to receive a warning message when you try to close the program window while the program is still 
running.



Click this to enable Windows to use a quicker method of pasting information into this program. Fast pasting 
works with most programs; however, if you try to paste information into your program and it does not paste 
correctly, clear this check box.



Click this to display the MS-DOS toolbar when this program is running in a window. 



Click this to restore the window size and position on the desktop the next time you start this program.



Specifies that the program run in a full screen. This uses the least memory and is mostly used to run graphics.



Specifies that the program run in a window. This mode makes it easier to share information with other Windows-
based programs and is mostly used for text-based MS-DOS programs.



Specifies the initial number of lines on the screen for this program. A program that resets the display to its 
default number of lines on the screen will override this setting.



Specifies whether the display driver should emulate any of the video functions in read-only memory (ROM) 
functions. Make sure this box is checked if you want this program to write to the screen faster. 
Clear this check box if your program is using nonstandard functions in ROM, or if you experience problems with 
the program writing text to the screen. 



Specifies the amount of conventional memory that is required (in kilobytes). 
If you don't know how much is required, set this to Auto.



Specifies whether to protect system memory from inappropriate modifications by this program. 
When this check box is checked, the program might run slightly slower, but your system is protected from errors 
or failures in the program. 



Specifies the maximum amount of expanded memory to allocate to this program (in kilobytes). If you set this 
value to Auto (recommended), then no limit will be imposed.
Some programs may have difficulty coping with an unlimited amount of expanded memory. If you experience 
difficulty, set this value to 8192.



Specifies the maximum amount of MS-DOS protected-mode (DPMI) memory to allocate to this program (in 
kilobytes). If you set this value to Auto (recommended), then Windows will choose a limit based on your current 
configuration.



Specifies the maximum amount of extended memory to allocate to the program (in kilobytes). If you set this 
value to Auto (recommended), then no limit will be imposed.
Some programs may have difficulty coping with an unlimited amount of extended memory. If you experience 
difficulty, set this value to 8192.



Specifies whether this program can use the high memory area (HMA). 
This option has no effect if the HMA is already being used by the system (for example, if MS-DOS is loaded or if 
an MS-DOS device driver is using the HMA).



Specifies the shortcut keys you want to reserve for use with Windows instead of with this program. Clear the 
check box for a key sequence if you want Windows to ignore it when this program is in use. 
Following are the functions of the shortcut keys in Windows:
ALT+TAB Switches between programs.
ALT+ESC Cycles through the programs in the order they were started.
CTRL+ESC Displays the Start menu.
PRINT SCREEN Copies an image of the screen to the Clipboard. If this box is cleared, sends an image of 

the screen to your printer.
ALT+PRINT SCREEN Copies an image of the active window to the Clipboard.
ALT+ENTER Switches the program between a window (if it can run in one) and a full screen.
ALT+SPACEBAR Displays the program's System menu.



Make sure this box is checked if you want the screen saver to start even when the program is the active 
program.



Prevents any system resources from being used by this program when it is not active.



Specifies how long Windows will allow the program to remain idle (waiting for keyboard input) before reducing 
the CPU resources allotted to the program and enabling other programs to use them.
Low idle sensitivity lets the program run longer before Windows reduces the CPU resources allotted to it. High 
idle sensitivity reduces the CPU resources allotted to the program sooner.
If a program that is running in the background is not getting enough CPU resources, move the slider toward Low.
If you want a program to use fewer CPU resources, move the slider toward High.



Specifies that when you run this program, Windows detects whether it requires or runs best in MS-DOS mode. If 
it does, Windows runs a wizard to set up a custom icon to run the program. If the program works best in or 
requires MS-DOS mode, and you do not select this option, then it may run poorly or not run at all. 



Specifies that when you run this program, it controls all system resources. Before the program runs, the system 
closes all other active Windows-based and MS-DOS–based programs. When you quit the program, Windows 
restarts automatically.



Specifies the number of bytes of memory reserved for the MS-DOS Command Interpreter (Command.com). This 
setting also applies to batch files having the extension .bat. 
If set to Auto, the initial size of the environment is determined by the SHELL= line in your Config.sys file.



Restores window settings when you quit this program, including the window size, position, and font. This is not 
used if you are running the program in a full screen. 



Make sure this box is checked if this program uses text and graphic modes and you want to maximize the 
amount of memory available to other programs when this program is running. When you switch to the mode 
requiring less memory, Windows makes more memory available to other programs. When you switch back to the
mode requiring more memory, Windows attempts to provide the memory.
To ensure that there is always enough memory for Windows to correctly display this program in any mode, make 
sure this box is not checked.



Specifies that you want the system to display a warning that it will close all other Windows-based and MS-DOS–
based programs before running this program in MS-DOS mode. 



Font, Memory, Screen, and Misc options are enabled only when the program is not running in MS-DOS mode. To 
specify that the program should not run in MS-DOS mode, click the Program tab, click Advanced, and then make 
sure the MS-DOS Mode box is not checked.



Shows why your computer is not configured for expanded memory and how you can enable it.



Enables you to edit the Config.sys and Autoexec.bat files, either in the text boxes below or by clicking the 
Configuration button.



Specifies that you want the program to use the current Config.sys and Autoexec.bat file settings.



To install or change software for a network adapter 

1 Click here        to display Network properties.
2 Click Add.
3 Click Adapter, and then click Add.
4 Follow the instructions on the screen.

Tip
If you have an adapter that is not listed, click Have Disk, and then follow the instructions on the screen.



To specify settings for a network adapter

1 Click here        to display Network properties.
2 Click the adapter that you want to configure, and then click Properties.
3 Click the tab for the settings you want to change, and then change the settings.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To remove software for a network adapter

1 Click here        to display Network properties.
2 Click the adapter that you want to remove.
3 Click Remove.

Notes
A network adapter is a hardware device that physically connects your computer to a network.
When you remove the software for a network adapter, all associated components, such as the protocol, are

also removed from the list.



To install a network protocol

1 Click here        to display Network properties.
2 Click Add.
3 Click Protocol, and then click Add.
4 Follow the instructions on the screen.

Notes
 A protocol is the "language" a computer uses to communicate over a network. Computers must use the 

same protocol to communicate with each other.
To install the TCP/IP protocol, which enables you to connect to the Internet: After clicking Add in step 3, 

click Microsoft in the Manufacturers column, and then click Microsoft TCP/IP.
If you have a protocol that is not listed (but is written specifically for Windows 95), click Have Disk, and 

then follow the instructions on the screen.



To specify settings for a network protocol

1 Click here        to display Network properties.
2 Click the protocol that you want to configure, and then click Properties.
3 Click the tab for the settings you want to change, and then change the settings.

Notes
 A protocol is the "language" a computer uses to communicate over a network. Computers must use the 

same protocol to communicate with each other.
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To specify settings for a network client

1 Click here        to display Network properties.
2 Click the client for which you want to change settings, and then click Properties.
3 Click the settings you want to change.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
Client software enables you to use resources that have been shared by people on the network.

{button ,AL("A_INSTALL_NET_CLIENT;")} Related Topics



To specify settings for a network service

1 Click here        to display Network properties.
2 Click the service that you want to configure, and then click Properties.
3 Click the settings you want to change.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
Service software enables you to install services such as file and printer sharing on your computer, or 

automatic backup to a network server.



To remove a network protocol

1 Click here        to display Network properties.
2 Click the protocol that you want to remove.
3 Click Remove.

Note
 A protocol is the "language" a computer uses to communicate over a network. Computers must use the 

same protocol to communicate with each other.



To enable file and printer sharing on your computer

1 Click here        to display Network properties.
2 Click File And Print Sharing.
3 Click the sharing options you want. A check mark means the feature is activated.

{button ,AL("a-sharefolder;a-share-printer")} Related Topics



To disable file and printer sharing on your computer

1 Click here        to display Network properties.
2 Click File And Print Sharing.
3 Delete the check mark from the sharing options you want to remove.



To set up your computer to connect to the network

1 Click here        to display Network properties.
2 Click Add.
3 Click Client.
4 Click Add, and then follow the instructions on the screen.

Notes
The Client for NetWare Networks that is included with Windows 95 enables you to connect to Novell 

NetWare servers. To install this client, after you click Add in step 4, click Microsoft in the Manufacturers column, and 
then click Client For NetWare Networks. 

Two versions of the Novell NetWare workstation shell are also available. To install one of these instead of 
the Client for NetWare Networks, after you click Add in step 4, click Novell in the Manufacturers column.

If you have a network client that is not listed (but is written specifically for Windows 95), click Have Disk, 
and then follow the instructions on the screen.



To remove software for a network client

1 Click here        to display Network properties.
2 Click the network client you want to remove.
3 Click Remove.



To specify a primary network logon

1 Click here        to display Network properties.
2 In the Primary Network Logon list, click the down arrow, and then click the client or logon option you use most 

often when you log on to the network. 

Tips
To start Windows without verifying your logon to a network, click Windows Logon. No error messages will 

appear if you cannot be logged on to the network (for example, when you are using a portable computer on the 
road).

If you see two separate logon screens when you start Windows (one for Windows and one for the network),
you should use the same password for both.



To log on to a domain for Client for Microsoft Networks

1 Click here        to view Network properties.
2 Click Client For Microsoft Networks, and then click Properties.
3 Click Log On To Windows NT Domain.

Tips
You can specify a different domain by typing a new domain name into the Windows NT Domain text box.
You must have the Client for Microsoft Networks installed in order to log on to a domain. For information 

about installation, click Related Topics below.

{button ,AL("A_INSTALL_NET_CLIENT;")} Related Topics



Domain refers to a set of computers on a network that have been assigned a group name. For example, a 
company's domain name on the Internet might be something like "thiscompany.com". A domain could contain 
two or more smaller groups of computers, sometimes referred to as workgroups.



Displays the type of power your computer uses and information about how much power is remaining on the 
power supply.



Changes the Power Management setting used by your computer. Click Advanced to use additional power-saving 
features provided by Windows. Click Standard to use only the power-saving features provided by your computer. 
Click Off to turn off all power-saving features.
If the power-saving features of your computer do not appear to be working, it is possible that some programs 
you are using do not recognize Windows power management. In this case, click Standard.



When this box is checked, the battery meter appears on the taskbar. You can then double-click the battery meter
or simply rest your mouse pointer on the battery meter to see how much power is remaining.



Enables you to put the Suspend command on the Start menu. You can choose to see this command always, 
never, or only when your computer is away from its docking station.



When this option is checked, Windows displays a warning message when your battery power is running low.



Click this to see power-management options provided by your computer manufacturer.



To see how much power remains on your power supply
Double-click the battery or electric plug icon on the taskbar.

{button ,AL("A_SHOW_BATMETER;A_POWER_TURN_ON_SUPPORT")} Related Topics



To show or hide the battery meter

1 Click here     to display Power properties.
2 Click the check box to enable the battery meter.

Tip
When the battery meter is on, you can double-click the battery icon on the taskbar to see information 

about your computer's power supply, or you can point to the icon on the taskbar to see how much power remains.

{button ,AL("A_POWER_TURN_ON_SUPPORT")} Related Topics



To show or hide the Suspend command

1 Click here        to display Power properties.
2 In the Suspend Command Options area, specify whether you want to see the command always, 
sometimes, or only when your portable computer is undocked.

{button ,AL("A_POWER_TURN_ON_SUPPORT")} Related Topics



Windows cannot find the Powercfg.dll file. Your computer may not support power management features.
If your computer does support power management features and you see this message, see Related Topics for 
information about turning on power management.



To turn on power management support

1 Click here        to display the Device Manager.
2 Click the plus sign next to System Devices, and then double-click Advanced Power Management Support.

If you don't see a listing for Advanced Power Management Support, your computer does not support these 
features.

3 Click the Settings tab.
4 Make sure the box to enable power management support is checked.



Displays the icon for the printer.



Describes what type of printer it is and where you can find its icon in My Computer.



Provides a place for you to add a comment about the printer; for example, when it is available or what it is used 
for.
If you share this printer, the comment is transferred when someone sets up your printer on their computer. 
However, if you change the comment, other people will not see the updated version.



Click this to send a test page to your printer. You might want to do this to make sure your printer is set up 
correctly.



Displays the name of the printer.



Displays the port your printer is connected to or the path to the network printer you are using.
You can change where you print to by typing the network path here, by opening the list and clicking a port, or by 
clicking Add Port.



Click this to add a new port or specify a new network path.



Displays the type of printer you are using. This type must match your printer or be one that your printer can 
emulate.



Click this to update or change your printer driver.



Inserts a page between each document printed. This is useful if many people are using your printer or if you are 
printing multiple documents at once. You can choose between a full page that includes graphics or a simple page
with text only.
If you want to use a custom separator page, click Browse to locate and specify which separator file you want to 
print between documents. You can use any Windows metafile (.wmf) for a separator page.
You can set up separator pages only if the printer is attached directly to your computer.



Click this to look for and specify a file that you want to use as a separator page. You can use any Windows 
metafile (.wmf) file for a separator page.



Specifies how much time (in seconds) Windows will wait for the printer to be online before reporting an error.



Specifies how much time (in seconds) Windows will wait for the printer to be ready to print before reporting an 
error. If you have problems printing large documents, you may want to increase the value of this setting.



Click this to change settings for the printer port.



Click this to specify how your document is sent from your program to the printer.



Click this to change settings specific to your printer.



Saves printing information on your computer's hard disk until the printer is ready to print. This frees up your 
program quickly so you can work on other tasks.



Waits until your printer is ready before sending the print job from your program directly to your printer. It may 
take longer for your program to be free for working on other tasks. It is recommended that you spool your print 
jobs unless you are having trouble printing.
If you print directly to the printer, you cannot pause your printer and you will not be able to print if you are 
working offline. If you have shared your printer with others, this option is not available.



Waits until all printing information has come from the program before sending it to the printer. This is the fastest 
way to free up your program for working on other tasks, but you must have enough disk space to store the entire
print job until it is printed.



Starts sending printing information from your disk to the printer after one page has been received from the 
program. Less disk space is used, but your program may take longer to finish printing the document.



Specifies the format in which to store printing information on your disk while a print job is waiting to be printed. 
Generally, EMF (metafile) format frees up your program faster because it is smaller and doesn't depend on what 
kind of printer you have. RAW format is specific to the printer, so extra time may be required to convert the 
printing information, and your program would not be available for working on other tasks.
If you have problems printing using the EMF option, try the RAW option.



Returns to the original settings.



Specifies that your printer should use its bi-directional capabilities to communicate with your computer.



Specifies that your printer should not use its bi-directional capabilities to communicate with your computer.



Click this to delete a port from the list of available ports.



Specifies that you want to print to a network printer.



Specifies that you want to add a port for printing.



Provides a space to type the path of the network printer you want to use. If you don't know the path, click 
Browse.



Click this to find and specify the printer you want to use.



Lists the types of ports available. Click the one you want to add.



Lists existing ports. Click the port(s) you want to delete.



Specifies whether you want to spool documents that you print from MS-DOS–based programs.



Provides a space for you to specify a filename that you want to print to. This name will be added to the list of 
available ports. When you print, your file will be printed to a file with the name you specified here.



Provides a space for you to type the name of the file you want to print to.



Click this to capture a port (map it to a network drive).



Click this to remove the mapping of a port from a network drive (end the capture).



To set up a new printer

1 Click here        to start installing a printer.
2 Follow the instructions on the screen.

If you want to print a test page, first make sure your printer is on and ready to print.

Tip
If you want to use a shared network printer, you can set it up quickly by browsing for it in Network 

Neighborhood, clicking the printer's icon, and then clicking Install on the File menu.



To specify the default printer

1 Click here        to open the Printers folder.
2 Click the icon for the printer you want to use as the default printer.
3 On the File menu, click Set As Default.

If there is a check mark next to this command, the printer is set as the default printer.

Note
It's a good idea to set the default printer to be the one you use most often. When you choose the Print 

command in many Windows-based programs, the default printer is used unless you specify otherwise.



To view documents waiting to be printed

1 Click the Start button, point to Settings, and then click Printers.
2 Double-click the icon for the printer you want to look at. The print queue with all of the print jobs listed 

appears.

Tip
In the printer window, you can find information such as the status of print jobs and the owner of a 

document. If you want to cancel or pause the printing of any of the documents you have sent, click the document, 
and then use the commands on the Document menu.



To cancel printing of a document

1 Click here        to open the Printers folder.
2 Double-click the icon for the printer you are using.
3 In the list, click the document you want to cancel.
4 On the Document menu, click Cancel Printing.

Note
You can cancel the printing of all documents on a printer that is attached to your computer. If you are using

a network printer, you can cancel only your own documents.



To change the port a printer is connected to

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Details tab, and then change the port in the Print To The Following Port box.

Notes
If you want to map the port to a network drive, click Capture Printer Port.
If you want to print to a file, select File in the Print To The Following Port box.



To change the order of documents in a print queue

1 Click here        to open the Printers folder.
2 Double-click the icon for the printer you are using.
3 Click the document you want to move, and then drag it to its new position in the queue.

Note
You cannot move a document that is in the process of printing.



To pause or restart your printer

1 Click here        to open the Printers folder.
2 Double-click the icon for the printer you want to pause or restart.
3 On the Printer menu, click Pause Printing.

If there is a check mark next to the command, the printer is paused. To restart the printer, click this command 
again.

Notes
You can pause a printer only if it is attached to the computer you are using. For example, you cannot pause

a network printer from your own computer.
The Pause Printing command is unavailable if you have turned off spooling in your printer properties.



To separate your print jobs with a banner page

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 In the Separator Page box, open the list and click the type of separator page you want.

If you want to use a custom separator page, click Browse.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
You can set up separator pages only if the printer is attached directly to your computer.



To change printer settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.

The settings you can change depend on the type of printer you have. Click the different tabs to see all of the 
options you can set.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
Changing the printer properties will change them for all documents you print on this printer. To change 

these settings for one document, use the Page Setup or Print Setup command on the File menu in your program.
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To change the printer timeout settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you want, click the File menu, and then click Properties.
3 Click the Details tab, and then change the settings in the Timeout Settings area.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To use a printer that is not currently connected

1 Click here        to open the Printers folder.
2 Click the icon for the printer that you want to print to.
3 On the File menu, click Work Offline.

When you send a document to this printer, it will be stored until you turn the printer online by clicking the 
Work Offline command again.
The Work Offline command is available only for portable computers or for computers using a network printer. 
For local printers, use the Pause Printing command.

Tips
If you have a laptop computer with a docking station and you start Windows while the computer is 

undocked, your print jobs are automatically saved. Then, when you start Windows when your computer is docked, 
the documents are sent to the printer.

If you have turned off spooling in your printer properties, you cannot print offline.



To view printing status
Use your right mouse button to click the printer icon next to the clock on the taskbar.

When your document is finished printing, the printer icon disappears.

Tip
You can double-click the printer icon on the taskbar to get information about the documents printing on the

printer.



To change the paper size or layout for printing

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Paper tab.

The settings you can change depend on the type of printer you have.

Tips
For Help on an item, click 

 at the top of the dialog box, and then click the item.
Changing the printer properties in the Printers folder will change them for all documents you print on this 

printer. To change these settings for one document, use the Page Setup or Print Setup command on the File menu in
your program.



To specify font settings for your printer

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Fonts tab, and then specify the settings you want.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To set printing options for graphics and color

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Graphics tab.

The settings you can change depend on the type of printer you have. To change color settings, click the Color 
button.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To remove all documents from the print queue

1 Click here        to open the Printers folder.
2 Double-click the icon for the printer you are using.
3 On the Printer menu, click Purge Print Jobs.

All documents waiting to be printed will be removed from the print queue, and they will not be printed.

Note
You cannot remove documents from the print queue of a network printer from your computer.



To capture a printer port

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties.
4 Click the Details tab, and then click Capture Printer Port.
5 In the Device list, select the printer port that you want to capture.
6 Type the network path, and then click OK.
7 In the Print To The Following Port box, select the port you mapped.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



A print queue is a list of documents waiting to be printed on the printer. In the print queue, you can see 
information such as the size of the document, who sent the document, and status information for printing.



Print Troubleshooter

This troubleshooter helps you identify and solve printer problems. Just click to answer the questions, and then try
the suggested steps to fix the problem.

What's wrong?
            My document didn't print at all.  
            My document printed, but it doesn't look right, or it printed only partially.  
            Printing is unusually slow.  



Are you printing to a local or a network printer?
            Local. My printer is directly connected to my computer.  
            Network. My printer is located somewhere else. It's not attached to my computer.  



Print Troubleshooter

1 Click here        to display printer properties.
2 Make sure all settings are correct.
3 Try printing again.

Note
If you're still having trouble printing, wait until Windows has finished starting, and then open the Print 

Troubleshooter in Help.



Are you printing from an MS-DOS–based program?
            Yes.  
            No. I'm printing from a Windows-based program.  



Check the printer

1 Make sure the printer is plugged into your computer and into an electrical outlet.
2 Make sure the printer's power switch is on.
3 Make sure the printer is online. Most printers have an On Line button with a light next to it. The light should be 

on.
If you need more information about any of these steps, see your printer manual.

Do you think this fixed the problem?
            Yes. Try printing another test page to make sure the problem is fixed.  
            No. My printer is on, but it still won't print. What else could be wrong?  



Try printing a test page

Click here        to send a test page to your printer.



Next steps

You've run into a problem with your printer or with Windows that the Print Troubleshooter can't help you solve.
Try looking in your printer manual for more information, or see the Printers.txt file that comes with Windows.



Check the paper

1 Make sure there is paper in your printer.
2 Make sure the paper isn't jammed.
3 Find out if you need to change the cartridge, ribbon, or toner.

Do you think this fixed the problem?
            Yes. Try printing another test page to make sure the problem is fixed.  
            No. The paper supply is fine, but my printer won't print. What else could be wrong?  



Check the printer driver

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Make sure the printer driver matches the printer you are using. If it doesn't, click New Driver, and then make 

the necessary changes.

Do you think this fixed the problem?
            Yes. Try printing another test page to make sure the problem is fixed.  
            No. The printer driver is correct, but my printer won't print. What else could be wrong?  



Check settings in your program

1 In the program you are trying to print from, click the File menu, and then click Print Setup or Page Setup.
2 Make sure the printer specified in the dialog box matches the printer you are using.
3 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes. it worked. Close this troubleshooter.  
            No. The printer listed is correct, but my printer won't print.  



Try capturing the printer port

If you are using a network printer, carry out the following procedure.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the Details tab.
4 If your port is listed as LPTx in the Print To The Following Port box, then it has already been captured. Skip to 

the end of this procedure, and choose No. Otherwise, proceed to step 5.
5 Click Capture Printer Port.
6 In the Device list, select the printer port that you want to capture.
7 Type the network path, and then click OK.
8 In the Print To The Following Port box, select the port you captured.
9 Try printing your document again.

Did this fix the problem?
            Yes. it worked. Close this troubleshooter.  
            No. What else should I try?.  



Try reinstalling your printer

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Delete.
3 Double-click the Add Printer icon, and then follow the instructions to install your printer again.

Do you think this fixed the problem?
            Yes. Try printing another test page to make sure the problem is fixed.  
            No. My printer is installed correctly. What else could be wrong?  



Check the printer port

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the Details tab.
4 Make sure the correct port or network path is specified in the Print To The Following Port list box. 

If you have a network printer, click Capture Printer Port and make sure you've got a port assigned to the 
network path.

5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! It worked. Close this troubleshooter.  
            No. The port setting is correct, but my printer won't print.  



Check your program settings

1 In your MS-DOS–based program, make sure that the correct printer is specified.
2 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! It worked. Close this troubleshooter.  
            No. My document won  ’  t print. What else could be wrong?  



Try turning MS-DOS spooling off

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Details tab, and then click Port Settings.
4 Click the Spool MS-DOS Print Jobs box to remove the check mark.
5 Try printing your document again.

Did this fix the problem?
            Yes! It worked. Close this troubleshooter.  
            No. My document won  ’  t print. What else could be wrong?  



Quit program after printing
Try printing your document again, and then quit your MS-DOS–based program. 
Sometimes the document won’t be printed until the MS-DOS–based program is closed.

Did this fix the problem?
            Yes! It worked. Close this troubleshooter.  
            No. My document still won  ’  t print. What else could be wrong?  



Check the network server
Make sure that the computer attached to the printer is still running correctly.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. The print server is running. What else could be wrong?  



Try capturing the printer port

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the Details tab.
4  If your port is listed as LPTx in the Print To The Following Port box, then your port is already captured. Skip to 

the end of this procedure, and choose No. Otherwise, proceed to step 5.
5 Click Capture Printer Port.
6 In the Device list, select the printer port that you want to capture.
7 Type the network path, and then click OK.
8 In the Print To The Following Port box, select the port you captured.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. The port is captured and I still can't print. What else could be wrong?  



Try turning off separator pages

If you are using a PostScript printer on a NetWare server and banner pages are being used to separate 
documents, carry out the following procedure.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 In the Separator Page box, click None.
If you do not have access to your network printer server, ask your network administrator to turn off separator 
pages for this printer.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. What else could be wrong?  



Check the network path

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the Details tab.
4 In the Print To The Following Port list box, make sure the path to the printer is correct and still exists.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. The path is correct, but my printer won't print. What else could be wrong?  



Check the network cable connection
Make sure the cable that connects your computer to the network is plugged in properly.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. My network cable is plugged in, but my printer won't print. What else could be wrong?  



Check disk space

You need to have at least 2MB free on your hard disk. To check this, carry out the following procedure.
1 Double-click the My Computer icon.
2 Click the hard disk icon, click the File menu, and then click Properties.
3 If you don't have enough free space, try deleting unnecessary files or running the Disk Space Troubleshooter.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. I have plenty of disk space, but my printer won't print. What else could be wrong?  



Check printer settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Check the settings on all of the tabs, including any memory settings. Make sure that the settings match what 

is actually installed in your printer.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. The printer settings are correct, but my printer won't print. What else could be wrong?  



Does your document contain complex graphics or special fonts?
If your document contains complex graphics or numerous fonts, try printing a small, simple document. It is 

possible that your printer does not have enough memory to print the document you are working on.

Did the small document print?
            Yes. I probably need to get more memory for my printer. Close this troubleshooter.  
            No. I can't even print a small document.  



Try changing timeout settings

If your document contains complex graphics or numerous fonts, try increasing the timeout values by carrying out
the following procedure.
1 Click here     to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the Details tab.
4 In the Timeout Settings area, increase the values of the timeout settings.
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes. it worked. Close this troubleshooter.  
            No. The timeout settings are fine, but my printer won't print.  



Printer is set up correctly

Since the test page works, we know that your printer is set up correctly in Windows.
If you changed any settings to get the self-test page to work, try printing your document again.

Is the problem fixed?
            Yes! My document prints now. Close this troubleshooter.  
            No. My document still won't print. What could be wrong?  



Check spooling settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties
3 Click the Details tab, and then click Spool Settings.
4 If the Spool Data Format is set to EMF, try changing the setting to RAW. 

If it is set to RAW, try turning spooling off by clicking Print Directly To The Printer.

Do you think this fixed the problem?
            Yes! Try printing another test page to make sure the problem is fixed.  
            No. The spooling settings are correct, but my printer won't print. What else could be wrong?  



My document doesn’t look right
Click the button for the type of problem you are having.
            Only a partial page printed.  
            The text or graphics either don  ’  t print at all or print incorrectly.  
            Incorrect fonts are printed.  
            PostScript text codes are printed.  



Check paper orientation

1 In the program you are trying to print from, click the File menu, and then click Print Setup or Page Setup.
2 Make sure that you have selected the correct orientation (landscape or portrait) for your document. Depending

on your program, you may need to click a Setup button or Options button to find these settings.
3 If the setting is correct in your program, make sure the setting is also correct in the properties for your printer.

Click here        to open the Printers folder.
4 Click the icon for the printer you are using, click the File menu, and then click Properties.

5 Click the Paper tab, and then verify that you have specified the correct settings.
6 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. The orientation settings are correct. What else could be wrong?  



Check the nonprinting area

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Paper tab, and then click Unprintable Area.
4 Make sure the settings are correct for your printer and your paper size. Then make sure that your document is 

the correct size for the paper.
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. The unprintable area settings are correct. What else could be wrong?  



Check the graphics mode

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 Click the File menu, click Properties, and then click the Graphics tab.
4 If the Graphics Mode is set to Vector, try changing the setting to Raster.

If you don't see the Graphics Mode box, then your printer does not support this option.
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. The unprintable area settings are correct. What else could be wrong?  



Check your printer cable setup

1 If you are using a switchbox for your printer, try bypassing it.
2 Check your printer cable. Parallel cables should be no more than six feet long. If your parallel cable is longer 

than six feet, try using a shorter cable.
3 If you made any changes, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. My printer cable setup is correct. What else could be wrong?  



Check graphics settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Graphics tab, and then make sure the settings are correct for your printer.

If you are using a color printer, try selecting Error Diffusion in the Dithering area.
4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. The graphics settings are correct. What else could be wrong?  



Check the fonts in the document

1 Check to see what kind of fonts you are using in your document. You should use TrueType or printer fonts; 
screen fonts won't necessarily look the same printed as they do on your screen.

2 If you change any fonts in your document, try printing it again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Check the font cartridge

If your printer uses a font cartridge, make sure that it is installed correctly in your printer, and then carry out the 
following procedure to check the cartridge settings.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Fonts tab, and then make sure that the correct font cartridge is selected. If the cartridge is not in the 

list, click Install Printer Fonts.
4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Check the font settings

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Fonts tab, and then review the font settings.
4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Try printing TrueType fonts as graphics

If you have a laser printer, carry out the following procedure.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Fonts tab, and then click Print TrueType As Graphics.
4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Make sure you have a PostScript driver

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Details tab, and then make sure the correct printer driver is specified in the Print Using The Following 

Driver box. To print a PostScript file, you must have a printer that supports PostScript. To use a different printer
driver, click New Driver.

4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Check the printer

1 Make sure that your printer is set for printing PostScript files. Some printers can print in different modes; you 
can configure the modes in the printer's control panel. For more information, see your printer's manual.

2 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Check the output format

If you get a PostScript error when you print your document, try changing your PostScript settings by carrying out 
the following procedure.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using.
3 On the File menu, click Properties, and then click the PostScript tab.
4 If the PostScript Output Format is set to PostScript (Optimize For Speed), try changing the setting to PostScript 

(Optimize For Portability).
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Printing is unusually slow
            It takes a long time for my program to print and to be available for other tasks.  
            It takes a long time for the document to come out of the printer.  



Make sure spooling is turned on

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Details tab, and then click Spool Settings.
4 Make sure spooling is turned on. If spooling is on, experiment with printing after the first page is spooled and 

after the last page is spooled.
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Turn spooling off

1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Details tab, and then click Spool Settings.
4 If spooling is turned on and Spool Data Format is set to EMF, try changing the setting to RAW. You can also try 

turning spooling off by clicking Print Directly To The Printer.
5 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



Try a lower printing resolution

If your printer supports multiple printing resolutions, try printing in a lower resolution by carrying out the 
following procedure.
1 Click here        to open the Printers folder.
2 Click the icon for the printer you are using, click the File menu, and then click Properties.
3 Click the Graphics tab, and then select a lower resolution.
4 If you change any settings, try printing your document again.

Did this fix the problem?
            Yes! My document prints now. Close this troubleshooter.  
            No. What else could be wrong?  



To set up a network connection by using Dial-Up Networking

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.
2 Follow the instructions on the screen.

Notes
If you have already set up one or more Dial-Up connections, you can double-click Make New Connection to 

create a new connection. To dial a connection that you have already set up, double-click its icon in the Dial-Up 
Networking window.

After you have connected to another computer, you can see files and folders on that computer only if they 
are shared. 

If you do not see a Dial-Up Networking folder in My Computer, then it is not installed. To find out how to 
install it, click Related Topics below.

{button ,AL("A_ADDPROG_COMPONENT;A_RNA_CHANGE_SETTINGS;A_RNA_CHANGE_DIALIN_SETTINGS")} 
Related Topics



To change dialing settings for a Dial-Up connection

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.
2 Click the connection whose settings you want to change.
3 On the Connections menu, click Settings.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.

{button ,AL("A_DIAL_LINK;A_RNA_CHANGE_SETTINGS")} Related Topics



To change the properties for a Dial-Up connection
1 In the Dial-Up Networking folder, click the icon for the connection whose properties you want to change.
2 On the File menu, click Properties.
3 Click Configure. 
4 Make changes to the modem properties.
Changes that you make will take effect when you gain access to a shared resource that uses this connection, or 
the next time you double-click the icon for this connection.

Tips
To change the type of server that you are dialing in to, or to specify which protocols this connection uses, 

click Server Type instead of Configure.
You can change settings only if you have already set up a connection.
For Help on an item, click 

 at the top of the dialog box, and then click the item.

{button ,AL("A_DIAL_LINK;A_RNA_CHANGE_DIALIN_SETTINGS")} Related Topics



To set up a direct cable connection

1 Click the Start button, and then point to Programs.
2 Point to Accessories, and then click Direct Cable Connection.
3 Follow the instructions on the screen.

Notes
If you have already successfully run Direct Cable Connection on this computer, the connection wizard does 

not appear unless you click Change in the Direct Cable Connection dialog box. The wizard then starts, and you can 
change your previous settings.

If you do not see Direct Cable Connection in your Accessories menu, then it is not installed. To find out how
to install it, click Related Topics below.

{button ,AL("A_ADDPROG_COMPONENT;A_DCC_SETTINGS;A_DIAL_LINK_CABLE;A_RENEW_DCC")} Related Topics



To re-establish a direct cable connection that is already set up

1 On the host computer, click the Start button, and then point to Programs.
2 Point to Accessories, and then click Direct Cable Connection.
3 Click Listen.
4 Move to the guest computer, and then repeat steps 1 and 2.
5 Click Connect.

Note
If you have trouble connecting, check the cable, or run the Direct Cable Connection Troubleshooter in Help.

{button ,AL("A_DCC_SETTINGS;A_DIAL_LINK_CABLE;A_SETUP_DCC")} Related Topics



To change settings for a direct cable connection

1 Click the Start button, and then point to Programs.
2 Point to Accessories, and then click Direct Cable Connection.
3 Click Change.
4 Make any necessary changes. These changes will take effect when you gain access to a shared resource that 

uses this connection.

{button ,AL("A_DIAL_LINK_CABLE;A_SETUP_DCC;A_RENEW_DCC")} Related Topics



Shared resources include files, folders, and printers.



To dial a connection manually

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.
2 Click the icon for the connection you want to change.
3 On the File menu, click Properties.
4 Click Configure.
5 On the Options tab, click Operator Assisted or Manual Dial.
6 When you gain access to a shared resource that uses this connection, or the next time you double-click the 

icon for this connection, you will be prompted to lift the receiver of your phone and dial the number.
7 When you hear the tone from the computer, click Connect, and then hang up the phone.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To use Dial-Up Networking to connect to another operating system

1 In the Dial-Up Networking window, create a new connection to the computer you want to dial into.
2 After you have created the connection, use your right mouse button to click the icon for that connection, and 

then click Properties.
3 Click Server Type.
4 Select the type of dial-up server that matches the operating system you want to connect to.

Tips
If the other operating system requires you to type in information when you log on, click the Configure 

button in the properties for that connection, click Options, and then click Bring Up Terminal Window Before Dialing.
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To use a different IP or DNS address for a Dial-Up connection

1 In the Dial-Up Networking window, click the connection that you want to assign the new IP address to. 
2 On the File menu, click Properties.
3 Click Server Type, and then click TCP/IP Settings.
4 Type the new IP and/or DNS address in the space provided.

Notes
This setting is useful if you have more than one Internet account and cannot use the same address for all 

of them.
If you click Server Assigned IP Address or Server Assigned Name Server Addresses, Dial-Up Networking will

use the default TCP/IP address information for this connection, as specified in the Network properties in Control 
Panel.



Displays the status of the modem currently in use. A red light indicates that the modem is not actively 
transmitting or receiving. A green light indicates that the modem is actively transmitting or receiving.



Displays the telephone number of the computer you want to connect to. The number displayed is the number 
you entered when you created the connection. To change the number temporarily, you can modify it here. To 
change the number permanently, use your right mouse button to click the connection icon, and then click 
Properties.
If you modify the number directly, information in the Dial Properties dialog box is ignored.
If you want to use a calling card, or if you are at a different location, click Dial Properties.



Click this to specify how the call will be dialed. This is useful if you want to charge the call to a calling card, use 
your computer from different locations, or add a dial-prefix, country code, or area code automatically.



Shows the name of the computer you will connect to when you use this connection.
To connect to this computer, double-click the icon in your Dial-Up Networking folder.



Lists the connections you have set up.
If there are no connections in the list that will enable you to connect to this resource, go to the Dial-Up 
Networking folder and create a new connection.



Provides a space for you to type your user name. This name is used when you log on to the computer you are 
connecting to.



Provides a space for you to type the password for connecting to this computer (not to the network).
If you don't want to type your password each time you connect, click Save Password.



Specifies whether the computer remembers your password or whether you must type it each time you connect.
The password will only be saved for this connection icon and this user name.



Specifies where you are calling from. 
To change information about a location or define a new location, click Dial Properties. 
To change to a different location, select one from the list.
If this box and the Dial Properties button are unavailable, close this dialog box, use the right mouse button to 
click the connection, and then click Properties. Check the Use City And Area Code box.



Provides a space for you to type or select the area code, phone number, and country code for the computer you 
are connecting to.
You can specify that you want to ignore the area code and country code by making sure the Use Country Code 
And Area Code box is not checked. With this box cleared, you cannot specify that you want to dial from a 
different location when you try to connect.



Lists the modems that are set up on your computer. To select the modem you want to use for this connection, 
double-click it.
If the modem you want isn't on the list, double-click the Modems icon in Control Panel to add it.



Click this to change the settings of the modem you are using to establish the new connection.
Changing the modem settings for this connection will not affect global modem settings in Control Panel. These 
settings will be used only with this connection.



Click this to select the type of dial-up server to use.
Note that changes to the server type do not apply to a connection that is currently open.



Lists the types of servers available, as determined by the Dial-Up Adapter installed on this computer.
Note that changes to the server type do not apply to a connection that is currently open.



Specifies whether incoming or outgoing information is compressed before it is sent. This is useful to speed up the
transfer of information.
Compression will occur only if both computers are using compatible compression.



Specifies that only encrypted passwords can be sent to or accepted by your computer. This is useful if you need 
additional security for this connection. If you are dialing out, type your password in regular form; your computer 
will encrypt it for you. The computer you are connecting to must support encrypted passwords for this option to 
take effect.



Specifies that Dial-Up Networking will attempt to log on to the network you are connecting to, using the 
username and password you typed when you logged on to Windows.



Specifies the network protocols that your computer can use. 
To add or remove one of these three protocols, double-click the Network icon in Control Panel, and then click 
Add, or click a protocol in the list and click Remove.



Click this to change the TCP/IP settings exclusively for this connection. This is useful if you have different TCP/IP 
configurations for different connections.



If selected, Dial-Up Networking will accept an IP address from a PPP server. If the PPP server does not offer an IP 
address, the IP address specified for TCP/IP -> Dial-Up Adapter in the Network properties in Control Panel will be 
used. 



If selected, type the preferred IP address for this connection. Dial-Up Networking will try to use this address. 
This is useful if you have more than one Internet account and want to use different IP addresses for different 
connections.



If selected, Dial-Up Networking will accept DNS and WINS server addresses from a PPP server. If the PPP server 
does not offer DNS and WINS addresses, DNS and WINS server addresses specified for TCP/IP in the Network 
properties in Control Panel are used. 



If selected, type one or two DNS and/or WINS server addresses to use for this connection only. Dial-Up 
Networking will try to use these addresses first.
This is useful if you have more than one Internet account and need to use different DNS and WINS server 
addresses for different connections.



If checked, Dial-Up Networking uses IP header compression for this connection. IP header compression optimizes 
data transfer between computers.



If checked, IP    traffic is routed to the WAN connection by default. 



Dials the specified phone number and connects to the computer you're dialing.



Specifies whether Windows will redial the connection if the line is busy or doesn't answer, or if the connection is 
disrupted. 



Specifies how many times Windows will redial a connection after failing to connect.



Specifies the interval, in minutes and seconds, between each redial attempt.



Specifies whether Windows will prompt you to use Dial-Up Networking each time you establish a connection. 
This is useful if you want to assign a drive letter to a drive to which you are connected.



Shows which version of Windows is installed on your computer.



Specifies the type of processor your computer has and how much extended memory is in your computer and 
available to Windows.



Specifies the name of the person who is registered to use this copy of Windows. This name was entered during 
Setup.



Specifies how much extended memory is in your computer and whether you are using 32-bit paging or 16-bit 
paging.



Specifies how much of the virtual memory in your computer is available. The rest of the memory is being used 
by Windows and other programs.



Click this to change virtual-memory settings. These settings should be changed only by system administrators or
other advanced users.



Click this to change file system settings. These settings should be changed only by system administrators or 
other advanced users.



Optimizes disk performance for the typical use of the computer. Select the most common use for this computer.



If you have a CD-ROM drive, specifies the cache size and how the cache is balanced. Most of the time, you do not
have to change these settings.



Changes the cache size for your CD-ROM drive. The size of the cache when you choose small or large will differ 
depending on the type of CD-ROM you are optimizing.



Specifies the type of CD-ROM you have.



Specifies that Windows reserves some hard-disk space to use as extra memory. This speeds up your computer's 
performance. In most cases, you will see the best performance if Windows determines these settings.



By default, Windows maintains long filenames and extended file information on files and folders. To disable this 
support, run Setup again and choose the Custom option for installing.



These options enable you to change file-system settings. You should use these options only if you are 
troubleshooting, because checking any of these options will degrade Windows performance.



Uses the default setting for the amount of hard-disk space that your computer can use as extra memory. 
Whenever possible, you should choose this option.
Windows chooses the default setting based on the amount of free hard-disk space. The swapfile then shrinks and
grows dynamically based on actual memory usage. If you choose this option, the minimum size is zero and the 
maximum can be up to the available space on your hard disk.



Click this to change the amount of hard-disk space your computer can use as extra memory.
Unless you have specific memory needs that aren't being met by the default setting, it is better to let Windows 
manage your virtual-memory settings.



Specifies which hard disk you want to use for virtual memory, and specifies the amount of free space on the 
selected hard disk.



Specifies the minimum amount of hard-disk space your computer can use as extra memory. You might want to 
increase this setting if you use a program that requires a large amount of memory.



Specifies the maximum amount of hard-disk space your computer can use as extra memory.



Disables virtual memory. Your computer may slow down significantly, and you may not be able to run large 
programs. This option is not recommended.



Lists the hardware on your computer by type or by connection.
If you display the hardware by type, a device will be listed under its hardware category.
If you display the hardware by connection, the device will be listed under the hardware it is connected to. For 
example, you may see a SCSI card listed, and the various devices attached to the SCSI card will be listed 
beneath it.



Lists the hardware on your computer. To see hardware in a category, click the plus sign next to the hardware 
type or connection name. To see information about a piece of hardware, double-click it.
An X through an icon means the hardware has been disabled. A circled exclamation point through the icon 
means the hardware has a problem. The type of problem will be displayed in the properties for the hardware.



Click this to display and change properties for the selected device in the hardware list.



Updates the hardware list. This process may take a few minutes.



Removes the selected device or hardware type from the hardware list. If the device you select is not a Plug and 
Play device, make sure you also remove the hardware card from your computer so the resources used by the 
device will be freed.
For example, if you remove a sound device, remember to remove the sound card from your computer. To reinstall
a device that you have removed, double-click the Add New Hardware icon in Control Panel.



Click this to print a summary of your hardware, including resources used and device drivers, if applicable. This is 
useful for hardware troubleshooting.



Specifies the type of report you want to print.



Prints a report organized by resource type (IRQ, I/O port, memory, and DMA channel). Under each resource type, 
the report lists which hardware is using each resource.



Prints a report listing the resources and device drivers, if any, used by the hardware selected in the hardware 
list.



Prints a complete report about your hardware, including a list of all resources used by the hardware and details 
about each piece of hardware.



Specifies which printer the report is sent to. To change the printer, click Setup.



Specifies that you want to print to a file instead of a printer. If you select this option, Windows will prompt you for
the name of the file.



Specifies general information about your hardware.



Displays the status of the selected hardware device. If the hardware has a problem, the type of problem and a 
suggested solution are displayed here. 
You may also see a problem code and a number. If you call a support line, this number will be helpful in tracking 
down the problem.



Provides a place to enable or disable this device. If the box is checked, the device is enabled for that 
configuration and the Windows driver for the device will be loaded. If the box is not checked, the device is 
disabled, and the Windows driver for the device will not be loaded. If you use a real-mode driver for the 
hardware, it is unaffected by these settings.
If you disable Plug and Play hardware, resources for the hardware will automatically be available for other 
hardware. If you disable hardware that is not Plug and Play, you must also remove the device from the hardware 
list in Device Manager, and then physically remove the hardware from your computer to free the resources.



This device is part of a multifunction device. To disable this device, you must disable the parent device, which is 
specified above.
To disable the parent device, click OK to return to the hardware list, click the parent device, and then disable it. 
When you disable the parent device, all the child devices attached to it are also disabled.



Displays the device drivers that are currently being used by this hardware. To add or change a driver, click 
Change Driver.



Enables you to change the device driver used by this hardware.



If the information is available, displays information about the driver selected in the Driver Files list.



Lists the available hardware models.



Click Show Compatible Devices to show only hardware that is compatible with the hardware installed in your 
computer. Click Show All Devices to show all available hardware devices.



Click this if you have an installation disk for the hardware you are installing.



Provides a place for you to type or select the path to the file that contains information about your device. Or you 
can click Browse to search through folders to find the file you want.



Specifies the resources currently used by the hardware. To change a resource setting, double-click the resource 
type for the setting you want to change.
Generally, it is best not to change resource settings manually. When you change settings manually, the settings 
are fixed, and Windows will then have less flexibility when configuring other devices. If too many resources are 
fixed, Windows may not be able to install new Plug and Play devices. To have Windows choose resource settings 
for you, check the Use Automatic Settings box.



Changes the value of the setting selected in the Resource Settings box.
If this button is not available, the settings for this hardware cannot be changed. However, you may be able to 
use a different configuration by clicking a different option in the Settings Based On box.



Check this box if you want Windows to determine available resource settings for this hardware. This box is 
available only if your hardware supports this capability.
If this box is available, it is best to check it. Windows will then have the most flexibility when configuring other 
devices. If this box is not checked, the resource settings are fixed and Windows may not be able to install new 
Plug and Play devices.



Lists which configuration (group of available resource settings) the hardware is currently using. To choose a 
different configuration, click the down arrow.
If you choose a configuration other than the default, the hardware may run more slowly, or some functionality 
may not be available.



Lists any conflicts among the resources shown in the Resource Settings box. For Help on resolving a hardware 
conflict, look under Troubleshooting in the Help Contents.



Displays the current value for the resource setting you selected, and lists other values you can choose that will 
work with your hardware. If you choose a setting that is already in use by other hardware, the conflict will be 
listed in the Conflict Information box.



Displays the device(s) currently using the resource displayed in the Value box.
If a device is listed in this box, a hardware conflict will occur if you use the selected resource. If this box reads 
"No devices are conflicting," the resource selected above is available for use.



Displays general information about the hardware type.



Click a resource type to see a list of the current resource settings and the hardware that is using each setting. If 
the box below is empty when you click a resource type, then all the settings of that type are free.



Displays the resource values currently in use and the hardware that is using the resource.
To change a resource assignment, click OK to return to the hardware list. In the hardware list, double-click the 
hardware using the resource you want to change, and then click the Resources tab.



Click the type of resource you want to reserve. If you reserve a resource setting, it cannot be used by any 
hardware on your system.
Settings that are already reserved are listed below. If nothing is listed, no settings of that type are currently 
reserved.



Displays resources that are already reserved.



Reserves a resource system-wide. If you reserve a resource, it cannot be used by any hardware on your system. 
To reserve a resource, click the type of resource you want to reserve, and then click this button.



Changes the value of a reserved resource. To change a reserved resource, click the resource in the box above, 
and then click this button.



Frees a reserved resource so it can be used by hardware. To free a resource, click the resource in the box above, 
and then click this button.



Specifies which value(s) you want to reserve.



Displays a list of the hardware profiles set up on your computer. 
Hardware profiles instruct Windows to load the correct drivers when the available hardware changes. For 
example, you may have different hardware available for your portable computer, depending on whether the 
computer is docked or undocked. Windows will load only the drivers needed for the correct profile.



Copies the hardware profile you select to a new hardware profile. You can then make changes to the new profile. 
This is useful if, for example, you want to choose whether to use a network, and don't want to load the device 
drivers if you choose not to use the network.



Renames an existing hardware profile.



Deletes a hardware profile from the list. If you delete a hardware profile, you will have to set it up again if you 
start your computer with that profile later.



Provides a place for you to type a name for the new hardware profile.



Displays the name of the profile you are copying or renaming.



Specifies what memory will be used for your PC card devices.



When checked, specifies that Windows will automatically determine what memory is used by your PC cards.



Specify the start, end, and length of memory segment you want to use for your PC cards.



Turns off the sound that occurs when a PC card is inserted or removed from the socket.



Provides information about your SCSI disk.



Displays disk options. Most of the time, you do not have to change these settings.



This option is only for SCSI devices. This option is enabled by default, and should not be changed if your SCSI 
device works properly.



This option is for SCSI devices only. This option is enabled by default for disks, and disabled by default for CD-
ROMs. This option should not be changed if your SCSI device works properly.



Specifies that Windows will automatically be notified when you insert a compact disc in a CD-ROM drive.



Indicates that the disk is removable. Change this option only if it is incorrect.



Specifies whether the drive is an INT 13 drive. If it is, you cannot change this option. If it isn't, you may want to 
change this option only if you want to use utilities that work only on INT 13 drives. For example, if you want to 
use FDISK to partition this drive, you could check this box.
If this feature is enabled for removable drives, the media must be in the drive when you start your computer.



Specifies which drive letter is currently assigned to this drive.



Specifies which drive letters are reserved for a removable drive. If your removable drive is partitioned, you need 
to reserve drive letters for each partition.



Specifies the baud rate for this port. If you are unsure what the value should be, consult your hardware 
documentation, or use the default value.



Specifies the data bits for this port. If you are unsure what the value should be, consult your hardware 
documentation, or use the default value.



Specifies the parity for this port. If you are unsure what the value should be, consult your hardware 
documentation, or use the default value.



Specifies the stop bits for this port. If you are unsure what the value should be, consult your hardware 
documentation, or use the default value.



Specifies the flow control for this port. If you are unsure what the value should be, consult your hardware 
documentation, or use the default value.



Restores the values for bits per second (baud rate), data bits, parity, stop bits, and flow control to the default 
values.



When selected, enables you to reserve and select the size of a DMA buffer. Generally, you do not have to change
this option.



When selected, DMA transfers will occur only below the memory address specified. For example, if you choose 
16 MB, DMA transfers will occur below 16 MB. If you choose 4 GB (if you have a 486 or Pentium processor), DMA 
transfers will occur below 4 GB.
Generally, you do not have to change this option.



Click this to restore reserved memory and address restrictions to the default settings.



This button appears in one of two cases. The text above this button describes which case it is.
In the first case, resource settings used by this device have been freed temporarily, probably because your 
device is disabled. To set resources for this device automatically, click the General tab, and then enable the 
device. To manually determine resources for this device, click this button. The resource settings you choose will 
be set until you specify to choose settings automatically.
In the second case, the resource settings used by this device are working, but they don't match any of the 
known configurations. Click this button to use one of the known configurations instead of the settings your 
device is currently using.
If the configuration you choose does not contain all the resource settings required by this device, your hardware 
may not work properly. You may want to contact your hardware manufacturer for updated drivers or .inf files for 
this device.
If your hardware is working properly now, it is best not to change settings by using this button.



Click this to see the product support number you should call if you need assistance, and other information from 
your PC manufacturer.



Displays a list of the hardware that is conflicting.



Click this to display a list of hardware that is conflicting.



Hardware profiles instruct Windows to load the correct drivers when the available hardware changes. For 
example, you may have different hardware available for your portable computer, depending on whether the 
computer is docked or undocked. Windows will load only the drivers needed for the correct hardware profile.



Displays the available communications ports and the type of hardware installed on your computer through 
communications ports.



Displays information about the current communications driver installed on your computer.



When a modem is selected, displays more information about the port settings and the modem command 
settings.



Opens a troubleshooter that tells you how to solve modem problems.



Displays a list of the PC cards currently plugged into your computer.
To remove a card, click it in the list, and then click Stop.



Safely stops the selected PC card. Click a PC card in the list above, and then click this to have Windows safely 
stop it. When Windows prompts you, you can remove the card from your computer.



When this box is checked, a PC card (PCMCIA) icon appears on the taskbar. You can then double-click the icon to 
see properties for your PC card(s), or click once for a menu that enables you to stop a PC card before removing 
it.



When this box is checked, Windows will warn you if you try to remove a PC card without stopping it first.
You can stop a PC card by using the taskbar icon or the PC Card (PCMCIA) icon in Control Panel.



Installs a default Windows driver that will work with your hardware. This option is only available if a Windows 
driver exists that works with your hardware. 
Click this option if it is available and you don't have a disk provided by your hardware manufacturer, or if you 
know the disk you have is out-of-date.



Installs a driver from a disk provided by your hardware manufacturer. Click this option if you have a disk that 
came with your hardware.
If you click this option and see a message that there is nothing on the disk to list, it may be that the installation 
files on the disk provided by your manufacturer are not compatible with this version of Windows. In this case, 
choose not to install a driver, and install the driver by using the installation program on the disk.



Does not install a driver.
Click this option if you want to install a driver for your hardware later, or if the installation files on the disk 
provided by your manufacturer are not compatible with this version of Windows. If you choose this option, 
Windows will not prompt you again for a driver. You can install a driver later by using Device Manager.



Displays a list of devices so you can choose a similar device and install its driver. (For example, you may be able 
to install a standard driver for your type of hardware, or you can choose a similar type of device from the list and
see if its driver will work.)
This option is not recommended if any other options are available.



Installing a driver for your new hardware

Windows found new hardware on your computer and needs to install the software (driver) that will enable it to 
work properly.
For information about an option in this dialog box, click one of the following buttons:
            Windows default driver  
            Driver from disk provided by hardware manufacturer  
            Do not install a driver (Windows will not prompt you again.)  
            Select from a list of alternate drivers  



System resources are low. Some programs may not run.

Windows has a limited number of system resources available. When you have many programs open, or you open
a program that uses many system resources, Windows may run more slowly and some programs may not run 
properly.
Quit some programs to free up system resources, or restart your computer.



Suggestion: You may want to install more RAM.

You have less than 8 megabytes of random-access memory (RAM) installed on your computer, or you loaded a 
large program before starting Windows. 
Windows will run without problems under these conditions. However, if you want to speed up Windows and your 
programs, you may want to install more RAM.



System memory is running very low.

Your system memory (memory below 1 MB) is low, which could cause your programs to run more slowly.
Check to see if you have any memory-resident programs running that you no longer use, or load some of your 
device drivers into the upper memory area.



Compatibility mode paging reduces overall system performance.

Windows was unable to identify a real-mode driver or memory-resident program loaded in your Config.sys or 
Autoexec.bat file. You will see another message that lists the name of the driver or program causing the problem.
Because Windows could not identify the driver or program, it has switched to MS-DOS compatibility mode to 
ensure the program will run. However, this slows down overall performance. To improve performance, remove 
the program or driver causing the problem, or contact its manufacturer for an updated version.



Performance may be improved by enabling virtual memory.

Windows is able to use hard-disk space on your computer as extra memory. This is called virtual memory. This 
feature is currently disabled on your computer.

Click here    
 for instructions on enabling virtual memory.



PC card (PCMCIA) devices are not using 32-bit support.

Windows PC card (PCMCIA) 32-bit support enables you to insert and remove PC cards while the computer is 
running. It also enables the use of Plug and Play drivers for PC cards.
If you only have one PC card device, you may not need this support. If you use more than one PC card device, 
you may want to enable 32-bit support.

Click here    
    to enable 32-bit PC card support.



Drive X is using real mode compression software.

The software you are using to compress your disk is real-mode software, which means Windows will access your 
disks more slowly than when using 32-bit software. 
To speed up the access to your compressed drives, use DriveSpace or other 32-bit compression software.



[Filename] in CONFIG.SYS forces MS-DOS compatibility mode.

Windows was unable to identify the specified real-mode driver which was loaded in your Config.sys file.
If you no longer need this driver, remove it from your Config.sys file. Otherwise, contact the manufacturer of this 
driver to see if a Windows (protected-mode) driver is available. Windows will not perform optimally until you 
have done one of these things.



[Filename] in AUTOEXEC.BAT forces MS-DOS compatibility mode.

Windows was unable to identify the specified memory-resident program which was loaded in your Autoexec.bat 
file.
If you no longer need this program, remove it from your Autoexec.bat file. Otherwise, contact the manufacturer 
of this program to see if an updated version is available. Windows will not perform optimally while this program 
is loaded.



MS-DOS compatibility mode file system: POSSIBLE VIRUS

The master boot record has been modified by some program. This can be the result of installing disk-manager 
software used to add large hard-disk drives to older computers, or encryption or other security software. It can 
also be caused by a virus on your computer. If you do not have disk-management or security software installed, 
you should scan you computer for viruses.
Warning    Viruses can cause data loss. Check all the disks on your computer immediately for a virus by using 
any virus-checking software.



Drive X: using MS-DOS compatibility mode file system

This problem often occurs on more than one drive. Usually it is caused by a driver in Config.sys that Windows 
doesn't recognize, and is related to the problem "Compatibility mode paging reduces overall system 
performance." If you also see that problem, see the Help for that problem first.
If you only see this message on one drive, that drive is using an MS-DOS compatibility (real-mode) driver, which 
may slow down access to that drive. Contact your hardware manufacturer to see if an updated driver is available
for your drive. If not, the drive may work more slowly than is optimal, but you can still use it.



Displays a list of the types of devices to choose from.



Select the configuration from which you want to remove this device, or choose to remove the device from all 
configurations.



Removes the device from all configurations.



Windows was unable to find an information (.inf) file on the disk you specified. Click this button if you want to try 
again.



Windows was unable to find an information (.inf) file on the disk you specified. Click this button if you do not 
want to install a driver now. You will not be able to use this device until you install a driver for it.



Click this to restore the registry from a backup copy and restart your computer.



If one of the above areas is not optimal, a description of the performance problem appears here. For more 
information, click an item, and then click Details. If your computer is configured for optimal performance, a 
message appears instead of the problems box.



Select a problem in the box, and then click this button for more information on solving the problem.



Specifies the amount of physical memory (RAM) in your computer.



Specifies the percentage of free system resources. If this number drops too low, your computer may perform 
more slowly.



Specifies whether you are using a 32-bit or MS-DOS compatibility mode (real-mode) file system. Windows will 
perform best using a 32-bit file system.
A file system accesses and reads data off of your disk. Your disks will be slower if you are using MS-DOS 
compatibility mode.



Specifies whether virtual memory is enabled (using either 32-bit or MS-DOS compatibility mode) or disabled.
Virtual memory is hard-disk space that is used as extra memory. If virtual memory is enabled and is using MS-
DOS compatibility mode, it means the disk being used for virtual memory is using that mode. This is slower than 
if the disk is using 32-bit access.



Specifies whether you have installed any disk compression software on your computer. If you do have 
compression software, it is either 32-bit software, which is optimal, or MS-DOS compatibility mode (real-mode) 
compression software, which runs more slowly.



Specifies whether you have a PCMCIA socket enabled, and if so, whether you have enabled 32-bit support. 
Windows PC card (PCMCIA) 32-bit support enables you to insert and remove PC cards while your computer is 
running. It also enables the use of Plug and Play drivers for PC cards.
If this line specifies that you have no socket installed and your computer has a PCMCIA socket, double-click the 
Add New Hardware icon in Control Panel to install it.



Shows whether your numeric data processor is Intel Pentium floating-point hardware that contains the floating-
point division accuracy error.



To always use your numeric data processor, click the first option. This option is recommended if your processor 
doesn't have the floating-point division accuracy error, or if your processor has the error but you want to use it 
anyway.
If your processor did not pass the diagnostics (and it has the floating-point division accuracy error) and you do 
not want to use this processor, click the second option. If you later install a fix for your processor, your numeric 
data processor will work properly again.
If you do not want to use a processor at all, click the third option. If you later want to use the processor, you 
must change this setting before it will work.



Check this box to enable power management support. If this box is empty, all Windows power management 
features will be disabled.



Check this box to force Advanced Power Management compatibility with Windows version 3.1.



Check this box to disable detection of the Intel SL power management support at startup. Check this box only if 
your computer stops responding when this box isn't checked.



Check this box to disable power status polling. Check this box only if your keyboard or mouse stops responding 
while you are working in an MS-DOS window.



Click this to adjust how Windows uses the graphics capabilities of your hardware. This is useful if you are having 
display-related problems.



Specifies the amount of acceleration you want for your graphics hardware. Full acceleration is the fastest and is 
recommended for most computers. If your computer is having problems and you suspect graphics acceleration 
to be the cause, use the highest setting at which you don't have problems.



Provides a place for you to type parameters that will be passed to your SCSI driver when it starts.



To display the percentage of free system resources
Click here    

    to display Performance information.



To reserve disk space for extra memory
1 Click here        to display Performance information.

2 Click Virtual Memory.
3 Make sure the first option to let Windows manage your virtual memory settings is selected.

Tips
Whenever possible, it is best to let Windows manage your virtual memory. Windows chooses the default 

setting based on the amount of free hard-disk space. The swapfile then shrinks and grows dynamically based on 
actual memory usage.

If you need to specify a different disk or set limits on the minimum or maximum reserved space, click the 
second option. Then specify the new disk in the Hard Disk box or type values (in kilobytes) in the Minimum or 
Maximum boxes.



To set up new hardware

1 Click here        to start the Add New Hardware wizard.
2 Follow the instructions on your screen.

Tip
It is recommended that you let Windows detect your new hardware. Make sure you have connected your 

hardware or installed its components in your computer before running the wizard.

{button ,AL("WIN_SYS_DOWNLOAD_WDL")} Related Topics



To view or change resource settings for a hardware device

1 Click here        to display Device Manager.
2 Click the plus sign next to the hardware device type.
3 Double-click the hardware.
4 Click the Resources tab.

If your device does not have a Resources tab, either you cannot change its resources or it isn't using any 
resource settings.

5 Double-click the resource you want to change.

Tips
You cannot change resource settings while the Use Automatic Settings box in the Resources tab is checked.
In some cases, you may see a Set Configuration Manually button on the Resources tab. You may have to 

click this button before you can change resource settings.
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To view which resources are in use by all devices

1 Click here        to display Device Manager.
2 Click Computer, and then click Properties.
3 To see which resource settings are in use, click a resource type at the top of the dialog box.



To view or change which resources are reserved system-wide

1 Click here        to display Device Manager.
2 Click Computer, and then click Properties.
3 Click the Reserve Resources tab.
4 To view reserved resources, click a resource type at the top of the dialog box.

To reserve resources, click Add.



To print information about your hardware

1 Click here        to display Device Manager.
2 To print all hardware information, click Computer, and then click Print.

To print information about selected hardware, click the hardware, and then click Print.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To enable or disable hardware in a hardware profile

1 Click here        to display Device Manager.
2 Click the plus sign next to the hardware type, and then double-click the hardware.
3 In the Device Usage area, click to place a check mark next to each hardware profile in which you want to 

enable the hardware, or clear the check box to disable the hardware for that hardware profile.

Tip
If you see a message prompting you to restart your computer, click Yes.

{button ,AL("A_ENABLE_DEVICE;A_DISABLE_DEVICE;A_CREATE_HP;A_FREE_RESOURCES")} Related Topics



To enable a hardware device

1 Click here        to display Device Manager.
2 Click the plus sign next to the hardware type, and then double-click the hardware.
3 In the Device Usage area, make sure there is a check mark in the box next to the current configuration.

Tip
If you see a message prompting you to restart your computer, click Yes.



To disable a hardware device

1 Click here        to display Device Manager.
2 Click the plus sign next to the hardware type, and then double-click the hardware.
3 In the Device Usage area, make sure the check box next to the current configuration is empty.

If there is more than one configuration listed in the Device Usage area, clear the check boxes next to each 
configuration in which you want to disable the device.

Tip
The device will be disabled, but the resource settings may not be freed unless you have Plug and Play 

hardware. To free the resource settings used by this device, click Related Topics below.

{button ,AL("A_FREE_RESOURCES")} Related Topics



To free resource settings used by disabled hardware

1 Click here        to display Device Manager.
2 In the hardware list, click the plus sign next to the type of hardware, and then click the device that is disabled.
3 Click Remove, and then click OK.
4 Click the Start button, and then click Shut Down. Click OK. When the message appears saying it is safe to do 

so, turn off and unplug your computer, and then remove the card for this hardware from the slot inside your 
computer.

Tip
If you have a Plug and Play device, resources are freed automatically when you disable or remove a 

device. To see if resources are free after the device is disabled but before removing the device, double-click the 
device in the hardware list in Device Manager, and then click the Resources tab.

{button ,AL("A_DISABLE_DEVICE")} Related Topics



To create a hardware profile

1 Click here        to display Hardware Profiles information.
2 Click the name of the hardware profile you want to base the new hardware profile on, and then click Copy.
3 Type a name for the hardware profile you want to create.

Tips
To change which hardware is enabled or disabled in your new hardware profile, click Related Topics below.
When you start Windows, you are prompted to select the hardware profile in which to start Windows. 

Windows loads only the device drivers for those hardware devices that are enabled in the profile you select.
If you have a hardware profile named the same as an MS-DOS multiple configuration menu item, the 

corresponding menu item will be run automatically when you start in that hardware profile.

{button ,AL("A_ENABLE_DISABLE")} Related Topics



To delete a hardware profile

1 Click here        to display Hardware Profiles information.
2 Click the name of the hardware profile you want to remove.
3 Click Delete.



To rename a hardware profile

1 Click here        to display Hardware Profiles information.
2 Click the name of the hardware profile you want to rename.
3 Click Rename.



To add or change a device driver for hardware

1 Click here        to display Device Manager.
2 Click the plus sign next to the type of hardware, and then double-click the hardware.
3 On the Driver tab, click Change Driver, and then follow the instructions on the screen.

Tip
Some devices don't have a Driver tab. In this case, you may be able to change the driver by double-

clicking the icon in Control Panel that is specific to that type of hardware. See your hardware documentation for 
more information.

{button ,AL("WIN_SYS_DOWNLOAD_WDL")} Related Topics



To view information about a device driver

1 Click here        to display Device Manager.
2 Click the plus sign next to the type of hardware, and then double-click the hardware.
3 Click the Driver tab, and then click the device driver you want information about.

Tip
Some devices don't have a Driver tab. In this case, you may be able to view information about the driver 

by double-clicking the icon in Control Panel that is specific to that type of hardware. See your hardware 
documentation for more information.

{button ,AL("A_CONTROL_PANEL")} Related Topics



To view information about your hardware

1 Click here        to display Device Manager.
2 Click the plus sign next to the type of hardware you want information about.
3 Double-click the icon for the hardware.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To optimize your hard disk or CD-ROM

1 Click here        to display Performance information.
2 Click File System.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To change the drive letter assignment for a disk or CD-ROM

1 Click here        to display Device Manager.
2 Click the plus sign next to the type of drive, and then double-click the disk or CD-ROM for which you want to 

change the letter.
3 Click Settings, and then change the drive letter assignment.

Tip
If the box to change the drive letter assignment is unavailable, you cannot change the drive letter.



To get additional drivers from the Windows Driver Library (WDL)

1 If you do not have a modem, obtain a disk that contains the driver by calling Microsoft Product Support 
Services. Then proceed to step 3.
If you have the CD-ROM version of Windows 95, you can obtain some drivers from the Drivers folder. If the 
driver you need is in that folder, proceed to step 3.
If you have a modem, connect to one of the online services listed, and then download the driver you want from
the Windows Driver Library (WDL).

The Microsoft Network (MSN): Look in the Windows 95 area.
Worldwide Web: (http://www.microsoft.com.)
Gopher: (gopher://gopher.microsoft.com)
FTP: (ftp://ftp.microsoft.com)
CompuServe: (GO MSL)
Microsoft Download Service (MSDL): Call the U.S. phone number (206) 936-6735. There is no connect-time 

charge to use the MSDL.
2 In My Computer or Windows Explorer, double-click the file you downloaded to extract the driver.
3 Click the Start button, point to Settings, and then click Control Panel.
4 Double-click the Add New Hardware icon, and then follow the on-screen instructions. At the prompt, "Do you 

want Windows to search for your new hardware?", click No.
5 Select the hardware type for the driver you are installing.
6 Click Have Disk, and then specify the location of the driver file.
7 Follow the instructions on your screen.

Note
Drivers are available at no charge; however, connect-time fees and long-distance telephone charges, if 

any, apply.



The Microsoft Windows Driver Library (WDL) contains a Hardware Compatibility List (HCL) as well as device 
drivers for many printers, and display, multimedia, network, and other adapters. New and updated device 
drivers are added to the WDL as they become available.



Click this to add a program to the Start menu or the Programs menu.



Click this to remove a program from the Start menu or the Programs menu.



Click this to start Windows Explorer.



Lists the menus and menu items that you can modify. To open a menu, click the plus (+) sign beside it. Some 
menus, such as Accessories, have submenus. If this is the case, continue clicking plus signs until the item you 
want to remove is visible. Click the menu item you want to remove, and then click Remove.



Deletes the selected item in the list above.



Removes the list of documents from the Documents menu.



Shows how the settings on this tab affect the way Windows displays the taskbar. This image changes as    you 
select different settings.



Ensures that the taskbar is always visible, even when you run a program in a full screen.



Reduces the taskbar to a thin line at the bottom of your screen after you use the Start menu or the taskbar. To 
redisplay the taskbar, point to the thin line. If you want the taskbar to be available even when you run a program
in a full screen, make sure both Always On Top and Auto Hide are checked.



Reduces the size of the menu that appears when you click the Start button.



Displays a digital clock on the taskbar. The clock displays the time as specified by your computer's internal clock.
You can point to the clock to display the date, and double-click the clock to adjust the time or date.



Provides a place for you to type all or part of the name of the file you are searching for.



Shows where Windows will search for the file you want to find. To specify a different location, click Browse.



Click this to specify where you want Windows to begin its search.



When this box is checked, Windows searches all the folders within your main folders.



Begins your search.



Ends your search.



Begins a new search. If you click this button, you lose the results of your previous search.



Displays the files Windows found. To sort the list of files, click the Name, In Folder, Size, Type, or Modified button.



Finds all the files that match the criteria you specified on other tabs, regardless of when the files were created or
modified.



Finds files that were created or modified during a specific time period. Windows will find files that match the 
criteria on this tab and the other tabs in this dialog box.



Searches for files that were created within the number of days you specify.



Searches for files that were created within the number of months you specify.



Searches for files that were created between the dates you specify.



Provides a place for you to specify the beginning of a range of dates. 



Provides a place for you to specify the end of a range of dates. 



Lists the types of files Windows can search for. If you don't know a file's name but do know its type, you may be 
able to find it by specifying only its type.



Provides a place for you to type some of the text a file contains. If you don't know a file's name, you may be able
to find the file by typing some of its contents.



Provides a place for you to specify a minimum or maximum file size. For example, if you select At Least in this 
box and 50 in the K box, Windows will search for all files that are 50K or larger.



Provides a place for you to specify the size of the file you're looking for.



Provides a place for you to type the location and filename of the program you want to run. If you are unsure of 
the program's location or filename, click Browse. You can also make a temporary network connection by typing 
the path to a shared computer in this box.



To start a program

1 Click the Start button, and then point to Programs.
2 If the program you want is not on the menu, point to the folder that contains the program.
3 Click the program.

Tips
After you start a program, a button appears on the taskbar. To switch from one running program to 

another, click its taskbar button.
If the program you want to start doesn't appear on the Programs menu or one of its submenus, point to 

Find on the Start menu, and then click Files Or Folders. Use the Find dialog box to locate the program file.

{button ,AL("A_CUST_START_MENU;WIN_TRAY_PROGRAM_MENU_DEF")} Related Topics



To open a document you've used recently

1 Click the Start button, and then point to Documents.
2 Click the document you want to open.

Tip
Some programs cannot add files to the Documents menu. If the document you want to open is not listed, 

click the Start button, and then point to Find. Click Files Or Folders, and then use the Find dialog box to locate the 
file.

{button ,AL("WIN_TRAY_CLEAR_DOC_MENU;A_FIND_FILE")} Related Topics



To clear the contents of the Documents menu

1 Click the Start button, and then point to Settings.
2 Click Taskbar, and then click the Start Menu Programs tab.
3 In the Documents Menu area, click Clear.



To change your computer's settings

1 Click the Start button, and then point to Settings.
2 Click Control Panel.
3 Double-click the icon that represents the settings you want to change.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.



To start a program each time Windows starts

1 Click the Start button, and then point to Settings.
2 Click Taskbar, and then click the Start Menu Programs tab.
3 Click Add, and then click Browse.
4 Locate the program you want to start, and then double-click it.
5 Click Next, and then double-click the StartUp folder.
6 Type the name that you want to see on the StartUp menu, and then click Finish.

If Windows prompts you to choose an icon, click one, and then click Finish.

{button ,AL("WIN_TRAY_PROGRAM_MENU_DEF")} Related Topics



To start a program in a minimized or maximized window

1 Use your right mouse button to click the Start button, and then click Open. 
2 Locate the program you want to start, and then click the program's icon.
3 Click the File menu, and then click Properties.
4 Click the Shortcut tab.
5 In the Run box, click Minimized or Maximized.

Tips
Starting a program in a minimized window is most useful for the items on your StartUp menu. In this case, 

the program will start every time your computer starts, and will appear as a button on the taskbar. To use that 
program, click its button.

You can configure any shortcut to start in a minimized or maximized window. For information about 
creating shortcuts, click Related Topics below.

{button ,AL("A_TRAY_START_PROG_AUTO;A_CUST_START_MENU;A_WIN_FCAB_CREATE_NEW_SHORTCUT;A-LINK")}
Related Topics



To add a program to the Start or Programs menu

1 Click the Start button, and then point to Settings.
2 Click Taskbar, and then click the Start Menu Programs tab.
3 Click Add, and then click Browse.
4 Locate the program you want to add, and then double-click it.
5 Click Next, and then double-click the menu on which you want the program to appear.
6 Type the name that you want to see on the menu, and then click Finish.

If Windows prompts you to choose an icon, click one, and then click Finish.

Tip
You can also add a program to the top of the Start menu by dragging the program's icon onto the Start 

button.

{button ,AL("A_CUST_TASK_BAR;WIN_TRAY_PROGRAM_MENU_DEF")} Related Topics



To remove a program from the Start or Programs menu

1 Click the Start button, and then point to Settings.
2 Click Taskbar, and then click the Start Menu Programs tab.
3 Click Remove, and then locate the program you want to remove.
4 Click the program, and then click Remove. Although this deletes the shortcut from the Start menu, the original 

program remains on your computer.

Tip
Each folder represents a menu or submenu. To open a folder, double-click it.



To customize the taskbar or Start menu

1 Click the Start button, and then point to Settings.
2 Click Taskbar.
3 On the Taskbar Options or Start Menu Programs tab, change settings as needed. 

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.

{button ,AL("A_CUST_START_MENU;WIN_TRAY_REMOVE_PROGRAM")} Related Topics



To find a file or folder
1 Click the Start button, and then point to Find.
2 Click Files Or Folders.
3 In the Named box, type all or part of the file's name.

If you do not know the name of a file or want to refine the search, click the Date Modified or Advanced tabs. 
If you want to specify where Windows should begin its search, click Browse. 

4 Click Find Now.

Tips
For Help on an item, click the Help menu, and then click the What's This? command. Then click the item 

you want information about.
If you type upper- and lowercase letters in the Containing Text box on the Advanced tab, and you want the 

search to be case-sensitive, click the Options menu and make sure the Case Sensitive box is checked.

{button ,AL("WIN_TRAY_SAVE_SEARCH_RESULTS")} Related Topics



To save the results of a search for files or folders

1 Conduct a search for files.
For information about finding files, click Related Topics below.

2 If you want to save the results of a search along with the search criteria, click Options, and then click Save 
Results. 
If you want to save only the search criteria, make sure the Save Results box is clear.

3 Click the File menu, and then click Save Search.
An icon representing the search results or search criteria appears on your desktop. 

Tip
After you double-click the search results icon, you can reinitiate the search or update the search results by 

clicking Find Now.

{button ,AL("A_FIND_FILE")} Related Topics



To move the taskbar
Drag the taskbar to a different location.



To switch between running programs
Click the program's button on the taskbar.



To start a program by using the Run command

1 Click the Start button, and then click Run.
2 In the Open box, type the location and name of the program you want to start.

Tips
If you don't remember the location or name of the program file, click Browse.
To select a program you started recently, click the down arrow in the Open box, click a program in the list, 

and then click OK.
You can open a file or folder or connect to a shared computer by typing its path in the Open box.

{button ,AL("WIN_TRAY_PATH_DEF")} Related Topics



To shut down your computer
Click the Start button, click Shut Down, and then click Shut Down The Computer. 

Important
Do not turn off your computer until the "You can now safely turn off your computer" message appears.



To restart your computer
Click the Start button, click Shut Down, and then click Restart The Computer.



To restart your computer in MS-DOS mode
Click the Start button, click Shut Down, and then click Restart The Computer In MS-DOS Mode.

Note
MS-DOS mode is typically used to run programs, such as MS-DOS games, that will not run under Windows.



To log off your computer so someone else can use it
Click the Start button, click Shut Down, and then click Close All Programs And Log On As A Different User.



To display all open windows

1 Using your right mouse button, click a blank area on the taskbar.
2 Click Cascade, Tile Horizontally, or Tile Vertically.

Tips
Make sure all the windows you want to display are open. Closed or minimized windows cannot be 

displayed.
To restore your windows to their original state, use your right mouse button to click a blank area on the 

taskbar, and then click Undo Cascade or Undo Tile.



To minimize all open windows

1 Using your right mouse button, click a blank area on the taskbar.
2 Click Minimize All Windows.

Notes
Windows does not minimize open dialog boxes.
To open a minimized window, click its button on the taskbar.
To restore your windows to their original state, use your right mouse button to click a blank area on the 

taskbar, and then click Undo Minimize All.



To turn on your portable computer's suspend mode

1 If you are using files over a network, save them. Your network connections may be lost when you suspend your
computer.

2 Click the Start button, and then click Suspend. 
For information about restoring your computer to its original running state, consult the documentation that 
came with the computer. 

Tip
Use Suspend if you are going to leave your computer briefly but want to conserve as much energy as 

possible while you are away. After you return your computer to its original running state, you will be able to pick up 
exactly where you left off.

{button ,AL("energy saving features")} Related Topics



To hide the taskbar

1 Click the Start button, and then point to Settings.
2 Click Taskbar.
3 Make sure the Auto Hide box is checked.

Tips
To redisplay the taskbar, point to the area of your screen where the taskbar is located. For example, if your 

taskbar is located at the bottom of your screen, point to that area.
Instead of using the Auto Hide setting, you can temporarily hide the taskbar by pointing to the top of it and

dragging downward when a two-headed arrow appears. To redisplay the taskbar, drag the visible edge upward.



To close a minimized window

1 Using your right mouse button, click the window's button on the taskbar.
2 Click Close.



To add a new submenu to the Programs menu
1 Using your right mouse button, click the Start button, and then click Open.
2 Double-click the Programs folder.
3 Click the File menu, and then point to New.
4 Click Folder, and then type the name that you want to use for the submenu.
5 Press ENTER, and then double-click the folder you just created. 
6 On the File menu, point to New, and then click Shortcut.
7 Use the Create Shortcut wizard to add items to the submenu. 

{button ,AL("WIN_TRAY_PROGRAM_MENU_DEF")} Related Topics



How programs get on the Start and Programs menus

When you click the Start button and then point to Programs, the Programs menu appears. The submenus 
(folders) and programs on the Programs menu come from several places:

If you upgraded from a previous version of Windows, your old program groups appear as folders on the 
Programs menu.

During Setup, Windows adds several programs and folders. Each folder contains a group of programs.
Windows also adds a StartUp folder during setup. Programs on the StartUp menu start automatically every 

time you start Windows.
The setup programs for any software you install may add folders to the Programs menu.
You can modify the contents of the Programs menu. For more information, click Related Topics below.

{button ,AL("A_TRAY_START_PROG_AUTO;A_CUST_START_MENU;TRAY_GROUP_PROGRAMS;WIN_TRAY_REMOVE_PR
OGRAM")} Related Topics



To specify a path

A path is a more direct way to describe where a file, such as a document or program, is located on your 
computer or network. A path includes the drive, folders, and subfolders that contain a file, in addition to the file's
name. Generally, a filename ends with a 3-letter "extension" that indicates what type of file it is. For example, a 
filename ending in .exe is a program, and a filename ending in .txt is a text file.

To specify a path
1 Type the drive letter, followed by a colon (:) and backslash (\). 
2 Type the names of the folders and subfolders that contain the file. A backslash should precede each folder or 

subfolder name. 
3 Type the name of the file. A backslash should precede the filename.

If you use filenames that contain spaces or exceed eight characters in length, enclose the path in quotation 
marks. 

Examples
To specify the location of Disk Defragmenter, which is located on drive C in the Windows folder, type:

c:\windows\defrag.exe
To specify the location of a document named Party List.doc, which is located in the Holiday subfolder of the

Social Events folder on drive C, type:
"c:\social events\holiday\party list.doc"

To specify the location of a bitmap named Canyon, which is located in a shared folder named Scenic on a 
computer named Pictures, type:

\\pictures\scenic\canyon.bmp
Or map the shared folder to a drive (for example, drive D), and then type:
d:\canyon.bmp

{button ,AL("WIN_FCAB_SHOW_FILE_EXTENSIONS;TIP_PATHNAME")} Related Topics



Using the Shut Down Windows dialog box

For information about the settings in the Shut Down Windows dialog box, click one of the following buttons:
            Shut Down The Computer  
            Restart The Computer   
            Restart The Computer In MS-DOS Mode  
            Close All Programs And Log On As A Different User  

To redisplay the Shut Down Windows dialog box, click the Start button, and then click Shut Down.



To reorganize the items on the Programs menu

1 Use your right mouse button to click the Start button, and then click Explore.
2 In the left pane of the window, locate the Programs folder, and then click it.
3 On the File menu, point to New, and then click Folder.
4 Type a name for the folder. This name will appear on the Programs menu.

If there are currently so many items on the Programs menu that you find it difficult to use, create a general 
category that many of your programs fit into.

5 Click the plus (+) sign beside the Programs folder. If necessary, scroll until you see the folder you named in 
step 4.

6 In the left pane, click a folder whose contents you want to move into the new folder. The folder's contents are 
displayed in the right pane.

7 Drag the icons from the right pane into the new folder or any other folder in the left pane.
8 To delete the folder you just emptied, click it, click the File menu, and then click Delete.



The taskbar is the bar on your desktop that has the Start button on it. Buttons representing running programs 
appear on this bar.



Saves any Windows settings that you changed and writes any information that is currently stored in memory to 
your hard disk. This prepares your computer to be turned off.



Saves any Windows settings that you changed, writes any information that is currently stored in memory to your 
hard disk, and then restarts your computer.



Closes all your programs and disconnects your computer from the network. This prepares your computer to be 
used by someone else.



Starts your computer in MS-DOS mode. MS-DOS mode is typically used to run programs, such as MS-DOS games,
that will not run under Windows. When you are finished using MS-DOS mode, type exit or win to return to 
Windows.



Specifies the type of modem you have selected.



Specifies which port on your computer your modem is connected to.
If your modem uses a different port, change this setting by clicking the correct one.



Displays the port on your computer that your modem is connected to.



If your modem supports it, adjusts the speaker volume for your modem.



If your modem supports it, lists the speeds that the modem can use to connect. Click the maximum speed your 
modem can use.



If your modem supports it, prevents the modem from trying to connect at lower speeds if it is unable to connect 
at the higher speed you specified. 
This is useful if you prefer to try again later rather than use a slower connection.



If your modem supports it, provides space for you to specify the data bits, parity, and stop bits settings for 
connections you make using this modem and port.



If your modem supports it, provides a space for you to specify dialing and connection options for connections you
make using this modem and port.



If your modem supports it, waits for a dial tone before dialing. 
Clear this check box if your modem is not recognizing the dial tone in your current location, or if you have to 
manually dial your phone.



If your modem supports it, cancels the call if the call is not completed within the specified number of seconds.



Hangs up the phone if there is no activity for more than the specified number of minutes.



Click this to specify port settings for ports from other manufacturers. For more information about the available 
settings, see your port hardware documentation.



Click this to specify types of error and flow control for the connection and to directly specify other modem 
settings. 
These settings force error checking, but they may make your connection less reliable.



If your modem supports it, enables you to set up or remove error control. Removing error control may make your
connection less reliable.



If your modem supports it, forces a reliable connection.



If your modem supports it, compresses data, which increases the speed of communication.



If your modem supports it, uses cellular protocol, which you need to use with a cellular phone.



Specifies whether XON/XOFF or RTS/CTS protocol is used to control the flow of data between the modem and 
your computer. 
Use XON/XOFF if RTS/CTS isn't supported, or if your cable does not support hardware flow control.
Note  XON/XOFF may not work with certain programs.



Enables you to switch the modulation type so that it is compatible with the signals from the modem of the 
computer you are trying to connect to. Both computers must be using the same type of modulation to exchange 
information successfully.
Most modems fall into the standard category, but if you are having trouble connecting, try switching to a 
nonstandard modulation type.



Sets the modulation settings used in 300- and 1200-baud connections to default values commonly used in 
Europe.



Sets the modulation settings used in 300- and 1200-baud connections to default values commonly used in the 
United States.



Provides a space for you to type additional modem initialization settings. These are sent to your modem after all 
the other settings are sent, so they override previous settings.
For information about other available modem settings, see your modem manual.



Creates a log file named Modemlog.txt in the folder where Windows is installed. 
This is useful for monitoring calls and for troubleshooting.



Click this to be able to type commands directly to your modem before you dial.
For a list of available commands, see your modem manual.



Click this to be able to type commands directly to your modem after you dial.
For a list of available commands, see your modem manual.



Prompts you to dial your phone yourself rather than having the computer dial it. 
This is useful in locations such as hotels when you need to talk to the operator.
When you dial the phone manually, wait until you hear the computer answer, and then click Connect and hang 
up the phone.



Specifies how many seconds to wait for a credit card tone before continuing dialing.



Displays the status window that shows the progress of your connection.



Provides a space for you to type any modem commands.



Sets up the phone so you can talk.



Hangs up the phone.



Enables you to use different settings for each of your drives.



Uses the settings on this tab for all your drives.



If this box is checked, Windows removes items from your disk as soon as you delete them. If this box is not 
checked, the items you delete are stored in the Recycle Bin. They are not removed from your hard disk until you 
empty the Recycle Bin.



Specifies the maximum size of the Recycle Bin. You can conserve disk space by reducing the Recycle Bin's size.



Shows the capacity of your drive.



Shows the amount of space on your drive that is reserved for deleted files. To change this setting, drag the slider.



If this box is checked, Windows displays a confirmation dialog box when you delete files. This dialog box can 
prevent you from deleting files in error. If the Do Not Move Files To The Recycle Bin check box is checked, you 
cannot change this setting.



To retrieve deleted files or shortcuts

1 Double-click the Recycle Bin icon.
2 Click the file or shortcut you want to retrieve. 

To retrieve several items, hold down the CTRL key while clicking each one.
3 On the File menu, click Restore.

Tip
If you delete a folder, only the files within that folder appear in the Recycle Bin. If you restore a file that 

was originally located in a deleted folder, Windows recreates the folder, and then restores the file to it.



To empty the Recycle Bin

1 Double-click the Recycle Bin icon.
2 On the File menu, click Empty Recycle Bin.

Tip
If you want to remove only some of the items in the Recycle Bin, hold down the CTRL key while clicking 

each item. Click the File menu, and then click Delete.



To change the capacity of the Recycle Bin

1 Using your right mouse button, click the Recycle Bin icon, and then click Properties.
2 If you want to use different settings for different drives, click Configure Drives Independently, and then click 

the tab of the drive whose settings you want to change. 
If you want to use the same settings for all drives, click Use One Setting For All Drives.

3 Drag the slider to increase or decrease the amount of disk space that is reserved for storing deleted files.



To permanently remove files when you delete them

1 Using your right mouse button, click the Recycle Bin icon, and then click Properties.
2 If you want to use different settings for different drives, click Configure Drives Independently, and then click 

the tab of the drive whose settings you want to change. 
If you want to use the same settings for all drives, click Use One Setting For All Drives.

3 Make sure the Do Not Move Files To The Recycle Bin box is checked. Note, however, that if this box is checked, 
you will be unable to recover any files you delete.



To prevent delete confirmation messages from appearing

1 Using your right mouse button, click the Recycle Bin icon, and then click Properties.
2 Make sure the Display Delete Confirmation Dialog check box is clear.

Note
This setting is unavailable if the Do Not Move Files To The Recycle Bin box is checked. 



Windows stores deleted files in the Recycle Bin, which is located on the desktop. You can use the Recycle Bin to 
retrieve files you deleted in error, or empty the Recycle Bin to create more disk space.
If you cannot see the Recycle Bin, use your right mouse button to click a blank area of the taskbar, and then click
Minimize All Windows.



Using Help
If you don't know how to do something, you can look it up in Help. Just click the Start button, and then click

Help.
You can get Help on each item in a dialog box by clicking the question-mark button in the title bar and then

clicking the item.
To learn what any toolbar button is for, you can rest your mouse pointer on the button for a few seconds. 

Windows displays the button name.



Getting your work done
To start a program, you just click the Start button, point to the folder your program is in, and then click the 

program.
You can minimize all open windows at once; just use your right mouse button to click an empty area on the

taskbar, and then click Minimize All Windows.
To select more than one file or folder, hold down the CTRL key while you click each item.
Deleted files and folders are saved in the Recycle Bin until you empty it.
To open a document quickly, you can double-click its icon.
The Shut Down command on the Start menu enables you to safely shut down your computer.
You can minimize neck strain by positioning your monitor at eye level.
When you type, you should keep your wrists elevated or use a wristpad to minimize strain.
Even if you don't shut down your computer at night, you can turn off your monitor to save power.



Printing
To print a document quickly, you can drag its icon onto a printer icon.
You can solve printer problems by using the Print Troubleshooter in Help.
You can put shortcuts to your printers on your desktop.
When you print a document, a printer icon appears on the taskbar. Double-click it to see a list of 

documents waiting to print.



Personalizing Windows
You can move the taskbar to any edge of your screen by dragging it with your mouse.
To set your computer's clock, you can double-click the clock on the taskbar.
To change the Windows color scheme, use your right mouse button to click the desktop; then click 

Properties.
To change your screen saver, use your right mouse button to click the desktop; then click Properties.
You can have programs start when you start Windows by dragging their icons to your StartUp folder.
To change your desktop background, click it by using your right mouse button; then click Properties.
You can switch mouse buttons if you are left-handed. Just double-click the Mouse icon in Control Panel.
The mouse pointer is easier to see on laptop computers if you turn on pointer trails. Just double-click the 

Mouse icon in Control Panel, and then click the Motion tab.



Exploring and maintaining your computer
To see how much disk space is free, use your right mouse button to click the icon for the drive in My 

Computer; then click Properties.
You can use Defragmenter, in the System Tools folder, to speed up your computer's performance.
To free disk space, try emptying the Recycle Bin. 
You can use ScanDisk, in the System Tools folder, to check your hard disk for errors.
You can use Windows Explorer to see all the files on your computer. 
When a folder is open, you can press BACKSPACE to open the folder one level higher.
When you display files in Details view, you can sort them by clicking the column headings.
You can solve memory problems on your computer by using the Memory Troubleshooter in Help.



Becoming an expert
You can use your right mouse button to drag files. Try it and see what happens!
You can use long filenames when you save documents. You can even use spaces!
You can use your right mouse button to click anywhere and see a menu of available commands.
To draw a selection box around a group of files, you can click at a corner of the group, and then drag to 

form the box.
The underlined letters in menus are shortcuts. Press ALT plus the underlined letter to choose the item.
You can solve hardware problems by using the Hardware Conflict Troubleshooter in Help.
You can use the Run command on the Start menu to open shared folders on other computers.
To add a program to your Start menu, you can drag the program's icon onto the Start button.
You can drag a file's icon into a document, or even drag a shortcut icon into a document or mail message.
You can start a Windows-based program from an MS-DOS window.
You can copy and paste text between MS-DOS and Windows.
You can set Windows Explorer to show or hide three-letter MS-DOS filename extensions.



To view the Welcome screen again
Click 

    to open the Welcome screen. 

Tip
Click Next Tip to cycle through the entire list of tips.



A new look and feel
The look and feel of Windows has been improved to make it easier and faster for you to get your work done.
    Start button and taskbar
    My Computer
    Windows Explorer
    Network Neighborhood
    Long filenames
    The desktop
    Properties
    Folders
    Shortcut menus
    Close, Minimize, and 

Maximize buttons
    What's This?

Faster ways to get your work done
Windows includes more ways to help you get your work done faster.
    Find command
    Run command
    Documents command 
    Open With command
    AutoPlay for CDs
    Quick View 
    Add New Hardware wizard
    Faster printing
    Improved multitasking and 

performance

Find command

You can now locate files and folders easily by using the Find command on the Start menu. The tabs in the Find 
dialog box make it easier to fully define your search criteria, which you can then save instead of having to re-
create common searches.
You can also use the Find command to quickly find other computers on your network.



AutoPlay for CDs

Just insert your audio CD into the CD-ROM drive, and it will start playing.



Open With command

When you double-click a file and Windows doesn't know which program to use to open it, the Open With dialog 
box appears and you can specify the program you want to use.



Quick View

You can now view documents that were created with popular Windows-based programs without starting the 
program. Just click a document you would like to view in My Computer or Windows Explorer, and then click Quick
View on the File menu.
If Quick View is not available, either your program doesn't support it, or it is not installed on your computer. Look
up "installing, Windows components" in the Help Index.



Run command

You can use the Run command on the Start menu to start any program or to open any folder, whether it is on 
your computer or on another computer on the network.
The commands you run are saved, so you can easily run a command again by selecting it from the list in the Run
dialog box.



Documents command
You can quickly open a document you've worked on recently by using the Documents command on the Start 
menu.



Add New Hardware wizard

The Add New Hardware icon in Control Panel opens a "wizard" that helps you install new hardware devices on 
your computer. Windows uses Plug and Play technology to make this process easier, even for devices that do not
support Plug and Play.



Faster printing

Windows prints your documents "in the background," so you can get back to work quickly after you send your 
document to the printer.
Windows also has a new Add Printer wizard that makes setting up new printers fast and easy. Click the Start 
menu, point to Settings, and then click Printers.



Improved multitasking and performance

You will notice big performance improvements throughout Windows. Smoother multitasking lets you use many 
programs at once; if you are doing something in a program and see an hourglass cursor, just move your mouse 
to a different window, and you'll be able to work in another program!
Also, Windows checks to make sure that it is running at the optimal performance level for your computer.



More ways to customize Windows
There are many new ways to customize Windows.
    Shortcuts on the desktop
    Display properties
    Fonts folder
    User profiles
    Accessibility options for 

people with disabilities
    System properties

Display properties

You can customize almost any screen element in Windows by using the right mouse button to click the desktop, 
and then clicking Properties.
In the Display Properties dialog box, you can change the background color or add a bitmap to your desktop; you 
can change the font used for your menus, title bars, and other elements; and you can choose different screen 
savers.



Fonts folder

Windows has a Fonts folder that you can use to easily install or remove fonts. You can open the Fonts folder from 
Control Panel.



Accessibility options for people with disabilities

Windows provides several accessibility features to make computers more accessible to people with disabilities. 
For example:

For people who have restricted movement, Windows can use the keyboard for the mouse pointer, and you 
can adjust your keyboard settings.

For people with low vision, bigger fonts and high-contrast color schemes are available.
For people who are deaf or hard-of-hearing, Windows can visually indicate when the computer makes a 

sound.
Although these features are designed for people with disabilities, they are useful to everyone. To see these 
features, double-click the Accessibility Options icon in Control Panel.
If this component is not on your computer, look up "installing, accessibility components" in the Help Index.



System properties

It's easy to modify your system configuration settings by using the new System Properties dialog box. To display 
system properties, double-click the System icon in Control Panel.
From this dialog box, you can view or modify your computer's hardware settings.



New programs and accessories
Windows includes many useful programs and accessories.
    Microsoft Exchange
    Microsoft Fax
    The Microsoft Network
    WordPad
    Paint
    Phone Dialer
    File Transfer
    HyperTerminal
    CD Player
    Volume Control
    MS-DOS Prompt
    Disk Defragmenter
    ScanDisk
    DriveSpace
    Backup

Microsoft Exchange

Microsoft Exchange provides a universal inbox that you can use to send and receive electronic mail (e-mail). In 
addition, you can use the inbox to organize, access, and share all types of information, including faxes and items
from online services.
To start Microsoft Exchange, double-click the Inbox icon on your desktop.
If the Inbox icon is not on your desktop, look up "installing, Windows components" in the Help Index.



Microsoft Fax

Windows comes with a fax program you can use to send and receive faxes directly within Windows.
If this component is not on your computer, look up "installing, Windows components" in the Help Index.



The Microsoft Network

With Windows 95, you can access a new online service, The Microsoft Network. You can exchange messages with
people around the world; read the latest news, sports, weather, and financial information; find answers to your 
technical questions; download from thousands of useful programs; connect to the Internet, and more!
To start The Microsoft Network, double-click The Microsoft Network icon on your desktop.



WordPad

Windows includes a new text editor that you can use to create and modify documents. WordPad has a toolbar for
quick access to common tasks and a full range of fonts for you to select from.
To find WordPad, click the Start button, point to Programs, and then point to Accessories.
If WordPad is not on your computer, look up "installing, Windows components" in the Help Index.



Paint

You can create, modify, or view pictures by using Paint, a program that replaces Paintbrush from Windows 
version 3.1. Paint contains many new features, including a movable toolbox and color box, and print preview.
To find Paint, click the Start button, point to Programs, and then point to Accessories.
If Paint is not on your computer, look up "installing, Windows components" in the Help Index.



Disk Defragmenter

You can use Disk Defragmenter to optimize your disk so that the files and unused space are arranged efficiently. 
This makes your programs run faster and your files open more quickly.
To find Disk Defragmenter, click the Start button, point to Programs, point to Accessories, and then point to 
System Tools.
If Disk Defragmenter is not on your computer, look up "installing, Windows components" in the Help Index.



HyperTerminal

HyperTerminal is a new program you can use to easily connect to a remote computer, a bulletin board, or an 
online service. It replaces Terminal from Windows version 3.1.
To find HyperTerminal, click the Start button, point to Programs, and then point to Accessories.
If HyperTerminal is not on your computer, look up "installing, Windows components" in the Help Index.



MS-DOS Prompt

MS-DOS Prompt within Windows has been enhanced. You can start Windows-based programs from the command 
prompt, and you can close the MS-DOS window by clicking the  (Close) button on the title bar.

You no longer need to use PIF Editor to specify settings for your MS-DOS-based programs. Instead, you just modify 
the properties of the program.
To find MS-DOS Prompt, click the Start button, and then point to Programs.



Phone Dialer

You can use Phone Dialer to place telephone calls from your computer by using a modem or another Windows 
telephony device. You can store a list of phone numbers you use frequently, and dial the number quickly from 
your computer.
To find Phone Dialer, click the Start button, point to Programs, and then point to Accessories.
If Phone Dialer is not on your computer, look up "installing, Windows components" in the Help Index.



File Transfer

This program enables you to send a file to someone while you are talking to them on the phone. File Transfer 
requires a modem that supports VoiceView.
To find File Transfer, click the Start button, point to Programs, and then point to Accessories.
If this component is not on your computer, look up "installing, Windows components" in the Help Index.



Backup

Windows comes with a program you can use to back up the files on your hard disk to a floppy disk, tape drive, or
another computer on your network.
To find Backup, click the Start button, point to Programs, point to Accessories, and then point to System Tools.
If Backup is not on your computer, look up "installing, Windows components" in the Help Index.



DriveSpace

If you need more room on your hard disk, you can use DriveSpace to compress the disk and free up more space.
To find DriveSpace, click the Start button, point to Programs, point to Accessories, and then point to System 
Tools.
If DriveSpace is not on your computer, look up "installing, Windows components" in the Help Index.



ScanDisk

You can use ScanDisk to check your hard disk for errors and to fix problems that are found.
To find ScanDisk, click the Start button, point to Programs, point to Accessories, and then point to System Tools.
If ScanDisk is not on your computer, look up "installing, Windows components" in the Help Index.



Volume Control

If you have a sound card in your computer, you can use Volume Control to increase or decrease the sound 
coming from your computer's speakers, microphone, or CD-ROM drive.
To find Volume Control, click the Start button, point to Programs, point to Accessories, and then point to 
Multimedia.
If Volume Control is not on your computer, look up "installing, Windows components" in the Help Index.



CD Player

With CD Player, you can play an audio CD in the CD-ROM drive on your computer.
To find CD Player, click the Start button, point to Programs, point to Accessories, and then point to Multimedia.
If CD Player is not on your computer, look up "installing, Windows components" in the Help Index.



Support for portable computers
Windows makes it easy to use your portable computer at home or on the road.
    Power management
    Briefcase
    Direct Cable Connection
    Deferred printing
    Docking detection

Docking detection

Windows can detect whether your portable computer is docked or undocked. If you have different configuration 
settings for the docked and undocked states, Windows uses the correct settings.



Briefcase
Briefcase helps you keep files up-to-date when you use two computers, such as your office computer and your 
portable computer.
If Briefcase is not on your desktop, look up "installing, Windows components" in the Help Index.



Power management

For portable computers, Windows provides a battery indicator on the taskbar and a Suspend command on the 
Start menu that you can use to save power without turning off your computer. In addition, for certain Energy-
Star-compliant computers, Windows provides some power-saving options for your monitor.
If you are using a portable computer, you can set your power-management preferences by double-clicking the 
Power icon in Control Panel .



Dial-Up Networking

If you have a modem, you can use Dial-Up Networking to dial in to another computer that is set up as a server 
and has a modem, and then gain access to shared resources on that computer and the network it is connected 
to.
To use Dial-Up Networking, double-click the My Computer icon, and then double-click Dial-Up Networking.
If this component is not on your computer, look up "installing, Windows components" in the Help Index.



Direct Cable Connection

You can easily connect your portable computer to another computer by using a serial or high-speed parallel 
cable. Your portable computer will then have access to shared resources on the main computer and to any 
network the computer is connected to.
To set up Direct Cable Connection, click the Start button, point to Programs, and then point to Accessories.
If this component is not on your computer, look up "installing, Windows components" in the Help Index.



Deferred printing

If your printer is temporarily disconnected from your computer, you can still send your documents to the printer. 
Deferred printing saves the print information until your printer is reconnected.
Deferred printing happens automatically for portable computers, such as laptops, that are not connected to their
printers. You can turn on this feature manually for portable computers or network printers by using the Work 
Offline command in the Printers folder. For a local printer, you can use the Pause Printing command.



Improved Networking
Using a network is easier than ever with Windows 95.
    Easier network browsing
    Easier sharing
    Easier network setup and 

configuration
    Dial-Up Networking
    Remote network 

administration

Easier network browsing

Double-click the Network Neighborhood icon to browse through and use the computers and printers on your 
network. You no longer need to connect to a network drive by mapping a drive letter.
You can also use Network Neighborhood to browse through computers on multiple networks.



Easier sharing

To share a folder or a printer, you can use your right mouse button to click the folder or printer, and then click 
Sharing on the menu.
When you share folders and printers, you can set up a password as the key to opening them, or you can create a
list of users that you want to have access to them.
If sharing is not enabled, you can turn it on by double-clicking the Network icon in Control Panel.



Easier network setup and configuration

Setting up a network is easier in Windows 95. Just double-click the Network icon in Control Panel.



User profiles

If more than one person uses the same computer, you can set up user profiles so that when one person logs on, 
their personal Windows settings are used. For example, you could have your own desktop colors, icons, and 
program groups appear when you log on to Windows, but if someone else logs on, their settings appear instead.
To set up user profiles, double-click the Passwords icon in Control Panel.



Remote network administration

If your computer is set up to allow remote administration, your system administrator can view the files on your 
computer and fix problems you may be having.



Start button and taskbar

At the bottom of your screen is the taskbar. It contains the Start button, which you can use to quickly start a 
program or to find a file. It's also the fastest way to get Help.
When you open a program, document, or window, a button appears on the taskbar. You can use this button to 
quickly switch between the windows you have open.



Shortcut menus

You can use your right mouse button to click any item and see a shortcut menu. This menu contains common 
commands that you can use on the item you clicked. For example, by clicking a file with your right mouse 
button, you can choose to open, copy, or delete it.



The desktop

When you start Windows, the large area you see is called the desktop. You can customize the desktop by adding 
shortcuts to your favorite programs, documents, and printers, and by changing its look to fit your mood and 
personality.
To adjust settings such as desktop color and background, use your right mouse button to click anywhere on the 
desktop, and then click Properties.



Shortcuts on the desktop

You can put a shortcut to any program, document, or printer on your desktop or in any folder. Shortcuts are quick
ways to get to the items you use often.
For example, you can create a shortcut to your printer by using the right mouse button to drag its icon to the 
desktop. Then, to print a file, just drag its icon onto the printer icon!



Properties

When you want to view or change information about any item, such as a document, program, folder, disk drive, 
or printer, you can look at its properties. Use the right mouse button to click the item, and then click Properties 
on the menu.
For MS-DOS-based programs, you no longer need to create and modify .pif files; you just modify the properties 
for the program.



Folders

Your documents and programs are stored in folders, which you can see in My Computer and Windows Explorer. In
previous versions of Windows, folders were called directories.



My Computer

You can use My Computer to quickly and easily see everything on your computer. Double-click the My Computer 
icon on the desktop to browse through your files and folders.



Windows Explorer
In Windows Explorer, you can see both the hierarchy of folders on your computer and all the files and folders in 
each selected folder. This is especially useful for copying and moving files. You can open the folder that contains 
the file you want to move or copy, and then drag it to the folder you want to put it in.
To find Windows Explorer, click the Start button, and then point to Programs.



Network Neighborhood

If you are using a network, the Network Neighborhood icon appears on your desktop.
Double-click it to browse through the computers in your workgroup and the computers on your entire network.



Long filenames

You can now give any name to a file; you are not limited to eight characters with a three-character extension. 
You can even use spaces!



Close, Minimize, and Maximize buttons

Every window has an        (Close button) in the upper-right corner that you can click to close the window and 
quit the program.

The Minimize and Maximize buttons also have a new look.



What's This?
In dialog boxes, you can easily get Help on an option or area by clicking  in the upper-right corner of the 
window and then clicking the item you want Help on. A pop-up window appears containing an explanation of the 
item.

Another way to get Help is to use your right mouse button to click an item, and then click What's This? on the menu
that appears.



Accepts any settings that are currently specified in this dialog box, and then continues.



Stops checking this drive for errors.



Click this to see more information about the error ScanDisk detected.



Lists the drives that ScanDisk can check. To select multiple drives, press CTRL, and then click each drive you want
to check.



Checks the files and folders on the selected drive(s) for errors. To change the settings that ScanDisk uses to 
check files and folders, click Advanced.



Click this to change the settings that ScanDisk uses to check the surface of your disk(s) for physical errors.



Checks files and folders for errors, and also checks the physical integrity of your disk's surface.
To change the settings that ScanDisk uses to check files and folders, click Advanced. To change the settings that 
ScanDisk uses to check the surface of your disk(s), click Options.



If this box is not checked, ScanDisk prompts you to specify how you want any errors repaired. If this box is 
checked, ScanDisk repairs most errors automatically using predetermined settings. To change the settings 
ScanDisk uses, click Advanced.



Starts ScanDisk. When ScanDisk runs, it checks the drive(s) you selected using the settings specified in this 
dialog box and in the ScanDisk Advanced Options dialog box. If you have chosen to conduct a thorough test, 
ScanDisk also uses the settings specified in the Surface Scan Options dialog box.



Closes ScanDisk if it is not running. Or stops checking your drives for errors if ScanDisk is running.



Click this to change the settings that ScanDisk uses when checking your files and folders for errors.



Displays a summary each time ScanDisk finishes checking a drive. This summary provides information about the 
drive and shows whether ScanDisk detected and repaired any errors.



Prevents ScanDisk from displaying a summary when ScanDisk finishes checking a drive.



Displays a summary about your drive only if ScanDisk detects errors on it. This summary provides information 
about the drive and shows whether ScanDisk repaired any of the errors it found.



Saves a detailed record of this ScanDisk session in a file named Scandisk.log, which is located in the top-level 
folder (root directory) of drive C. If there is already a log file on drive C, ScanDisk will replace it.



Saves a detailed record of this ScanDisk session and adds it to the end of the Scandisk.log file, which is located 
in the top-level folder (root directory) of drive C.



Prevents ScanDisk from saving the results of this ScanDisk session in a log file.



Deletes any cross-linked files that ScanDisk finds. A cross-link occurs when two or more files use the same 
cluster (area of a disk) at the same time. The data in a cross-linked cluster is probably correct for only one of the 
cross-linked files, but may not be correct for any of them.



Makes a separate copy of each cross-linked cluster and copies it to each affected file. A cross-link occurs when 
two or more files use the same cluster (area of a disk) at the same time. The data in a cross-linked cluster is 
probably correct for only one of the cross-linked files, but may not be correct for any of them.



Leaves cross-linked files on your disk. If you try to use or delete any cross-linked files, the data in them may 
become further damaged or your program may fail.



Checks files for invalid filenames. You may be unable to open files whose names are invalid.



Checks files for invalid dates and times. Files whose dates are invalid may not be sorted correctly. If a file's date 
is incorrect, some programs, such as backup, setup, or copy programs, may make incorrect assumptions about 
how current a file is.



If you have a drive that was compressed by using DoubleSpace or DriveSpace, ScanDisk checks the 
uncompressed drive on which the compressed drive is stored before checking the compressed drive itself. This 
uncompressed drive, called a host drive, may be hidden. Errors on a compressed drive are often caused by 
errors on its host drive.
If this box is not checked, ScanDisk does not check the host drive for errors.



Deletes lost file fragments, so your programs can use the freed disk space for storage. Lost file fragments may 
contain useful data, but are probably just taking up space.



Converts lost file fragments to files so you can view them and determine whether they contain any information 
you want to save. These files will be stored in the top-level folder (root directory) of your drive and will have 
names such as File0000.



Checks your entire drive for physical damage, including both its system and data areas.



Checks only the system area of your drive for physical damage. Errors in the system area may indicate that your 
drive needs to be replaced. ScanDisk usually cannot repair errors in the system area.



Checks only the data area of your drive for physical damage. ScanDisk can usually repair errors in the data area 
by relocating data to a valid area of the drive and marking the bad area so that programs won't store data there 
in the future. However, the data stored in a damaged area of your drive may be unrecoverable.



If this box is not checked, ScanDisk reads the contents of every sector of your drive and then writes the contents 
back to verify that the drive can be read from and written to correctly. If this box is checked, ScanDisk reads the 
contents of each sector, but does not write it back.



ScanDisk repairs bad sectors by moving the data they contain to a valid location. If this box is checked, ScanDisk
will not move data that is part of a hidden or system file. If this box is not checked, ScanDisk will move the data. 
However, if ScanDisk moves data, programs that require their files to be stored in a specific location on your disk
may not work correctly. Some older programs use the location of a hidden system file to verify that you are using
an authorized copy.



After checking the integrity of the file system, ScanDisk will verify that Windows can use every sector on the disk
to store data reliably. If ScanDisk finds a bad sector in the data area of the drive, it tries to move the contents of 
that sector to another location and then marks the sector so Windows does not use it again. ScanDisk cannot 
repair bad sectors in the system area of a disk.



Ignores this error and continues checking your disk for other errors. However, it would be best if you conducted a
thorough test now. Although a thorough test cannot repair this error, it can determine whether additional areas 
of your disk are damaged, and ScanDisk may be able to repair those areas.



Ignores this error and continues checking your disk for other errors. If you do not conduct a thorough test and 
repair this error now, you may encounter problems while using some of the files on this disk.



Attempts to read the sector again. If ScanDisk can read the sector, it will continue checking your disk. However, 
even if ScanDisk can read the sector on its second attempt, the fact that it failed once may be an indication that 
the disk is deteriorating. If ScanDisk cannot read the sector on its second attempt, you will receive this error 
again.



Attempts to write to the sector again. If ScanDisk can write to the sector, it will continue checking your disk. 
However, even if ScanDisk can write to the sector on its second attempt, the fact that it failed once may be an 
indication that the disk is deteriorating. If ScanDisk cannot write to the sector on its second attempt, you will 
receive this error again.



After checking the integrity of the host drive's file system, ScanDisk will verify that Windows can use every 
sector on the host drive to store data reliably. If ScanDisk finds a bad sector on the host drive, it tries to move 
the contents of that sector to another location and then marks the sector so Windows does not use it again. 
ScanDisk then rechecks the integrity of the compressed drive's file system and ensures that all its data can be 
read reliably.



Ignores this error and continues checking your disk for other errors. However, the damaged portion of the drive 
contains critical information about the location of some or all of the files on it. If you continue to use the drive 
without repairing this error, many of your files will be inaccessible, your programs may fail, or you may receive 
errors when using some files.



Restarts ScanDisk, which will perform a thorough test of this drive's uncompressed host drive, and then test this 
compressed drive again.



ScanDisk cannot repair this error because your disk is full. Quit ScanDisk, free some disk space, and then restart 
ScanDisk. For information about freeing disk space, click Help.



Tests this sector again. If the test succeeds, ScanDisk will continue. If the test fails, you will receive this error 
again.



Ignores this error and continues checking your disk for other bad sectors. If you try to use this disk, you may 
encounter errors and may find that many of the files on the disk are unusable.



Recovers any recoverable data from this cluster and moves the data to another location on your disk. ScanDisk 
then makes this cluster available for file storage. However, if the host drive is physically damaged, any new data 
stored in this location will probably be corrupted until that damage is repaired. 
Note    If this option is unavailable, the error occurred in a file that cannot be repaired while Windows is running. 
In this case, click Help for information about how to repair the error.



Recovers any recoverable data from this cluster and moves the data to another location on your disk. ScanDisk 
then makes this cluster available for file storage.
Note    If this option is unavailable, the error occurred in a file that cannot be repaired while Windows is running. 
In this case, click Help for information about how to repair the error.



Attempts to read the cluster again. If the test succeeds, ScanDisk will continue. If the test fails, you will receive 
this error again.



Ignores this error and continues checking your disk for other errors. If you try to access the file or folder that is 
using this cluster, you will receive an error.



Marks this cluster as bad so Windows will no longer use it for file storage. If this cluster is currently in use, 
ScanDisk attempts to move the data in it to another location. However, the file using this cluster is probably 
already damaged. 
Note    If this option is unavailable, the cluster contains part of a file that ScanDisk cannot move while Windows 
is running. In this case, click Help for information about how to repair the error.



Tests this cluster again. If the test succeeds, ScanDisk will continue. If the test fails, you will receive this error 
again.



Attempts to complete this task again. However, if your computer still does not have enough available memory, 
you will receive this error again.



Attempts to continue checking your disk for errors, but ScanDisk may be unable to correct them. 
Note    If this option is unavailable, ScanDisk is unable to continue. Restart your computer and run ScanDisk 
again, or run ScanDisk in MS-DOS mode. For information about running ScanDisk in MS-DOS mode, click Help.



Repairs the error by assigning a correct value to the file allocation table (FAT) media byte.



Does not assign a correct value to the file allocation table (FAT) media byte.



Replaces the damaged copy of the file allocation table (FAT) with a valid copy.



Does not replace the damaged copy of the file allocation table (FAT) with a valid copy. If the primary copy of the 
FAT becomes damaged, you could lose data.



Converts lost file fragments to files, so you can view them later. ScanDisk saves files in the top-level folder (root 
directory) of this disk and gives them names such as File0000. You can use any text editor to open the file(s).



Deletes the data in lost file fragments and frees the disk space the data is currently using.



Ignores lost file fragments, which will continue to take up space on your disk. 



Makes a separate copy of each cross-linked cluster and copies it to each affected file. After ScanDisk copies the 
cross-linked cluster(s), all but one of the files will probably still contain invalid data. However, the files will no 
longer share that data. Note that your program may fail if you use the files that contain invalid data. 
Note    If this option is unavailable, ScanDisk cannot repair this error while Windows is running. In this case, click 
Help for information about how to repair the error.



Deletes each of the affected files. 
Note    If this option is unavailable, ScanDisk cannot safely delete some of the affected files. In this case, click 
Help for information about how to repair the error.



Ends each file at the point where the cross-linked files started using the same section of your disk. This will make
each file valid but incomplete. ScanDisk will probably recover the end of each file later as lost file fragments. If 
any of these files are important to you, be sure to save lost file fragments later. 
Note    If this option is unavailable, ScanDisk cannot safely truncate one or more of the affected files. In this 
case, click Help for information about how to repair the error.



Preserves the selected file and deletes all other files in the list. The selected file might not contain valid data. 
Note    If this option is unavailable, ScanDisk cannot safely delete any of the files that are not selected. In this 
case, click Help for information about how to repair the error.



Preserves the selected file and ends the other file(s) at the point where the file(s) starts using the same section 
of your disk. This will make the other file(s) valid but incomplete. The selected file might not contain valid data. 
ScanDisk will probably recover the end of the other file(s) later as lost file fragments. If any of these files are 
important to you, be sure to save lost file fragments later. 
Note    If this option is unavailable, ScanDisk cannot safely truncate any of the files that are not selected. In this 
case, click Help for information about how to repair the error.



Leaves cross-linked files on your disk. If you attempt to use or delete any of these files before correcting this 
error, the data in all these files may become further damaged or your program may fail.



Repairs the error as indicated in the text of this error message.



Repairs the error by deleting the file and by removing the reference to it in the folder that contained it. 
Note    If this option is unavailable, ScanDisk cannot repair the error now because the file is in use or cannot be 
deleted safely.



Repairs the error by deleting the folder and removing the incorrect information about it from the folder it is in. 
Any files or folders in this folder will be reported later as lost file fragments. If this folder or its contents are 
important to you, be sure to save lost file fragments later.
Note    If this option is unavailable, the folder or some of the files in it cannot be deleted safely.



Ignores this error and continues checking your disk for other errors.



Ends the allocation chain at the point where it references an earlier portion of the file or folder. This will make the
allocation chain valid, but the data in the file or folder may have already been damaged. Your disk may contain 
additional data that has been disassociated from the rest of the file or folder. If so, ScanDisk can recover that 
portion of the file or folder later as a lost file fragment. If this file or folder is important to you, be sure to save 
lost file fragments later. 



Deletes the entire file or folder.
Note    If this option is unavailable, the file or folder cannot be deleted safely. In this case, click Help for 
information about how to repair the error.



Ignores this error and continues checking your disk for other errors. If you attempt to use the file before 
correcting this error, the file's data may become damaged or your program may fail.



Ends the allocation chain at the point where it references an invalid location. Although the allocation chain 
indicates that part of this file or folder is in an invalid location, that part may still exist on your disk. If so, 
ScanDisk can recover that portion later as a lost file fragment. If this file or folder is important to you, be sure to 
save lost file fragments later. 



Deletes the entire file or folder. If this is a folder, any files or folders in it will be reported later as lost file 
fragments.
Note    If this option is unavailable, the file or folder cannot be deleted safely. In this case, click Help for 
information about how to repair the error.



Ignores this error and continues checking your disk for other errors. If you attempt to use the file or folder before 
correcting this error, its data may become damaged or your program may fail.



Makes the volume label valid. Any data associated with the label will be reported later as lost file fragments. 



Deletes the volume label. Any data associated with the label will be reported later as lost file fragments. 



Ignores this error and continues checking your disk for other errors.



Removes the volume label identifier from the file. If there is no data in the file, ScanDisk deletes it.



Deletes the misidentified file or folder. Any data associated with it will be reported later as one or more lost file 
fragments.



Ignores this error and continues checking your disk for other errors. If you do not correct this error, you will be 
unable to use this file.



Repairs the error by moving the file to the top-level folder (root directory) of your disk. 



Moves the folder and all its contents to the top-level folder (root directory) of your disk.



Deletes the file. Any data in it will be reported later as a lost file fragment.



Deletes the folder. Any files or folders in it will be reported later as lost file fragments.



Ignores this error and continues checking your disk for other errors. However, until you repair the error, you will 
be unable to use this file. 



Ignores this error and continues checking your disk for other errors. However, until you repair the error, you will 
be unable to use this file in MS-DOS mode. 



Ignores this error and continues checking your disk for other errors. However, until you repair the error, you will 
be unable to use this folder or any of the files in it.



Ignores this error and continues checking your disk for other errors. However, until you repair the error, you will 
be unable to use this folder or any of the files in it in MS-DOS mode.



Moves the folder and all its contents to the top-level folder (root directory) of your disk.



Deletes the folder and all its contents.



Ignores this error and continues checking your disk for other errors. However, until you repair the error, you will 
be unable to use this folder or any of the files in it in MS-DOS mode. If this is the only available option, click Help.



Repairs the error as indicated in the text of this error message.



Repairs the error by deleting the folder and all its contents. 
Note    If this option is unavailable, the folder or some of the files in it cannot be deleted safely.



Ignores this error and continues checking your disk for other errors. 



Repairs the error by giving the compressed volume file the correct name.



Ignores this error and continues checking your disk for other errors. If you don't repair this error, some disk 
utilities may be unable to work with your drive or may damage it.



Rewrites the signature(s).



Ignores this error and continues checking your disk for other errors. If you don't repair this error, some disk 
utilities may be unable to work with your drive or may damage it.



Rewrites the boot sector.



Ignores this error and continues checking your disk for other errors. If you don't repair this error, some disk 
utilities might make invalid assumptions about this drive and damage it.



Increases the size of the volume file to 512K. Although this will make the file valid, virtually all the data that was 
on the drive will be lost.



Ignores this error. ScanDisk will not search for any more errors on this drive.



Reconstructs the compressed volume file's MDBPB. 
Note    If this option is unavailable, click Help for information about how to repair this error.



Ignores this error and continues checking your disk for other errors. If you choose this option, ScanDisk may be 
unable to detect some errors or may report errors incorrectly. In addition, all the data on this drive could be 
damaged or lost if you continue to use the drive.



Ensures that this MDFAT entry no longer causes errors when you attempt to open or use this file. However, the 
area of the file or folder whose MDFAT entry was invalid will now be blank.



Frees the invalid MDFAT entry and recovers the space it was using.



Ignores this error and continues checking your disk for other errors. If you attempt to use this file or folder before
repairing the error, your program may fail or you may receive an error message.



Ignores this error and continues checking your disk for other errors. However, if you do not repair this error, you 
will be unable to use the space the invalid MDFAT entry is occupying.



Frees the lost MDFAT reference(s) and recovers the disk space they were using.



Creates a corresponding reference in the file allocation table (FAT) for each of the lost MDFAT reference(s). 
Although the reference(s) will no longer be lost, the data they refer to will not be associated with a file. To save 
the data in these MDFAT references, make sure you choose to convert lost file fragments to files when ScanDisk 
recovers lost file fragments. 



Leaves the lost MDFAT reference(s) on your disk. Until you correct this error, you will be unable to store files in 
the space these lost references occupy.



Makes a separate copy of the cross-linked data for each affected portion of the file(s), file fragment(s), or 
folder(s). After ScanDisk repairs a cross-link, all or most of the affected portions will still contain incorrect data. 
When accessing the file(s) or folder(s), you may receive error messages or your program may fail. 



Deletes each of the affected files, file fragments, or folders. Any files or folders within affected folders will be 
reported later as lost file fragments. If these files or folders are important to you, be sure to save lost file 
fragments later.
Note    If this option is unavailable, ScanDisk cannot safely delete some of the affected files or folders.



Ignores this error and continues checking your disk for other errors. If you attempt to use any of these files or 
folders before repairing this error, the data in the affected files or folders may become further damaged or a 
program you are using may fail. You may also receive error messages when you start your computer.



Ensures that the cluster will remain unavailable for storing data, which is the safest option. Some encryption 
programs, or programs that are copy protected, mark one or more clusters as bad to prevent other programs 
from accessing them. If you are using one of these programs, you should leave the bad cluster mark intact.



Makes the cluster available for storing data. Although ScanDisk did not detect anything wrong with this cluster, 
you may encounter errors if you use it.



Retests the bad cluster. If the test fails, ScanDisk will leave the cluster marked as bad and will continue searching
your disk for other errors. If the test succeeds, this dialog box will appear again. If the test succeeds several 
times, it is probably safe to store data in this cluster. 



To check files and folders for errors

1 Click here        to start ScanDisk.
2 Click the drive that contains the files and folders you want to check.
3 Click Standard.

If you want to change the settings ScanDisk uses when checking files and folders, click Advanced.
4 Click Start.

Tips
If you want to specify how ScanDisk repairs any errors it finds, make sure the Automatically Fix Errors box 

is not checked.
For Help on an item in the main ScanDisk screen, use your right mouse button to click the item, and then 

click the What's This? command.
For Help on an item in the ScanDisk Advanced Options dialog box, click 

 at the top of the dialog box, and then click the item.
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To check your disk's surface, files, and folders for errors

1 Click here        to start ScanDisk.
2 Click the drive you want to check.
3 Click Thorough.

If you want to change the settings ScanDisk uses when checking the disk's surface, click Options.
If you want to change the settings ScanDisk uses when checking files and folders, click Advanced.

4 Click Start.

Tips
If you want to specify how ScanDisk repairs any errors it finds, make sure the Automatically Fix Errors box 

is not checked.
For Help on an item in the main ScanDisk screen, use your right mouse button to click the item, and then 

click the What's This? command.
For Help on an item in the Surface Scan Options or ScanDisk Advanced Options dialog boxes, click 

 at the top of the dialog box, and then click the item.

{button ,AL("WIN_DISK_LOGICAL")} Related Topics



To check for disk errors when your computer starts

1 Click here        for information about adding a ScanDisk icon to your StartUp folder.
2 After you have added a ScanDisk icon to your StartUp folder, use your right mouse button to click the icon.
3 Click Properties, and then click the Shortcut tab.
4 After the text in the Target box, specify one or more of the following:
driv
e:

to specify the 
drive(s) you want 
to check

/a to check all your 
local, 
nonremovable 
hard disks

/n to start and close 
ScanDisk 
automatically

/p to prevent 
ScanDisk from 
correcting any 
errors it finds

Examples
To check drive D and start and close ScanDisk automatically, the text in the Target box should look similar 

to the following:
c:\windows\scandskw.exe d: /n

To check all nonremovable hard disks but prevent ScanDisk from correcting any errors it finds, the text in 
the Target box should look similar to the following:

c:\windows\scandskw.exe /a /p



To add ScanDisk to your StartUp folder

1 Use your right mouse button to click the Start button, and then click Open.
2 Double-click the Programs folder, and then double-click the StartUp folder.
3 Click the File menu, and then point to New.
4 Click Shortcut, and then type the following:

scandskw.exe
5 Click Next, and then type the following:

ScanDisk
6 Click Finish, and then click the Back button in this Help topic to return to the previous procedure.



To repair errors that ScanDisk cannot repair while Windows is running

1 In ScanDisk, click OK to continue checking your disk for errors.
2 While ScanDisk finishes checking your disk for errors, print or write down these instructions.
3 Insert your Windows startup disk in your startup floppy disk drive.

Click here        if you do not have a startup disk, and then click Create Disk.
4 Click the Start button, and then click Shut Down.
5 Click Restart The Computer, and then click Yes.
6 At the command prompt, type the following:

scandisk x:
For x, substitute the letter of the drive you were just checking.

7 If ScanDisk prompts you to specify whether you want to check the host drive for errors, press Y.
8 When ScanDisk is finished, remove the startup disk, and then restart your computer.



To repair errors that ScanDisk cannot repair while Windows is running

1 In ScanDisk, click Cancel.
2 Print or write down these instructions.
3 Insert your Windows startup disk in your startup floppy disk drive. 

Click here        if you do not have a startup disk, and then click Create Disk.
4 Click the Start button, and then click Shut Down.
5 Click Restart The Computer, and then click Yes.
6 At the command prompt, type the following:

scandisk x:
For x, substitute the letter of the drive you were just checking.

7 If ScanDisk prompts you to specify whether you want to check the host drive for errors, press Y.
8 When ScanDisk is finished, remove the startup disk, and then restart your computer.



To repair errors that ScanDisk cannot repair while Windows is running

1 In ScanDisk, click Cancel.
2 Print or write down these instructions.
3 Insert your Windows startup disk in your startup floppy disk drive. 

Click here        if you do not have a startup disk, and then click Create Disk.
4 Click the Start button, and then click Shut Down.
5 Click Restart The Computer, and then click Yes.
6 At the command prompt, type the following:

scandisk x: /surface
For x, substitute the letter of the drive you were just checking.

7 If ScanDisk prompts you to specify whether you want to check the host drive for errors, press Y.
8 When ScanDisk is finished, remove the startup disk, and then restart your computer.



To repair errors that ScanDisk cannot repair while Windows is running 

1 In ScanDisk, click Cancel.
2 Print or write down these instructions.
3 Insert your Windows startup disk in your startup floppy disk drive. 

Click here        if you do not have a startup disk, and then click Create Disk.
4 Click the Start button, and then click Shut Down.
5 Click Restart The Computer, and then click Yes.
6 At the command prompt, type the following:

scandisk x: /surface
For x, substitute the letter of the drive you were just checking.

7 When ScanDisk is finished, remove the startup disk, and then restart your computer.



To change the compression ratio of a drive whose size is invalid

1 In the message, click Cancel.
2 In ScanDisk, click Close.
3 Click here        to start DriveSpace.

4 Select the drive that you were checking for errors or were working with in DriveSpace.
5 On the Advanced menu, click Change Ratio.
6 Click OK. When you do, DriveSpace automatically makes your compressed drive a valid size.

If Windows prompts you to restart your computer, click Yes.
7 Run ScanDisk again on the drive that you were checking for errors or were working with in DriveSpace.



To defragment a disk drive

1 In ScanDisk, click Continue to finish checking your drive for errors.
2 When ScanDisk has finished, click here        to start Disk Defragmenter.

3 Select the drive that you want to defragment, and then click OK.
4 Click Start.



To correct an invalid compression ratio

1 In ScanDisk, click Continue to finish checking your drive for errors.
2 When ScanDisk has finished, click here        to start DriveSpace.

3 Select the drive whose ratio you want to change, and then click OK.
4 Drag the slider to the left, so the estimated compression ratio is closer to the actual compression ratio. 
Then click OK.



To repair a compressed volume file that is too small

1 Restart ScanDisk.
2 Click the drive you were just checking, and then click Advanced.
3 Make sure the Check Host Drive First box is checked, and then click OK.
4 Click Start.



To perform a thorough test of a compressed drive and its host drive

1 Quit ScanDisk by clicking Cancel.
2 In the Type Of Test area, click Thorough.
3 Click Advanced.
4 Make sure the Check Host Drive First box is checked, and then click OK.
5 Click Start.



To enable multiple users to personalize settings

1 Click here     to display Passwords properties.
2 Click User Profiles.
3 Make sure the second option, that users can customize their desktop settings, is checked. 

The next person who logs on to Windows can change settings without affecting the settings you prefer. The 
next time you log on, your settings will be restored.

{button ,AL("A_WIN_TRAY_LOGOFF")} Related Topics



To change your Windows password

1 Click here        to display Passwords properties.
2 Click Change Windows Password.

If you have other network passwords, these will be listed so that you can change them to match your new 
Windows password if you want to.

3 Type your old password.
4 Type your new password, and then type it again in the Confirm New Password box.

Tip
If you are using Windows with a network, you need to be logged onto the network in order to change your 

Windows password.



Click the password you want to change.



Click this to change a password other than the Windows password — for example, a password used to connect to
a network computer.



Click this to change the Windows password. Your Windows password is used when you log on to Windows. Also, 
you can set other passwords — such as your password to log on to a network — to be the same as your Windows
password. That way, you have only one password to remember.



Specifies that everyone who uses this computer use the same settings.



Enables each person who uses this computer to personalize the desktop settings.



Specifies whether an administrator can create shared folders and printers on this computer and see who 
connects to them.



Lists the people who are administrators.



Click this to add a name to the list of administrators.



Click this to remove a name from the list of administrators.



Provides a space for you to type a password that the administrator must use to create, change, or monitor 
shared resources on your computer.



Provides a space for you to retype the password that the administrator must use to create, change, or monitor 
shared resources on your computer.



Specifies the settings saved in user profiles on this computer.



Provides a space for you to type your old password. Asterisks will appear instead of what you type.



Click this to display a list of the passwords that will be changed along with your Windows password.



Lists the passwords you can change.



To enable 32-bit PC card support

1 Click here        to start the PC Card (PCMCIA) wizard.
2 If you see the wizard, follow the instructions on your screen.

If you see properties for your PCMCIA socket, Windows 32-bit support for PC cards is already turned on.



To turn off 32-bit PC card support

1 Click here        to display Device Manager.
2 Click the plus sign next to PCMCIA Socket, and then double-click your PCMCIA controller.
3 In the Device Usage box, click to remove the check from the box next to the current configuration.
4 Use a text editor to edit the following files and remove the words "REM - by PC Card (PCMCIA) wizard - " from 

the lines that load your PC card drivers:
Config.sys
Autoexec.bat
System.ini

5 Save your changes, and then restart your computer.

Note
You may see other lines in these files that have the REM command in front of them. However, you should 

modify only those lines that mention the PC Card wizard.



To install PC card support for a Flash memory card

1 Check to make sure your computer supports the Microsoft Flash File System. If it doesn't, your Flash memory 
card will not work with this version of Windows.
If you are unsure whether your computer supports the Microsoft Flash File System, see your computer 
documentation.

2 Click here        to start the PC Card (PCMCIA) wizard. When you are prompted to restart your computer after 
finishing the wizard, click No.

If you see properties for your PCMCIA socket instead of the PC Card wizard, click Cancel, and then continue
to the next step.
3 Use a text editor to edit your Config.sys file, and insert the following lines in this order just before the line 
that contains "flash" in the driver name:

device=c:\windows\system\csmapper.sys
device=c:\windows\system\carddrv.exe /slot=n
For the value of n, type the number of PC card slots on your computer. Also, make sure the Csmapper.sys and 
Carddrv.exe files are in your Windows\System folder.

4 Find the line that contains "flash" or some variation of it in the driver name (such as Ssmsflsh.sys), and remove
the text "REM - by PC Card (PCMCIA) wizard - " from the beginning of that line. This line should follow the two 
commands you added in step 3.

5 Save your changes, and then restart your computer.



To install PC card support for an SRAM memory card
1 Click here        to start the PC Card (PCMCIA) wizard. When you are prompted to restart your computer after 

finishing the wizard, click No.
If you see properties for your PCMCIA socket instead of the PC Card wizard, click Cancel, and then continue

to the next step.
2 Use a text editor to edit your Config.sys file, and add the following lines in this order to the end of the file:

device=c:\windows\system\csmapper.sys
device=c:\windows\system\carddrv.exe /slot=n
For the value of n, type the number of PC card slots on your computer. Also, make sure the Csmapper.sys and 
Carddrv.exe files are in your Windows\System folder.

3 Save your changes, and then restart your computer.



To turn PC card sound effects on or off

1 Click here        to display PCMCIA properties. 
2 On the Global Settings tab, click the check box to turn sound effects on or off.

Tip
If the PC Card (PCMCIA) wizard appears when you click the button in step 1, complete the wizard. After 

restarting your computer, double-click the PC Card (PCMCIA) icon in the Control Panel, and then click the Global 
Settings tab.



Windows cannot run the PC Card (PCMCIA) wizard, because you do not have a PCMCIA socket installed. To install 
a PCMCIA socket, double-click the Add New Hardware icon in Control Panel.



Windows cannot view options for your PC card devices because you do not have a PCMCIA socket installed. To 
install a PCMCIA socket, double-click the Add New Hardware icon in Control Panel.



To remove your PC card from your computer

1 Click the PC card indicator on the taskbar.
2 Click the command to stop the card you want to remove.
3 When Windows prompts you, remove the card from your computer.

{button ,AL("A_PCMCIA_TASKBAR")} Related Topics



To display the PC card indicator on the taskbar

1 Click here        to display PC card properties. 
2 Make sure the box to show the control on the taskbar is checked.

Tip
If the PC Card (PCMCIA) wizard appears when you click the button in step 1, complete the wizard. After 

restarting your computer, double-click the PC Card (PCMCIA) icon in the Control Panel, and then check the box to 
see the status indicator on the taskbar.



To specify the number of PC card slots

1 In My Computer, double-click the icon for your hard disk, and then double-click the Config.sys file.
2 In the Open With dialog box, double-click Notepad.
3 At the end of the line that loads the Carddrv.exe file, type a space followed by /slot=n, where n is the number 

of PC card slots in your computer.
For example, if you have four slots, the line would look like the following:
device=c:\windows\system\carddrv.exe /slot=4

4 Click the        (Close button) at the far right of the title bar.
Click Yes to save changes.

5 Restart your computer.

Tips
You can specify from one to 16 slots. If you do not specify the /SLOT parameter, Windows will use the 

default value of two slots.
If you specify fewer slots in the /SLOT parameter than the number of slots on your computer, the extra 

slots will not have a drive letter assigned and you will not be able to use them with PC memory cards.



PC Card (PCMCIA) Troubleshooter

This troubleshooter helps you identify and solve problems with your PC cards. (A PC card is also called a PCMCIA 
card.) Just click to answer the questions, and then try the suggested steps to fix the problem.

What's wrong?
            My PC cards aren't installed automatically when I insert them.  
            My PC card was installed, but it doesn't work properly.  
            Some of my PC card slots cannot read memory cards.  



Have you run the PC Card wizard?
            Yes, I've run the PC Card wizard.  
            No, I haven't run the PC Card wizard.  
            I'm not sure.  



To enable 32-bit PC card support
Click here    

    to start the PC Card wizard.

Do you see the PC Card wizard?
            Yes.  
            No, I saw properties for my PCMCIA socket.  
            The wizard won't run because my PCMCIA socket isn't installed.  



Run the PC Card wizard

Follow the instructions on the screen. If you still have problems after running it and restarting your computer, 
return to this troubleshooter and continue trying to resolve the problem.



Windows 32-bit PC card support is already enabled
Click Cancel to close the PCMCIA socket properties dialog box.

            Click here to continue.  



Did you hear a tone when you inserted your PC card?
            Yes, I heard a low tone.  
            Yes, I heard an ascending tone.  
            No, I didn't hear a tone.  
            I am unable to hear tones.  



Check if you have memory reserved for PCMCIA Card Services

1 Click here        to display Device Manager.
2 Double-click Computer.
3 Click Memory.
4 Look to see whether PCMCIA Card Services is listed.

Do you see PCMCIA Card Services listed?
            Yes.  
            No.  



Close Device Manager

1 Click Cancel to close the Computer properties dialog box.
2 Click Cancel to close Device Manager.
            Click here to continue.  



Does your PC card work if your card is inserted when you start your computer?
            Yes.  
            No, it doesn't work then either.  
            I haven't tried that.  



Try to configure the PC card manually

1 Click here        to display Device Manager.
2 Double-click your PCMCIA controller.

If your PCMCIA controller isn't visible, click the plus sign next to the icon for your PCMCIA socket.
3 Click the Resources tab.
4 Make a note of what Input/Output range appears in the Resource Settings box.
5 In the Settings Based On box, search through the configurations to find one that has the same Input/Output 

range but no Interrupt Request.

Were you able to find a configuration without an interrupt request?
            Yes, I chose a new configuration.  
            No, I couldn't find a configuration, or I saw a Set Configuration Manually button.  



Restart your computer

1 Click OK, and then click OK again.
2 Click the Start button, and then click Shut Down.



Restart your computer with the card in it

1 Insert the PC card you are having trouble with.
2 Click the Start button, and then click Shut Down.
3 Click Restart The Computer to restart the computer with your PC card in the socket.
If you try this and still have trouble with your PC card, return to this troubleshooter and continue trying to resolve
the problem.



Check if you have memory reserved for PCMCIA Card Services

1 Click here        to display Device Manager.
2 Double-click Computer.
3 Click Memory.
4 Look to see whether PCMCIA Card Services is listed.

Do you see PCMCIA Card Services listed?
            Yes.  
            No.  



Close Device Manager

1 Click Cancel to close the Computer properties dialog box.
2 Click Cancel to close Device Manager.
            Click here to continue.  



Do you see any lines marked "Unavailable for use by devices"?
            Yes.  
            No.  



Check if memory ranges are excluded when loading EMM386

It is possible that memory needed by your previous PC Card (PCMCIA) support was made unavailable when 
Windows loaded EMM386. If so, you can remove the command that specifies that this memory should be 
excluded.
1 Use a text editor such as Notepad to edit your Config.sys file.
2 Find the line that loads EMM386. For example, it could look like this:

device=c:\windows\emm386.exe noems x=D000-DFFF

Do you have a line loading EMM386 that has x= at the end of it?
            Yes.  
            No.  



Remove excluded memory ranges

1 If you have the memory range D000-DFFF in the x= portion of the command loading EMM386, remove the 
memory range.
For example, suppose you have this command:
device=c:\windows\emm386.exe noems x=C000-C7FF D000-DFFF 
The new command would appear as follows:
device=c:\windows\emm386.exe noems x=C000-C7FF
Otherwise, experiment by removing a range that is excluded. You may want to save a backup of the original 
file, just in case the range you remove was reserved for a different purpose.

2 Save the file, and then restart your computer.
If your device still doesn't work after you restart your computer, try replacing the memory range you removed, 
and then try a different memory range.



Memory range not available to support PC cards

Windows 32-bit PC Card (PCMCIA) support requires a memory window to work properly. These resources are not 
available on your computer, probably because they are in use by other devices.
You have encountered a problem that this troubleshooter cannot help you solve.
            Click here to close the troubleshooter.  



What kind of PC card are you having trouble with?
            Modem  
            Memory card  
            Other  



Have you installed PC card support for memory cards?
            Yes, I followed the specific memory card instructions.  
            No, I just installed general PC card support.  

If you respond No and still have trouble after following the instructions for memory cards, return to this 
troubleshooter and continue trying to resolve the problem.



What kind of memory card do you have?
            SRAM memory card  
            Flash memory card  



Make sure Windows supports your PC card

1 Click here        to start the Add New Hardware wizard.
IMPORTANT: You will not be completing this wizard. You just want to see if the device is supported.

2 On the second screen of the wizard, click No to indicate you do not want Windows to search for your new 
hardware, and then click Next.

3 In the list of hardware types, click the type of device that is not being detected, and then click Next to 
continue.

4 Scroll through the manufacturers and models and see if your device is listed.
If your device isn't listed, it is not supported by this version of Windows.

5 Click Cancel to close the wizard.

Was your device listed?
            Yes.  
            No.  



Next steps

You have encountered a problem that this troubleshooter can't help you solve.

What do you want to do?
            I still want to use 32-bit support for my other PC card drivers.  
            My device worked fine before running the PC Card wizard (which loads 32-bit drivers). I want to remove the  

32-bit support so this device will work again.



See your hardware documentation

Your hardware documentation may have information about obtaining updated Windows drivers for your device, 
or may have a solution to your problem. 
            Click here to close the troubleshooter.  



See if the device has a conflict or other problem

1 Click here        to display Device Manager.
2 Click the plus sign next to the type of device.

Does the device icon have a red X, or a red circle with an exclamation point?
            Yes, the icon has a red X through it.  
            Yes, the icon has a red circle with an exclamation point.  
            No, the device icon does not have either of these signs.  
            I don't see the device listed.  



Enable the device

If your device has a red X through it, it's probably disabled.
1 Double-click the device.
2 In the Device Usage box, make sure the check box next to the current configuration is checked.
3 Click OK.

Does the device work now?
            Yes, it works. Close the troubleshooter.  
            No, it still doesn't work.  



Determine the type of problem

If your device icon contains a red circle with an exclamation point, the device has some kind of problem.
1 Double-click the device.
2 In the Device Status area, determine what kind of problem your device has.

Is the problem a hardware conflict?
            Yes, this device has a conflict.  
            No, there is no conflict.  



Try fixing the problem

Follow the instructions in the Device Status area to try to resolve the problem. If that doesn't work, or if there are
no instructions, see your hardware documentation.
            Click here to close the troubleshooter.  



Try changing the memory allocation for your PC card socket
1 In the hardware list, click PCMCIA Socket, and then click Properties.
2 Click the Global Settings tab.
3 In the Card Services Shared Memory area, make sure Automatic Selection is not checked.
4 Try changing the memory settings in the Start and End boxes.

If you are unsure which settings to change, see your hardware documentation.
5 Restart your computer.
If your device still doesn't work after you restart your computer, see your hardware documentation or disable 32-
bit PC card support.

{button ,AL("A_DISABLE_32BIT")} Related Topics



Using Briefcase to keep documents up-to-date

If you want to work on files at home or on the road, you can use Briefcase to help keep the various copies of the 
files updated.
To use Briefcase, you drag files from shared folders on your main computer to the Briefcase icon on your 
portable computer. When you are finished working on the files on the portable computer, reconnect to your main
computer, and then click Update All in Briefcase to automatically replace the unmodified files on your main 
computer with the modified files in your Briefcase. 
The files on your main computer are automatically revised; you do not need to move the files you worked on out 
of Briefcase or delete the existing copies.

Notes
When you are copying files from your main computer into Briefcase, the two computers must be 

connected, either over a network or by a cable. 
Briefcase is installed only if you chose the Portable option during Windows setup, or if you chose the 

Custom option and specified installing Briefcase. If you do not see a Briefcase icon on your desktop, click Related 
Topics to find out how to install it.
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To add Accessibility Options 

1 Click here        to open the Add/Remove Programs dialog box. 
2 On the Windows Setup tab, click the check box for Accessibility Options to mark it for installation.
3 Click OK, and then follow the instructions on your screen. 

When installation is complete, you will be prompted to restart the computer so that the changes can take 
effect.

Notes
The Details button is used to display the list of components included in a group of components, such as 

Accessories, and is available with certain individual components as well. A description of each highlighted group 
and individual component appears in the Description box.    

For more information about individual Accessibility options, look up "accessibility" in the Help Index.



Using Dial-Up Networking to connect to a computer or network

With Dial-Up Networking, you can gain access to shared information on another computer, even if your computer
is not on a network. The computer you are dialing in to must be set up as a network server for you to use its 
shared resources. 
For example, if you have a computer at home, you can dial in and connect to your work computer and network 
through a network server. Both your home computer and the network server must have modems installed.

To start the Dial-Up Networking setup wizard, double-click My Computer, and then double-click Dial-Up 
Networking.

Notes
To connect to an online service such as a bulletin board, use HyperTerminal rather than Dial-Up 

Networking.
If the Dial-Up Networking icon is not in My Computer, it is not installed. To find out how to install it, click 

Related Topics. 
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A server is a computer on a local area network that is running software for controlling access to all or part of the 
network and its resources. 
A computer with server capabilities can make resources available to other computers on the network.



Using a parallel or serial cable to connect to another computer

With Direct Cable Connection, you can gain access to shared folders on another computer, even when your 
computer is not on a network. If the other computer is connected to a network, you can also gain access to that 
network. 
For example, if you have a portable computer, you can use a cable to connect it to your work computer and 
network.

To set up a direct cable connection with another computer, click the Start button, point to Programs, point 
to Accessories, and then click Direct Cable Connection.

Note
If you do not see Direct Cable Connection on the Accessories menu, it is not installed. To find out how to 

install it, click Related Topics.
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Playing Windows games

Just because you use Windows to get your work done doesn't mean you can't have fun too.
To start a game:
1 Click the Start button.
2 Point to Programs, point to Accessories, and then point to Games.
3 Click a game.
For information about how to play the game, click the Help menu in the game.

Note
If you do not see any games on your Accessories menu, then you did not install any games when you 

installed Windows. To find out how to install Windows games, click Related Topics.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



Using Paint to create pictures

You can use Paint to create, edit, and view pictures.
You can paste a Paint picture into another document you've created, or use it as your desktop background. You 
can even use Paint to view and edit scanned photos.

To start Paint, click here    
 .

For information about how to use Paint, click the Help menu in Paint.



Using WordPad to write and format documents

WordPad is a text editor for short documents. You can format documents in WordPad with various font and 
paragraph styles.

To start WordPad, click here    
 .

For information about how to use WordPad, click the Help menu in WordPad.
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Using Notepad to write and edit text files

You can use Notepad to create or edit text files that do not require formatting and are smaller than 64K. Notepad
opens and saves text in ASCII (text-only) format only. To create or edit files that require formatting or are larger 
than 64K, use WordPad.

To start Notepad, click here    
 .

For information about how to use Notepad, click the Help menu in Notepad.

{button ,AL("A_WORDPAD")} Related Topics



Using Microsoft Exchange to exchange messages

With Microsoft Exchange, you can send and receive electronic mail or fax messages. You send messages from 
and store all messages in Microsoft Exchange, so there's one convenient place to look for all your messages.

To open Microsoft Exchange to send or receive a message, double-click the Inbox icon on your desktop.

Notes
If the Inbox icon is not on your desktop, then Microsoft Exchange is not installed. To find out how to install 

it, click Related topics.
For information about how to use Microsoft Exchange, click the Help menu in Microsoft Exchange.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



Using Microsoft Fax

Microsoft Fax enables you to send and receive fax messages. You can also send faxes directly from programs you
create them in, such as Microsoft Word.
Fax messages appear in Microsoft Exchange, where you can view them online or print them.

To open Microsoft Exchange to send or receive a fax, double-click the Inbox icon on your desktop. 

Notes
If the Inbox icon is not on your desktop, then Microsoft Exchange is not installed. To find out how to install 

it, click Related Topics. You must install both Microsoft Exchange and Microsoft Fax to send and receive fax 
messages. 

For information on how to use Microsoft Fax, click the Help menu in Microsoft Exchange, and then click 
Microsoft Fax.

{button ,AL("A_ADDPROG_COMPONENT")} Related Topics



Using HyperTerminal to connect to a remote computer

You can use HyperTerminal and a modem to connect to a remote computer, even if it isn't running Windows.You 
can also use HyperTerminal to send and receive files, or to connect to computer bulletin boards and other 
information programs. To start HyperTerminal:
1 Click the Start button.
2 Point to Programs, point to Accessories, and then click HyperTerminal.
3 Double-click Hypertrm.
For information about how to use HyperTerminal, click the Help menu in HyperTerminal.

Tip
To gain access to files and printers on another computer running Windows, use Dial-Up Networking rather 

than HyperTerminal.

{button ,AL("A_DIAL_LINK;A_DIAL_LINK_CABLE")} Related Topics



To connect to The Microsoft Network

Access to The Microsoft Network, a new online service, is a feature of Windows 95. 
With The Microsoft Network, you can exchange messages with people around the world; read the latest news, 
sports, weather, and financial information; find answers to your technical questions; download from thousands of
useful programs; connect to the Internet, and more! 

To start The Microsoft Network, double-click The Microsoft Network icon on your desktop.
For more information, click the Help menu in The Microsoft Network.

{button ,AL("A_SignupProblems")} Related Topics



The Microsoft Network online service is not installed on your computer. To install it:
1 Use your right mouse button to click this topic, and then click Print Topic.
2 Click the Start button, point to Settings, and then click Control Panel.
3 Double-click the Add/Remove Programs icon.
4 Click the Windows Setup tab, and then click The Microsoft Network checkbox.
5 Insert your Windows CD or floppy disk as prompted.

Note
If The Microsoft Network online service does not appear on the Component list, it is not available for you to

install and use.



To view Help for The Microsoft Network, you must first install The Microsoft Network. To install it:
1 Use your right mouse button to click this topic, and then click Print Topic.
2 Click the Start button, point to Settings, and then click Control Panel.
3 Double-click the Add/Remove Programs icon.
4 Click the Windows Setup tab, and click The Microsoft Network checkbox.
5 Insert your Windows CD or floppy disk as prompted.



Using Backup to back up your files

You can use Backup to back up files on your hard disk. You can back up files to floppy disks, a tape drive, or 
another computer on your network. When you've made a backup file, you can restore it if your original files are 
damaged or lost.

To start Backup, click here    
 . 

For information about how to use Backup, click the Help menu in Backup.



Using Net Watcher to monitor shared resource use

You can see who is currently using resources on your computer by using Net Watcher. You can also add shared 
folders and disconnect users from your computer or from specific files. 
Before you can run Net Watcher, you must have Client for Microsoft Networks installed, and you must make sure 
that file and print sharing options for the network are enabled.

To start Net Watcher, click here    
 .

For information about how to use Net Watcher, click the Help menu in Net Watcher.



Using Phone Dialer to dial from your computer

Phone Dialer enables you to place telephone calls from your computer by using your modem or another Windows
telephony device.

To start Phone Dialer, click here    
.

For information about how to use Phone Dialer, click the Help menu in Phone Dialer.



Using Calculator to make calculations

You can use Calculator in standard view to do simple calculations, or use it in scientific view to do advanced 
scientific and statistical calculations.

To start Calculator, click here 
.

For information about how to use Calculator, click the Help menu in Calculator.



Using CD Player to play compact discs

You can use CD Player to play audio compact discs from a CD-ROM drive connected to your computer. To use CD 
Player, you also need a sound card.

To start CD Player, click here    
 .

For information about how to use CD Player, click the Help menu in CD Player.



Using Media Player to play multimedia files

You can use Media Player to play audio, video, or animation files, and to control the settings for multimedia 
hardware devices. 
To use Media Player, you should have a sound card.

To start Media Player, click here    
.

For information about how to use Media Player, click the Help menu in Media Player.



Using Volume Control to vary sound

If you have a sound card, you can use Volume Control to control the volume and speaker balance when you play 
audio files.

To start Volume Control, click here    
 .

For information about how to use Volume Control, click the Help menu in Volume Control.



Using Sound Recorder to record, play, and edit sound files

To use Sound Recorder, you must have a sound card and speakers installed on your computer. If you want to 
record live sound, you also need a microphone.

To start Sound Recorder, click here    
 .

For information about how to use Sound Recorder, click the Help menu in Sound Recorder.



Using DriveSpace to increase disk space

You can use DriveSpace to compress both hard and floppy disks to create more free space for files. You can also 
use DriveSpace to configure disk drives that you have already compressed by using DoubleSpace or DriveSpace.

To start DriveSpace, click here    
 .

For information about how to use DriveSpace, click the Help menu in DriveSpace.



Using ScanDisk to detect and repair disk errors

You can use ScanDisk to check your hard disk for logical and physical errors, and then repair the damaged areas.
To start ScanDisk, click here    

 .
For information about how to use ScanDisk, look up "ScanDisk" in the Help Index.



Using Disk Defragmenter to speed up your hard disk

You can use Disk Defragmenter to rearrange files and unused space on your hard disk so that programs run 
faster. 

To start Disk Defragmenter, click here    
.

For information about how to use Disk Defragmenter, look up "Defragmenter" in the Help Index.



This program is not installed on your computer. To install it:
1 Use your right mouse button to click this topic, and then click Print Topic.
2 Click the Start button, point to Settings, and then click Control Panel.
3 Double-click the Add/Remove Programs icon.
4 Click the Windows Setup tab.
5 Click a category, and then click Details.

Note
If you don't see the component listed in the Add/Remove Programs dialog box, it may be one that is 

included only with the CD version of Windows. In this case, you can download the component from an online 
service, such as The Microsoft Network, CompuServe, or the Microsoft Download Service.



This program is not installed on your computer because your computer is not set up to share files. Before you 
can install this program, you must install file and printer sharing for The Microsoft Network. To install file and 
printer sharing:
1 Use your right mouse button to click this topic, and then click Print Topic.
2 Click the Start button, point to Settings, and then click Control Panel.
3 Double-click the Network icon.
4 Click Add, and then click Service.
5 Click Add, and then click Microsoft.
6 Click File And Print Sharing For Microsoft Networks.

Note
If you don't see the component listed in the Add/Remove Programs dialog box, it may be one that is 

included only with the CD version of Windows. In this case, you can download the component from an online 
service, such as The Microsoft Network, CompuServe, or the Microsoft Download Service.



Registering Windows 95 online

With online registration, you can use your modem to register your copy of Windows 95 online. Registration 
ensures that you receive product support, product update information, and other benefits. The process only 
takes a few minutes to complete.
1 Click here        to start online registration.
2 Click Online Registration, and then follow the instructions on your screen.

Note
If you do not have a modem, use the registration card included in the Windows 95 package to register.



An acronym for American Standard Code for Information Interchange, ASCII is a file format that contains no text 
formatting, so it is transferrable between different operating systems and programs. ASCII text files are 
universally used for exchanging information between computers. 



Selects all the fonts in the List Of Fonts box.



Click this to map a network drive to a drive letter. The drive letter will appear in your drives list so you can 
search it for the font you want to add.



Lists the available drives you can search for the fonts you want to add.



Specifies whether to copy the fonts to your Windows\Fonts folder or to use them directly from the folder in which 
they are located.



Specifies the folder containing the fonts you want to add.



Lists the available fonts you can add from the drive and folder specified.



Add Fonts dialog box

You can add fonts from your local or network drives. They can either be copied to your Windows\Fonts folder, or 
you can use them from their current drive location.
For information about the options in this dialog box, click a button below.
            List of Fonts  
            Folders   
            Drives   
            Copy Fonts to Windows Folder   
            Select All   
            Network   

{button ,AL("WINDOWS_FONTS_ADDNEW")} Related Topics



To add a new font to your computer

1 Click here        to open the Fonts folder.
2 On the File menu, click Install New Font.
3 Click the drive and folder that contain the fonts you want to add.
4 Double-click the icon for the font you want to add.

Tips
To select more than one font to add, press and hold down the CTRL key, and then click the fonts you want. 
To select a range of fonts in the list, press and hold down the SHIFT key while dragging the cursor over the 

fonts.
To add fonts from a network drive without using disk space on your computer, make sure Copy Fonts To 

Windows Folder is not checked.

{button ,AL("WINDOWS_FONTS_DELETE;WINDOWS_FONTS_ADDNEW_31HELP")} Related Topics



To delete a font from your computer

1 Click here        to open the Fonts folder.
2 Click the icon for the font you want to delete.
3 On the File menu, click Delete.

Tip
To select more than one font to delete, press and hold down the CTRL key, and then click the fonts you 

want.

{button ,AL("WINDOWS_FONTS_ADDNEW")} Related Topics



To view fonts on your computer

1 Click here        to open the Fonts folder.
2 To look at a sample of a font, double-click the icon for the font. 

Note
When you install a printer, it may include several printer fonts. These do not appear in the Fonts folder, but

they do appear in the Font list of Windows-based programs such as WordPad.

{button ,AL("WINDOWS_FONTS_PRINT;WINDOWS_FONTS_SIMILAR")} Related Topics



To print a font sample 

1 Click here        to open the Fonts folder.
2 Double-click the icon for the font you want to print.
3 Click Print on the sample page that appears.

Tip
To select more than one font, press and hold down the CTRL key, and then click the fonts you want.

{button ,AL("WINDOWS_FONTS_VIEW")} Related Topics



To find similar fonts

1 Click here        to open the Fonts folder.
2 On the View menu, click List Fonts By Similarity. 
3 In the List Fonts By Similarity To box, click a font. The fonts on your computer appear in the list in order of 

similarity.

Note
Panose font-mapping information is stored with the font to describe its characteristics: serif or sans serif; 

normal, bold, or italic. If no Panose information is available for a font, the font appears at the bottom of the list, and 
it does not appear in the List Fonts By Similarity To box.

{button ,AL("WINDOWS_FONTS_VIEW;WINDOWS_FONTS_PRINT")} Related Topics



Direct Cable Connection Troubleshooter

This troubleshooter will help you identify and solve Direct Cable Connection problems. Just click to answer the 
questions, and then try the suggested steps to fix the problem.
Before you begin this troubleshooter, make sure you have connected the cable securely at both ends and you 
have run Direct Cable Connection to set up the software.

What kind of connection problem are you having?
            I don't know how to set up the connection software.  
            The connection fails.  



Run Direct Cable Connection

You first need to set up the software for cable connection on both computers. Start on your main (host) 
computer. The Direct Cable Connection wizard will prompt you to move to your other (guest) computer after you 
have finished setting up the host.

To start Direct Cable Connection
1 Click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection.
2 Follow the instructions on the screen.
            It's working now. Close the troubleshooter.  
            I already did this. Go back to the beginning of the troubleshooter.  



Did you set up one computer as the host and the other as the guest?
            Yes, one is set up as the host and the other as the guest.  
            No, they are both hosts or both guests.  



There must be a host computer and a guest computer

You need to run the Direct Cable Connection wizard again on one of the computers to set it up as the guest, if 
the other computer is the host (or vice versa).

Did this fix the problem?
            Yes, it's working now. Close the troubleshooter.  
            No, it still doesn't work.  



Did you enable file and print sharing on the host computer?
            Yes, sharing is enabled.  
            I don't know.  
            I only need access to the network through the host computer.  

Note
If you are only trying to connect to the network through the host computer, then sharing does not need to 

be enabled.



Check if file and print sharing is enabled

1 Click here        to display Network properties for this computer.
2 Click File And Print Sharing.
3 Make sure that both boxes are checked.
4 Restart your computer.

If this problem is not fixed, start this troubleshooter again.

Did this solve the problem?
            Yes, I can connect now. Close the troubleshooter.  
            No, the connection still doesn't work.  



Make sure you are sharing something on your host computer

It is possible that you are connected but that no folders or printers have been shared. In addition to enabling file 
and print sharing, you also have to share the folder on the host computer that you want to open on the guest 
computer. 

To share a folder
1 In My Computer, click the folder you want to share.
2 On the File menu, click Sharing.
3 Click Shared As.
4 Specify the sharing properties.

Tip
For Help on an item, click 

 at the top of the dialog box, and then click the item.

Did this solve the problem?
            Yes, I can connect now. Close the troubleshooter.  
            No, the connection still doesn't work.  



Check for a possible protocol conflict

The two computers may be using mismatched protocols. Both computers should have at least one common 
protocol installed, depending on the type of access needed by the guest computer. 

What kind of file access does the guest computer need?
            I only need to transfer files that are on the host computer.  
            I need full network access through the host computer.  



A protocol is a language computers use when communicating over a network. Two computers must use the same
protocol to communicate with each other. 
For example, if one computer is exclusively using an IPX/SPX-compatible protocol, and the other is exclusively 
using Microsoft NetBEUI, the connection will not work correctly.



The two computers must share a common protocol

Microsoft IPX/SPX-compatible protocol for Windows supports transferring files from the host computer to the 
guest computer. 

To add a protocol
1 Click here        to display Network properties for this computer.

2 If you need to add a protocol to match the other computer, click Add, click Protocol, and then click Add. 
3 Follow the directions in the Select Network Protocol dialog box.

Did this fix the problem?
            Yes, it works now. Close the troubleshooter.  
            No, it still doesn't work.  



Make sure Microsoft NetBEUI is installed on both computers

To gain server access through the host computer, you must install Microsoft NetBEUI on both computers, in 
addition to the IPX/SPX-compatible protocol. 

To add a protocol
1 Click here        to display Network properties for this computer.

2 If you need to add a protocol to match the other computer, click Add, click Protocol, and then click Add. 
3 Follow the directions in the Select Network Protocol dialog box.

Did this fix the problem?
            Yes, it works now. Close the troubleshooter.  
            No, it still doesn't work  



Make sure that the protocols are bound correctly

Protocols used for Direct Cable Connection must be bound to the Dial-Up Adapter. Typically, Windows will do this 
automatically when a protocol is added, but if for some reason it doesn't, you can bind it manually.

To bind a network adapter to a protocol
1 Click here        to display Network properties for this computer. 
2 In the list of installed network components, click Dial-Up Adapter, and then click Properties.
3 Click the Bindings tab.
4 Make sure that the boxes are checked for the protocols that both computers will be using.

Did this fix the problem?
            Yes, it works now. Close the troubleshooter.  
            No, it still doesn't work  



What kind of cable are you using?
            Serial cable  
            Parallel cable  
            I don't know  



What kind of serial cable are you using?

You need a serial, null-modem, RS-232 cable for a direct cable connection. If you are using another type of cable,
such as a LapLink serial cable, the connection will not work correctly.

Did replacing the cable fix the problem?
            Yes, close the troubleshooter.  
            No, it still doesn't work.  
            I need to buy a new cable.  



Check the type of parallel cable

1 Make sure that you chose the parallel cable option on both computers when you ran the Direct Cable 
Connection wizard.

2 Check to see what type of parallel cable you are using. 
Windows supports three types of parallel cables for a direct cable connection:

Standard or Basic 4-bit cable
ECP cable
UCM cable

Did this fix the problem?
            Yes. Close the troubleshooter.  
            I need a new cable.  
            I have the right cable, and it still doesn't work.  



Includes all LapLink and InterLink parallel cables. 



An ECP (Extended Capabilities Port) cable will work if both computers have ECP-enabled parallel ports, which 
must be enabled in the BIOS. 
Data transfer over an ECP cable is faster than over a standard 4-bit cable and is comparable to a UCM cable.



A UCM (Universal Connection Module) cable can switch into ECP mode if both computers have ECP-enabled 
parallel ports. 
Data transfer over a UCM cable is faster than over a standard 4-bit cable, and is comparable to an ECP cable. 



Cable definitions

Click one of the cable types below to see a description:
Serial
Parallel

Which type are you using?
            Serial  
            Parallel  



A parallel cable fits into a parallel port on your computer (labeled LPT1 or LPT2). A parallel port is commonly 
used for a printer cable and typically has a 25-pin connector. If the cable you are using looks the same as your 
modem cable, it is a serial, not a parallel, cable.
A parallel cable transmits data simultaneously over multiple lines. This makes it the faster of the two connection 
methods, but it can transmit data only over short distances. 



A serial cable fits into a serial port (usually called COM1 or COM2). A serial port is commonly used for a modem 
cable and typically has a 9-pin connector. If the cable you are using looks the same as your printer cable, then it 
is a parallel, not a serial, cable.
A serial cable transmits data sequentially over one pair of wires. It is slower than a parallel cable, but it can 
transmit data over long distances, including over phone lines. 



 To order a new cable

Direct Cable Connection cables are available from several sources.
Parallel Technologies Direct Parallel Cables

Phone (800) 789-4784    from inside the U.S.
Phone (206) 869-1119 from outside the U.S.

Your local dealer
Phone (206) 869-1119 for a dealer near you.
Via e-mail
SALES@LPT.COM (Internet)
71612,3466 (CompuServe)

            OK. Close the troubleshooter.  
            Go back to the beginning of the troubleshooter.  



Next steps

You have encountered a problem that the Direct Cable Connection Troubleshooter cannot help you solve. For 
more information, consult the documentation that came with your computer or the vendor from whom you 
purchased the cable.
            Go back to the beginning of the troubleshooter.  
            Close the troubleshooter.  



Dial-Up Networking Troubleshooter

This troubleshooter will help you identify and solve problems with Dial-Up Networking. Just click to answer the 
questions, and then try the suggested steps to fix the problem.

What's wrong?
            I can connect to the remote computer, but I do not see a terminal screen.   
            I can connect to the remote computer, but the remote computer hangs up right after answering the phone.  
            Dialing doesn't work correctly.  
            The remote computer hangs up unexpectedly.  



Try your call again 
You may be experiencing line noise or cable problems. Try your call again.

Did this fix the problem?
            Yes. I was able to connect. Close the troubleshooter.  
            No. I'm still having trouble.  



What kind of connection are you using?
            SLIP or PPP.  
            Windows for Workgroups and Windows NT 3.1.  



Bring up a terminal window 

1 In the Dial-Up Networking window, click the connection you are creating a terminal screen for.
2 On the File menu, click Properties. 
3 Click Configure. 
4 Click the Options tab, and then make sure Bring Up Terminal Window After Dialing is checked. 
5 Try your call again. 

Did this fix the problem?
            Yes. I was able to reconnect. Close the troubleshooter.  
            No. I'm still having trouble.  



Use Connect Network Drive

Dial-Up Networking doesn't show a terminal screen. Use Connect Network Drive to gain access to shared files 
and folders on the remote computer.
            OK. Click here to close the troubleshooter.  
            Click here for information about connecting to shared files and folders.  



Contact the computer's administrator
You may have gone too long without typing anything, or your account may limit how long you can be 

connected to the computer. Try the call again, and ask the administrator for the remote computer whether your 
time limit can be increased. 

Did this fix the problem?
            Yes. I was able to reconnect. Close the troubleshooter.  
            No. I'm still having trouble.  



Contact the computer's administrator
Find out if the computer is working correctly. It may have been shut down for maintenance. 

            OK. Click here to close the troubleshooter.  
            Click here to return to the beginning of the troubleshooter.  



Bring up a terminal window 

1 In the Dial-Up Networking window, click the connection you are creating a terminal screen for.
2 On the File menu, click Properties. 
3 Click Configure. 
4 Click the Options tab, and then make sure Bring Up Terminal Window After Dialing is checked.
5 Try your call again. 

Did this fix the problem?
            Yes. I was able to reconnect. Close the troubleshooter.  
            No. I'm still having trouble.  



Does the remote computer prompt you for a password?
            Yes.  
            No.  



Make sure you're using the correct password
Make sure the password you are using to log on to the remote computer is correct. If it has changed or 

expired, or if you have forgotten the password, contact the administrator for the remote computer to get a new 
password. Then try the connection again.

Did this fix the problem?
            Yes. Click here to close the troubleshooter.  
            No. I'm still having trouble.  



Make sure you have access to the remote computer
If the remote computer is set up for user-level access control, contact the administrator for the computer 

to make sure you have access to it. Then try the connection again.

Did this fix the problem?
            Yes. Click here to close the troubleshooter.  
            No.  



Contact the remote computer's administrator

You've run into a problem with the remote computer that the Dial-Up Networking Troubleshooter can't help you 
solve. 
For more information, contact the administrator for the remote computer. 
            Go back to the beginning of the troubleshooter.  
            Close the troubleshooter.  



Connecting to the Internet

There are many ways you can connect to the Internet using Windows. Here are two ways you can connect.
You can sign up for The Microsoft Network online service.
You can create a Dial-Up Networking connection to an Internet access provider. 

            How to sign up for The Microsoft Network  
            How to connect to the Internet using Dial-Up Networking  



The Internet is a constantly evolving group of international computer networks connected by telephone lines. 
Since its creation in the 1960's, it has grown exponentially and is now used by millions of people, from 
commercial and educational institutions to individual consumers.
Once you're connected to the Internet, you can access a wealth of information, including newsgroups (BBS), 
news and weather information, software, and games.



The Microsoft Network is an online service that gives you Internet access, including mail and newsgroups.



Connecting to the Internet using Dial-Up Networking

The steps in this procedure will guide you through the process of connecting to the Internet by using Dial-Up 
Networking. Just click the button to start, or click Quick Overview to see a summary of the steps.

Step 1
            Getting an Internet account  

            Quick overview  



Quick overview

Here's a quick look at the steps required for connecting to the Internet by using Dial-Up Networking:
1 Get an Internet account with an Internet access provider.
2 Set up your communications hardware.
3 Make sure Dial-Up Networking is installed.
4 Install the TCP/IP protocol and bind it to the Dial-Up Networking adapter.
5 Enter TCP/IP information.
6 Create a connection to your access provider in Dial-Up Networking.
7 Dial your Internet access provider.



Step 2    Setting up your communications hardware

You need a modem (9600 bps or faster is recommended) to connect to the Internet. Or, if your organization has a
direct connection to the Internet, you can use a network adapter card instead of a modem.
If you haven't set up your modem, follow these steps:
1 Click here        to set up a modem.
2 Follow the instructions on your screen.

What's next?
            The modem is set up. Go to step 3.  



Step 3    Make sure you have Dial-Up Networking installed
1 Double-click the My Computer icon on your desktop. If you do not see a Dial-Up Networking icon, then follow 

steps 2 through 4.
2 Click here        to display Add/Remove Programs.
3 Click Communications, and then click Details.
4 Check Dial-Up Networking, and then click OK.

What's next?
            Dial-Up networking is installed. Go to step 4.  



Step 4    Install the Windows 95 TCP/IP protocol

1 Click here        to display Network properties.
2 Click Add. (If the Windows 95 TCP/IP protocol is already installed, you can go to step 6.)
3 Click Protocol, and then click Add.
4 Click Microsoft, and then click TCP/IP.
5 Click OK.
6 Click Dial-Up Adapter, and then click Properties. Or, if your organization has a direct Internet connection, click 

your network adapter, and then click Properties.
7 Click the Bindings tab, and then make sure the TCP/IP check box is checked.

If prompted, restart your computer. Then, start Help and return to this procedure.

Note
When you install TCP/IP, it is bound to all of your adapters by default. If you have a network card and don't 

use TCP/IP with it, you should go to Properties for the network card, click the Bindings tab, and then remove TCP/IP.

What's next?
            The adapter is bound to TCP/IP. Go to step 5.  



To bind an adapter to a protocol

1 Click here        to display Network properties.
2 Click the adapter you want to bind to a protocol, and then click Properties.
3 On the Bindings tab, make sure the checkbox for the appropriate protocol is checked.

Note
For information about how to install a protocol, click Related Topics.

{button ,AL("A_INSTALL_PROTOCOL")} Related Topics



Step 1    Getting an Internet account

When you call an Internet access provider to sign up for Internet account, make sure you get the following 
information:

User name
Password
Access phone number
Your host name and domain name
Domain Name Server (DNS) server address

The access provider may also provide the following information:
IP address and subnet mask
DNS search order (if required)
Gateway address
Authentication procedure (whether or not they require a terminal window to log on)

Note
Use a PPP account if your provider offers it.
If your organization has a direct connection to the Internet, you can skip this step.

What's next?
            I have an Internet account. Go to step 2.  



Point-to-Point protocol is a communications protocol for transmitting information over standard telephone lines. 
You need a PPP account so you can connect to your Internet access provider's PPP server. Windows comes with 
support for PPP connections.



Step 5    Entering TCP/IP information

1 Click here        to display Network properties.
2 Click TCP/IP (If there is more than one TCP/IP entry, click TCP/IP -> Dial-Up Adapter), and then click Properties. 
3 On the IP Address tab, if your provider gave you an IP address, click Specify An IP Address, and then type your 

IP address and subnet mask. 
If your provider did not give you an IP address, click Obtain An IP Address Automatically.
If you are using a direct network connection to the Internet, type your IP address and subnet mask. If your 
network uses a DCHP server to assign IP addresses, click Obtain An IP Address Automatically.

4 On the Bindings tab, it is recommended that you clear the File And Printer Sharing box.

What's next?
            My TCP/IP information is entered. Go to step 6.  



An Internet access provider maintains a server that is directly connected to the Internet. You must connect 
through an access provider unless your organization is directly connected to the Internet. Connecting to an 
access provider entails calling the provider and setting up a PPP account.



Step 6    Setting up a connection to your access provider

1 In Dial-Up Networking, double-click Make New Connection. (If it is your first Dial-Up Networking connection, 
you’ll be prompted automatically.)

2 Follow the instructions on your screen.
3 Using your right mouse button, click the connection icon, and then click Properties.
4 If your provider requires a terminal window to log in, click Configure. Click the Options tab, make sure Bring Up

Terminal Window After Dialing is checked, and then click OK.
5 In the Properties for the connection, click Server Type, and then make sure the type of server is set to PPP.

You can decrease the time required to connect by making sure that the following options are not checked:
Log On To Network
NetBEUI
IPX/SPX Compatible

Note
If you have a SLIP account, you need to install SLIP support. This is available on the Windows 95 CD-ROM 

or from the Windows 95 Resource Kit. After SLIP support is installed, go to the properties for your connection, click 
Server Type, and make sure SLIP is installed.

What's next?
            My connection is set up. Go to step 7.  



Step 7    Dialing your Internet access provider
Double-click the connection, enter your name and password, and then click Connect.

Follow the instructions provided by your Internet access provider for browsing the Internet, reading e-mail, and 
accessing information.

Notes
Information transfer on the Internet is bidirectional, meaning that while you are connected, other people 

can gain access to your computer. For this reason, it is recommended that you disable file and printer sharing 
before connecting.

For information about how to change protocol settings, how to display a logon screen after dialing, how to 
disable sharing, or how to connect to other operating systems, click Related Topics.
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